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About This Guide

This Novell GroupWise 2014 Installation Guide helps you install a new GroupWise system or upgrade
an existing GroupWise 8 or 2012 system to GroupWise 2014.

+ Part I, “GroupWise Product Overview,” on page 13
+ Chapter 1, “GroupWise Features and Benefits,” on page 15
+ Chapter 2, “GroupWise Components,” on page 19
+ Chapter 3, “GroupWise System Architecture,” on page 21

+ Part Il, “GroupWise System Requirements,” on page 25
+ Chapter 4, “GroupWise Administration Requirements,” on page 27
+ Chapter 5, “GroupWise User Requirements,” on page 33
+ Chapter 6, “Supported Environments,” on page 35

+ Part lll, “GroupWise System Creation,” on page 37
+ Chapter 7, “GroupWise System Overview,” on page 39
+ Chapter 8, “Planning Your GroupWise System,” on page 43
+ Chapter 9, “Installing the GroupWise Server Software,” on page 61
+ Chapter 10, “Creating a Simple GroupWise System,” on page 67
+ Chapter 11, “Creating a Typical GroupWise System,” on page 71
+ Chapter 12, “Adding Users to Your GroupWise System,” on page 79
+ Chapter 13, “Working with the GroupWise Administration Console,” on page 83
+ Chapter 14, “Working with the GroupWise Agents,” on page 89
+ Chapter 15, “What’s Next,” on page 107

+ Part IV, “GroupWise Component Installation and Setup,” on page 109
+ Chapter 16, “Setting Up GroupWise WebAccess,” on page 111
+ Chapter 17, “Setting Up the GroupWise Calendar Publishing Host,” on page 129
+ Chapter 18, “Setting Up GroupWise Monitor,” on page 155
+ Chapter 19, “Installing the GroupWise Client,” on page 175

*

Chapter 20, “Using Other Novell Products with GroupWise,” on page 181
+ PartV, “GroupWise System Upgrade,” on page 183
+ Chapter 21, “What’s New in GroupWise 2014,” on page 185
+ Chapter 22, “Understanding the Upgrade Process,” on page 191
+ Chapter 23, “Preparing Your Existing GroupWise System for the Upgrade,” on page 197
+ Chapter 24, “Installing the GroupWise 2014 Software,” on page 199
¢ Chapter 25, “Upgrading the Primary Domain Server,” on page 203
+ Chapter 26, “Upgrading a Secondary Domain Server,” on page 209
+ Chapter 27, “Upgrading a Post Office Server,” on page 217
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+ Chapter 28, “Upgrading GroupWise Agents and Applications,” on page 223
+ Chapter 29, “Upgrading Users’ GroupWise Client Software,” on page 229
+ Part VI, “Appendixes,” on page 235
+ Appendix A, “GroupWise Version Compatibility,” on page 237
+ Appendix B, “Attributes, Operators, and Values for Object Filters,” on page 243

+ Appendix C, “Invalid Characters in GroupWise Object Names and Email Addresses,” on
page 247

+ Appendix D, “Cross-Platform Connections,” on page 249
+ Appendix E, “Third-Party Materials,” on page 255

The following resources provide additional information about using GroupWise 2014:
+ Novell Support and Knowledgebase (http://www.novell.com/support/)

To search the GroupWise documentation from the Novell Support website, click Advanced
Search, select Documentation in the Search In drop-down list, select GroupWise in the Products
drop-down list, type the search string, then click Search.

+ GroupWise Support Forums (https://forums.novell.com/forumdisplay.php/356-GroupWise)
+ GroupWise Support Community (http://www.novell.com/support/kb/product.php?id=GroupWise)

+ GroupWise Cool Solutions (https://www.novell.com/communities/coolsolutions/category/
groupwise/)

Audience

This guide is intended for network administrators who install and administer GroupWise.

Feedback
We want to hear your comments and suggestions about this manual and the other documentation

included with this product. Please use the User Comment feature at the bottom of each page of the
online documentation.

Additional Documentation

For additional GroupWise documentation, see the Novell GroupWise 2014 Documentation website
(http://www.novell.com/documentation/groupwise2014/).
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GroupWise Product Overview

Novell GroupWise is an enterprise collaboration system that provides the following secure services:

+ Email

+ Calendaring

¢ Scheduling

+ Task management

+ Contact management
+ Document management

+ Additional productivity tools
Companion products provide additional capabilities:
+ GroupWise Mobility Service: Synchronization of GroupWise data to mobile devices

+ Novell Messenger: Secure instant messaging
+ Novell Vibe: Team workspaces, document management, and other collaboration tools

GroupWise 2014 can be used in a variety of environments:

+ Your Windows Desktop: Windows XP, 7, and 8

+ Web Browsers: Mozilla Firefox, Google Chrome, and Microsoft Internet Explorer
+ Tablets: Apple, Android, Kindle, and RIM

+ Mobile Devices: Apple, Android, BlackBerry, and Windows

The following sections include more details about the benefits that GroupWise provides and the steps
you need to perform to set up your GroupWise system to best meet your users’ needs.

+ Chapter 1, “GroupWise Features and Benefits,” on page 15
+ Chapter 2, “GroupWise Components,” on page 19
+ Chapter 3, “GroupWise System Architecture,” on page 21

GroupWise Product Overview 13



14 GroupWise 2014 Installation Guide



1.1

GroupWise Features and Benefits

GroupWise provides communication and collaboration services that are secure, highly available, and
easily accessible:

*

*

*

*

*

*

Section 1.1, “Essential Communication and Collaboration Services,” on page 15
Section 1.2, “Available Anytime,” on page 16

Section 1.3, “Accessible Anywhere,” on page 16

Section 1.4, “Always Secure,” on page 17

Section 1.5, “Competitive Performance,” on page 17

Section 1.6, “Evaluation Version Available,” on page 17

Essential Communication and Collaboration
Services

GroupWise provides a variety of tools to enable users to work together and to work smarter:

*

Messaging: Send and receive mail messages, phone messages, and reminder notes. A mail
message is for general correspondence. A phone message is for those who take phone
messages for others. A reminder note includes a start date and, when accepted by the recipient,
is posted to the recipient’s Calendar.

Scheduling: Schedule both appointments and tasks. When you schedule an appointment, you
can search other users’ Calendars to find free times for the appointment. When you schedule a
task, you can assign a priority and due date to the task. If the recipient accepts an appointment
or task, it is automatically added to his or her Calendar.

Calendaring: View and manage your appointments, tasks, and reminder notes in a Calendar
view. You can create multiple calendars. You can create multi-user calendars. You can also
publish calendars and free/busy status to the web so that non-GroupWise users can
conveniently schedule meetings with you.

Task Management: Create and schedule tasks for others. Accept or decline the tasks you
receive, and track accepted tasks through to completion. You can turn any message into a task.
You can also organize, schedule, and monitor tasks in your Tasklist folder.

Contact Management: Manage information for your contacts, groups, resources, and
organizations, including being able to view, update, delete, and add information to the contacts in
your personal address books and Contacts folders. In addition, you can view a history of
messages sent to and received from individual contacts, and compile notes on interactions with
contacts.

Document Management: Store documents in GroupWise libraries. In a library, documents, are
compressed to save disk space and encrypted to maintain security. With document
management, you can check in, check out, share, and create multiple versions of documents.

Mobile Device Synchronization: Receive and respond to GroupWise messages,
appointments, tasks, and notes on your mobile device. You can also send new items of all types
and manage contacts on your mobile device.
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+ Instant Messaging: Communicate in real time with other GroupWise users through Novell
Messenger. Messenger lets you know when other users are online, busy, or away from their
desks and displays this status in the GroupWise client. Messenger also allows you to save
conversations.

+ Teaming: Collaborate on a Novell Vibe website where personal, team, and global workspaces
can include discussion folders, shared calendars, shared documents, blogs, wikis, surveys, and
more. Powerful search capabilities make finding information quick and easy. GroupWise
includes integration with Vibe, so that you can access a Vibe site from the GroupWise client.

1.2 Available Anytime

GroupWise ensures that your essential communication tools are always available:

+ Caching: The GroupWise client includes a Caching mode that allows you to cache GroupWise
information to your local drive and continue to work even when you are not logged in to your
Online mailbox.

+ LDAP Pooling: If you are using LDAP authentication for GroupWise mailbox authentication,
LDAP pooling ensures that there is always an LDAP server through which authentication can be
performed.

+ Clustering: To ensure that GroupWise data is always available and GroupWise components are
always running, you can install GroupWise in a cluster on Linux or Windows.

1.3 Accessible Anywhere

GroupWise lets you communicate and collaborate with other people by using the device that is most
convenient:

+ Personal Computers: To access your GroupWise mailbox with the most robust functionality,
you can run the GroupWise client on any workstation that uses Windows XP, 7, or 8.

+ Web Browsers: When you are away from your office, or when you prefer a platform other than
Windows, you can access your GroupWise mailbox from a variety of desktop web browsers by
using GroupWise WebAccess.

+ Tablet Computers: For those who prefer a more mobile computer, you can access your
GroupWise mailbox from a tablet computer by using GroupWise WebAccess Mobile.

+ Mobile Devices: If you want to access email messages, calendar items, tasks, and so on from a
handheld mobile device such as your cell phone, you have several options:

+ GroupWise Mobility Service: The GroupWise Mobility Service, available free of charge to
GroupWise customers with maintenance contracts, synchronizes GroupWise data to most
popular mobile devices.

+ BlackBerry Enterprise Server for GroupWise: This solution from Research in Motion
provides synchronization of GroupWise data for BlackBerry users with devices that are
older than the BlackBerry Z10. Newer BlackBerry devices are fully supported by the
GroupWise Mobility Service.

+ GroupWise WebAccess Basic Template: GroupWise WebAccess includes a basic
template customized for use on the small display available on a typical mobile device.

NOTE: GroupWise WebAccess Mobile is intended for use on tablets, not on smaller mobile
devices such as cell phones.
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+ Other Email Clients: GroupWise enables you to access your mailbox with any POP3, IMAP4,
or SOAP email client.

14 Always Secure

1.5

1.6

GroupWise provides extensive security measures to protect your information:

+ Native GroupWise Encryption: To protect your information as it is stored in the various
GroupWise databases and moved across the network, GroupWise automatically encrypts the
information. Each piece of information is encrypted differently through the use of randomly
generated encryption keys.

+ Open Security Standards: To further ensure that your information is secure while moving
across your internal network and across the Internet, GroupWise supports open security
standards such as Secure Sockets Layer (SSL), Secure Multipurpose Internet Mail Extension (S/
MIME), Public Key Infrastructure (PKI), and Transport Layer Security (TLS).

+ Spam Protection: To protect you from seeing unwanted messages, the GroupWise client
includes a Junk Mail Handling feature that lets you control unwanted Internet email messages. In
addition, you can configure the GroupWise Internet Agent (GWIA) to reject messages from
known open relay hosts and spam hosts. GroupWise also works with partner products that
provide additional anti-spam solutions.

+ Virus Protection: GroupWise works with partner products to provide solutions that detect and
eliminate viruses.

For information about additional security solutions available for GroupWise through GroupWise
partners, see the Novell Partner Product Guide (http://www.novell.com/partnerguide/).

Competitive Performance

GroupWise functionality compares very favorably with popular email solutions:

+ Novell GroupWise and Microsoft Exchange/Outlook (http://www.novell.com/products/groupwise/
features/groupwise-vs-outlook.html)

+ Novell GroupWise and Google Gmail (http://www.novell.com/products/groupwise/features/
groupwise-vs-gmail.html)

Evaluation Version Available

An evaluation version of GroupWise is available on the Novell Downloads website (http://
download.novell.com). With the evaluation version of GroupWise, you can create a test GroupWise
system that includes any number of domains, post offices, and users. The evaluation version does
not expire. However, the evaluation software cannot legally be installed and run in a production
environment.
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GroupWise Components

GroupWise includes multiple components that you need to install to realize the full benefits of
GroupWise. However, some components might not be necessary, depending on your needs. The
following table outlines the components, what they provide, and where to find instructions for

installing them.

Component

What it does

Go to

GroupWise Server:

¢ Administration Service
+ Message Transfer Agent
+ Post Office Agent

¢ |Internet Agent

+ Document Viewer Agent

WebAccess
WebAccess Mobile

Calendar Publishing Host

Monitor

GroupWise Client

Required for any GroupWise system.
These components must be installed
before any other components.

Provides access to mailboxes through
desktop web browsers, tablet
computers, and mobile devices.

Provides web-based public access to
GroupWise calendars and free/busy
availability to Internet users.

Provides administrative monitoring of
the GroupWise agents.

Provides access to mailboxes from
the Windows desktop; can be easily
rolled out to all GroupWise users on a
convenient schedule.

Chapter 10, “Creating a Simple
GroupWise System,” on page 67

Chapter 11, “Creating a Typical
GroupWise System,” on page 71

Chapter 16, “Setting Up GroupWise
WebAccess,” on page 111

Chapter 17, “Setting Up the
GroupWise Calendar Publishing
Host,” on page 129

Chapter 18, “Setting Up GroupWise
Monitor,” on page 155

Chapter 19, “Installing the GroupWise
Client,” on page 175

In addition to the sections referenced in the above table, this Installation Guide includes the following

supplemental sections:

+ Section 20.1, “Using the GroupWise Mobility Service to Synchronize GroupWise Data to Mobile

Devices,” on page 181

¢ Section 20.2, “Using Novell Messenger to Provide Secure Instant Messaging for GroupWise

Users,” on page 181

¢ Section 20.3, “Using Novell Vibe to Provide Team Workspaces for GroupWise Users,” on

page 182

The information in these sections is provided as a reference for installing additional products after you
have created your GroupWise system.

GroupWise Components
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3.1

GroupWise System Architecture

Your GroupWise system consists of multiple components. The better you understand each
component, the more effectively you can manage your GroupWise system.

+ Section 3.1, “Agent Architecture,” on page 21

*

*

*

*

Agent Architecture

Section 3.2, “Administration Service Architecture,” on page 22
Section 3.3, “WebAccess Architecture,” on page 23
Section 3.4, “Calendar Publishing Host Architecture,” on page 23

Section 3.5, “Monitor Architecture,” on page 24

The GroupWise agents move email throughout your GroupWise system, as well as to and from the

Internet.

GroupWise

System

Message
Transfer
Agent

Primary % f
Domain Qy E

1T—al o &1—]
= NI
Q00000

GroupWise Clients GroupWise Clients

The Post Office Agent (POA) runs for each post office. The POA delivers email to users’ mailboxes.

1

o
T—al o &1—]

= TN T
Q00000

GroupWise Clients GroupWise Clients

Message » Secondary
Transfer Domain
Agent

The Message Transfer Agent (MTA) runs for each domain. The MTA transfers email between post

offices and other domains.
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3.2

The Internet Agent (GWIA) runs for at least one domain in your GroupWise system. The GWIA
communicates with SMTP hosts across the Internet, sending and receiving email for users who are
not part of your GroupWise system.

Internet
Agent
=g
Internet
; ¥ Message
Domain Q« E Transfer Document
Agent =) Viewer

/ & Agent
Agents

&N Y S
Q00000

GroupWise Clients GroupWise Clients

The Document Viewer Agent (DVA) runs for at least one post office. The DVA converts attached
document files from a wide variety of formats into HTML format for indexing by the POA and for
viewing in GroupWise WebAccess.

Administration Service Architecture

The GroupWise Administration Service provides the GroupWise Administration console in your web
browser. The Admin console provides the global view of your GroupWise system. It enables you to
configure and customize all GroupWise objects (Domain, Post Office, User, MTA, POA, GWIA, DVA,
and so on). It also provide a number of administrative tools for managing your GrouPWise system.

@ Primary Secondary @
Admin Domain Domain Admin

Console [7] Server Server [ Console

= \ ! _— Q Domain Domain & _— ! /@
Admin Service Admin Service

Admin Service Admin Service Admin Service ‘ ‘ Admin Service

11— !— 1 1— l—

Post Post Post Post Post Post Post Post
Office Office Office Office Office Office Office Office
Server Server Server Server

The Admin Service runs on each domain server and post office server. The Admin Service
communicates with Admin Services on other GroupWise servers and with the agents that run on its
local server. You can access the Admin console on any domain server. For post office access, you
access the Admin console for the domain that owns the post office.
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3.3

3.4

WebAccess Architecture

WebAccess enables GroupWise users to access their mailboxes from their web browser.

Post
WWebAccess WebAccess —> —J Office
Secure  Application Agent
Login
S — (D
— i —_—
= Doqument
Web Browser Internet Web Server » (mz) Viewer
Agent

Externally, the WebAccess Application, which integrates with your web server, communicates with
the user’s web browser across the Internet. Internally, the WebAccess Application communicates with
the Post Office Agent (POA) to request mailbox data and with the Document Viewer Agent (DVA) for
conversion of attached documents into HTML for viewing.

Calendar Publishing Host Architecture

The Calendar Publishing (CalPub) Host enables GroupWise users and non-GroupWise users to view
GroupWise users’ calendars from their web browser.

Published Calendar

Calendar Putlzlli;;ing _J OP%scte
No Application Agent
Login

d ) Admin Service

it
Web Browser Internet Web Server L> GroupWise

Externally, the CalPub Host Application, which integrates with your web server, communicates with
the user’s web browser across the Internet. Internally, the CalPub Host Application communicates
with the Post Office Agent (POA) to request calendar data from the user’s mailbox. The CalPub Host
requires access to an LDAP server such as NetlQ eDirectory or Microsoft Active Directory for
administrator authentication to the CalPub Admin console.
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3.5

Monitor Architecture

Monitor enables you to monitor the GroupWise agents from your web browser when you are not

working behind your firewall.

Internal

Monitor
Console
F
External B\r’(\)'fvger
Monitor
Console Post Office
Monitor I —J Agents
Application
=] - - Message Transfer
= — — =] )« > < > Agents
Web Browser Internet Web Server Monitor | Internet
Agent Agents

Internally, the Monitor Agent gathers status information from GroupWise agents. Externally, the
Monitor Application, which integrates with your web server, communicates with your web browser
across the Internet to provide a Monitor console that is available outside your firewall. The Monitor
Agent also provides its own internal Monitor console independent of your web server, which is

available inside your firewall.
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GroupWise System Requirements

You, as a GroupWise administrator, must ensure that your system meets GroupWise system
requirements, so that your GroupWise system can be set up successfully. After your GroupWise
system is set up, you must ensure that users’ workstations meet GroupWise client requirements, so
that users can run the GroupWise clients successfully.

+ Chapter 4, “GroupWise Administration Requirements,” on page 27

+ Chapter 5, “GroupWise User Requirements,” on page 33

+ Chapter 6, “Supported Environments,” on page 35
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GroupWise Administration
Requirements

+ Section 4.1, “Hardware and Operating System Requirements,” on page 27
+ Section 4.2, “Directory Requirements,” on page 28

+ Section 4.3, “Web Server Requirements,” on page 28

+ Section 4.4, “Web Browser Requirements Administrators,” on page 29

+ Section 4.5, “Internet Agent Functional Requirements,” on page 29

+ Section 4.6, “Sample Agent Memory Requirements,” on page 30

41 Hardware and Operating System Requirements

(J x86-64 processor

J Any of the following server operating systems for the GroupWise agents (Post Office Agent,
Message Transfer Agent, Document Viewer Agent, Internet Agent, Monitor Agent):

+ Novell Open Enterprise Server (OES) 11, plus the latest Support Pack
¢ SUSE Linux Enterprise Server (SLES) 11, plus the latest Service Pack

NOTE: On Linux, the X Window System and Open Motif are required by the GUI
GroupWise agent server consoles for the Post Office Agent, the Message Transfer Agent,
and the Internet Agent.

By default, the GroupWise Linux agents run as services without user interfaces. Starting
and stopping the agents when they are running with a user interface is not supported in the
GroupWise Administration console.

+ Windows Server 2008 R2, Windows Server 2012, or Windows Server 2012 R2, plus the
latest Service Pack

(0 Adequate server memory as required by the operating system

Depending on the anticipated load on the GroupWise agents, additional memory might be
required. For details, see Section 4.6, “Sample Agent Memory Requirements,” on page 30.

O Adequate server disk space as required by each GroupWise component:

+ Domain Folder: 100-200 MB for the domain database, plus 1 GB or more for message
queues when links are down

+ Post Office Folder: 5 MB per user (minimum); 100 MB or more per user (recommended);
plus 100-300 MB for the post office database; plus 500 MB or more for message queues
when links are down

+ GroupWise Server Installation: Approximately 885 MB (GroupWise Administration
Service, Message Transfer Agent, Post Office Agent, Internet Agent, and Document Viewer
Agent combined; varies by platform)

For additional Internet Agent requirements, including Internet connectivity requirements,
see Section 4.5, “Internet Agent Functional Requirements,” on page 29.
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+ WebAccess Installation: Approximately 525 MB (shared with the Calendar Publishing
Host Application and the Monitor Application when they are installed on the same web
server; varies by platform)

+ Calendar Publishing Host Installation: Approximately 525 MB (shared with the
WebAccess Application and the Monitor Application when they are installed on the same
web server; varies by platform), plus 50 KB per published calendar and 50 KB per user for
free/busy searching

+ Monitor Installation: Approximately 40 MB for the Monitor Agent (varies by platform);
approximately 525 MB for the Monitor Application (shared with the WebAccess Application
and the Calendar Publishing Host Application when they are installed on the same web
server; varies by platform)

For additional disk space guidance, see the GroupWise Best Practices Wiki (http://
wiki.novell.com/index.php/GroupWise).

4.2 Directory Requirements

One or more of the following directories:
(J NetlQ eDirectory 8.8.7 or later, plus the latest Support Pack, with LDAP enabled (optional)

You can download eDirectory from the Novell Downloads site (http://download.novell.com).
(J Microsoft Active Directory (optional)

(J Native GroupWise directory (internal; required)

4.3 Web Server Requirements

The web server that is supported for your operating system, for use with the GroupWise
Administration console, the agent consoles, WebAccess, Monitor, and the Calendar Publishing Host:

(J x86-64 or x86-32 processor

(J OES 11/SLES 11
Apache 2.2 plus:
¢+ Tomcat 6
+ |IBM Java 6 Runtime Environment (JRE)
+ ModProxy Module

A Linux repository should be available when you run the GroupWise Installation Wizard. Apache,
Tomcat, the JRE, and the ModProxy Module are automatically installed from the Linux repository
if they are not already present on the Linux server.

If no Linux repository is available during the GroupWise installation, you are prompted to
manually install these required components from the Linux media, and then restart the
GroupWise installation.

(J Windows Server 2008 R2 / Windows Server 2012 / Windows Server 2012 R2
Microsoft Internet Information Server (1IS) 7 or later plus:
¢ Tomcat 6
+ IBM Java 6 Runtime Environment (JRE)
+ Jakarta Connector 1.2
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Tomcat 6.0.24, Oracle JRE 6 Update 26, and Jakarta Connector 1.2 are automatically
installed along with the GroupWise software if they are not already present on the Windows
server.

+ ISAPI support

On Windows, WebAccess requires ISAPI support. ISAPI support is no longer installed by default
when you install Windows Server 2008 R2 or later and Internet Information Services (1IS). Ideally, you
should select ISAPI support during the installation of 1IS. However, if you are installing WebAccess on
Windows Server 2008 R2 or later, and ISAPI support is not yet installed, you can add it after the fact.

1 In Windows Server Manager, expand Roles, then right-click Web Server (11S).

2 In the Role Services section, click Add Role Services.

3 Select Application Development, select ISAPI Extensions and ISAPI Filters, then click Install.

4 (Conditional) If you installed the GroupWise WebAccess Application before you installed ISAPI
support, reinstall the GroupWise WebAccess Application.

The WebAccess Installation Wizard restarts Tomcat and IS to put the ISAPI changes into effect.

44 Web Browser Requirements Administrators

Any of the following web browsers for the GroupWise Administration console and agent consoles:

O Linux; Mozilla Firefox
O Windows: Microsoft Internet Explorer 10 or later; Mozilla Firefox

O Macintosh: Mozilla Firefox

NOTE: The web browser requirements for GroupWise WebAccess are different from the web
browser requirements for the Admin and agent consoles. For those user requirements, see
Section 5.2, “GroupWise WebAccess User Requirements,” on page 33.

The Admin and agent consoles are not supported on tablet devices. For those user requirements, see
Section 5.3, “GroupWise WebAccess Mobile User Requirements,” on page 34.

4.5 Internet Agent Functional Requirements

The following additional requirements apply when you install the Internet Agent:

+ Section 4.5.1, “GroupWise Version Requirements,” on page 29

+ Section 4.5.2, “Internet Connectivity Requirements,” on page 30

451 GroupWise Version Requirements

The GroupWise system in which you install the Internet Agent (GWIA) must meet the following
requirements:

O The domain’s version must be equal to or later than the GWIA’s version. The domain’s version is
determined by the Message Transfer Agent (MTA) version running for it.

(0 The versions of any post offices that the GWIA accesses on behalf of POP3 or IMAP4 clients
must be equal to or later than the GWIA’s version. A post office’s version is determined by the
Post Office Agent (POA) version running for it.
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4.5.2 Internet Connectivity Requirements

Before you install the Internet Agent (GWIA), ensure that your network is configured for Internet
connectivity.

O Internet Connection: You can connect to the Internet by using a direct connection over a
leased line or a standard switched telephone line.

(J Internet Domain Name: You must have an Internet domain name. The domain name must be
defined by an MX RR (mail exchanger resource record) in DNS.

(J DNS Server Access or Relay Host Access: If you want the GWIA to send messages directly
to other SMTP hosts, it requires access to a DNS server for address resolution. Otherwise, it
requires access to a relay host that can perform the address resolution and message routing.
Ensure the server where you plan to install the GWIA is configured to access a DNS server or
can access your relay host. For specific details, refer to your server documentation.

O IP Address: The GWIA's server requires a static IP address and a fully qualified DNS
hostname.

46 Sample Agent Memory Requirements

+ Section 4.6.1, “Sample POA Memory Requirements Based on Post Office Size,” on page 30

+ Section 4.6.2, “Sample Memory Requirements for Other GroupWise Agents and Applications,”
on page 31

461 Sample POA Memory Requirements Based on Post Office
Size

The amount of memory used by the POA depends on the number of active users, as illustrated by the
table below. The POA typically performs best with abundant cache memory available.

Concurrent Users Minimum Recommended Memory for
Memory Best Performance
Required

100 active users (100-250 users in post office) 400 MB 2GB

250 active users (250-500 users in post office) 600 MB 4 GB

500 active users (500-1000 users in post office) 800 MB 4GB

1000 active users (1000 - 1500 users in post office) 1GB 8GB-12GB

1500 active users (1500 - 3000 users in post office) 2GB 12 GB
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4.6.2

Sample Memory Requirements for Other GroupWise Agents

and Applications

Agent/Application Minimum Recommended Memory for
Memory Best Performance
Required

Routing MTA 200 MB 2GB

DVA 100 MB 1GB

GWIA and its MTA 400 MB 4GB

Monitor 100 MB 1GB

WebAccess Application 400 MB 4GB

Calendar Publishing Host Application 200 MB 1GB

WebAccess and Calendar Publishing Host Applications 600 MB 4 GB

together
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5 GroupWise User Requirements

¢ Section 5.1, “GroupWise Client User Requirements,” on page 33
¢ Section 5.2, “GroupWise WebAccess User Requirements,” on page 33

+ Section 5.3, “GroupWise WebAccess Mobile User Requirements,” on page 34

51 GroupWise Client User Requirements

(J x86-32 processor or x86-64 processor

On a 64-bit processor, GroupWise still runs as a 32-bit application.
O Any of the following desktop operating systems for the GroupWise client:
+ Windows XP on a 300 MHz or higher workstation with at least 128 MB of RAM
+ Windows 7 on a 1 GHz or higher workstation with at least 1 GB of RAM
+ Windows 8 or Windows 8.1 on a 1 GHz or higher workstation with at least 1 GB of RAM

O Microsoft Internet Explorer 9 or later

NOTE: On Windows XP, Microsoft Internet Explorer 8.0 is also supported.

(3 Any of the following word processors for use as the GroupWise editor:
+ OpenOffice 3.4 or later
+ LibreOffice 3.6 or later
+ Microsoft Word 2007 or later

(0 Approximately 200 MB of free disk space on each user’s workstation to install the GroupWise
client.

5.2 GroupWise WebAccess User Requirements

(3 Any of the following web browsers:
¢ Linux: Mozilla Firefox; Google Chrome

+ Windows: Microsoft Internet Explorer 9 or later; Mozilla Firefox; Google Chrome; Spartan

NOTE: On Windows XP, Microsoft Internet Explorer 8.0 is also supported.

+ Macintosh: The latest version of Safari for your version of Mac OS; Mozilla Firefox; Google
Chrome

(J Any mobile device that supports Wireless Access Protocol (WAP) and has a microbrowser that
supports Hypertext Markup Language (HTML) 4.0 or later
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53 GroupWise WebAccess Mobile User
Requirements

Any of the following tablet operating systems and tablets:

(J Android 4.1, 5.0, or later, with Google Chrome, on any Android device

Apple iOS 7.x, 8.x, or later, with Apple Safari

Kindle Fire, with Amazon Silk

RIM Tablet OS 2.1 or later, with Google Chrome, on the Blackberry Playbook

I R R

Windows Mobile 8.0 or later Pro, with Microsoft Internet Explorer, on any Windows device (full
WebAccess, no template)
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6.1

6.2

6.3

Supported Environments

¢ Section 6.1, “IPv6 Support,” on page 35

¢ Section 6.2, “Clustering Support,” on page 35

+ Section 6.3, “Xen Virtualization Support,” on page 35

+ Section 6.4, “VMware Support,” on page 36

+ Section 6.5, “Hyper-V / Cloud Server Support,” on page 36

+ Section 6.6, “Citrix Support,” on page 36

+ Section 6.7, “Domain Services for Windows Support,” on page 36

+ Section 6.8, “File System Support,” on page 36

IPv6 Support

The Post Office Agent, the Message Transfer Agent, the Internet Agent, and the Monitor Agent
support the IPv6 protocol when it is available on the server. If IPv6 is available, the agent detects it
and supports it by default, along with IPv4. The Document Viewer Agent does not support IPv6.

As you configure your GroupWise system and specify the network address of an IPv6 server in the
GroupWise Administration console, you must specify its DNS hostname. IP Address fields in the
Admin console do not accommodate IPv6 address format.

Clustering Support

You can set up your GroupWise system in the following clustering environments:

+ Novell Cluster Services on Linux
+ Microsoft Clustering on Windows

If you are using one of these clustering environments, see “Clustering” in the GroupWise 2014
Interoperability Guide before using the installation instructions in this guide.

Xen Virtualization Support

You can install components of your GroupWise system in virtual environments where a software
program enables one physical server to function as if it were two or more physical servers. Xen
virtualization technology in Open Enterprise Server (OES) 11 and SUSE Linux Enterprise Server
(SLES) 11 is supported. For more information, see:

+ Open Enterprise Server 11 Virtualization documentation (http://www.novell.com/documentation/
oes11/#cat_virtualization)

¢ SLES Virtualization Technology documentation (https://www.suse.com/documentation/sles11/
#additional)
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Large post offices with busy Post Office Agents are not good candidates for Xen virtualization.
Specialized Post Office Agents, such as an indexing Post Office Agent with no mailboxes and users,
could be virtualized using Xen. Other GroupWise components such as the Message Transfer Agent
and the Internet Agent do well when virtualized using Xen.

6.4 VMware Support

GroupWise is supported on VMWare ESX and ESXi. For more information, see the VMware website
(http://www.vmware.com).

All GroupWise components are good candidates for VMware virtualization.

6.5 Hyper-V/ Cloud Server Support

GroupWise is supported on Hyper-V Server 2008 and Windows Cloud Server 2012. For more
information, see the Microsoft Hyper-V Server website (http://www.microsoft.com/en-us/server-cloud/
products/windows-server-2012-r2/default.aspx).

All GroupWise components are good candidates for Hyper-V / Cloud Server virtualization.

6.6 Citrix Support

Any version of the GroupWise client runs successfully on any 32-bit version of Citrix terminal
services.

The GroupWise agents run successfully on Citrix XenServer.

For more information, see the Citrix website (http://www.citrix.com).

6.7 Domain Services for Windows Support

GroupWise can be used with Domain Services for Windows (DSfW) in your NetlQ eDirectory tree.
GroupWise accounts can be added to User objects in the DSfW partition, but all other GroupWise
objects (Domain, Post Office, Agent, and so on) must be created in the eDirectory partition.

IMPORTANT: Do not install GroupWise on the same server with DSfW.

6.8 File System Support

GroupWise is supported on any file system supported by the server OS.

NOTE: If you choose to use the NSS file system, turn off Salvage for best performance. For more
information, see the Novell Open Enterprise Server Documentation (https://www.novell.com/
documentation/oes11/).
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741

GroupWise System Overview

Your GroupWise system can be structured in a variety of ways. Some decisions must be made in the
beginning. Other decisions can be made as your GroupWise system grows.

+ Section 7.1, “Simple GroupWise System,” on page 39

+ Section 7.2, “Typical GroupWise System,” on page 40

+ Section 7.3, “GroupWise Users,” on page 40

+ Section 7.4, “GroupWise Agents,” on page 41

Simple GroupWise System

A simple GroupWise system is installed on a single server. A simple GroupWise system would be
appropriate only for a very small number of users working in a single geographic location or for
temporary use in a lab environment.

A simple GroupWise system consists of a single domain (the primary domain) with one post office,
and several users, as shown below:

Simple
GroupWise
System
| Message
: Transfer
GroupWise
Server ! Agent
Primary B
Domain E
Internet
| I\ Agent
S
Post Office

Post Internet
Ofﬂce )
Agent 3

[ |

o * * Document

GroupWise Users Viewer
Agent

A domain organizes post offices into a logical grouping for administration and routing purposes in
your GroupWise system. Messages are transferred between post offices and domains by the
Message Transfer Agent (MTA). Messages are transferred to and from your GroupWise system by
the Internet Agent (GWIA).

A post office serves as an administrative unit for a group of users and mailboxes. Messages are
delivered to mailboxes by the Post Office Agent (POA).
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7.2 Typical GroupWise System

In contrast to a simple GroupWise system, a typical GroupWise system is installed on multiple
servers, perhaps across multiple geographic locations.

+ Primary Domain: The primary domain would be created on its own server and would not own
post offices.

+ Secondary Domains: Secondary domains would each be created on their own servers and
would own multiple post offices.

+ Post Offices: Depending on server capacity, post offices could be created on domain servers or
could be created on their own servers.

+ Internet Agents: One or more Internet Agents would be set up for the GroupWise system. An
Internet Agent could be set up in a domain that owns post offices, or a separate domain could be
created specifically to house one or more Internet Agents.
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7.3 GroupWise Users

You can add users to your GroupWise system in two different ways:

+ Manually create users in the internal GroupWise directory

+ Import users from an LDAP directory such as NetlQ eDirectory or Microsoft Active Directory

Each GroupWise user has a mailbox in the post office. Users can access their mailboxes in several
ways:

+ GroupWise client on a Windows desktop
+ GroupWise WebAccess in a supported web browser
+ GroupWise WebAccess Mobile on a supported tablet

Users can also synchronize mailbox data with mobile devices using the GroupWise Mobility Service.
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7.4 GroupWise Agents

Domains, post offices, and mailboxes are supported by four GroupWise agents:

+ The Post Office Agent (POA) responds to GroupWise client requests for mailbox data and
delivers messages between users’ mailboxes in a post office. The POA also communicates with
the MTA to route messages to and from the post office. In addition, the POA performs a variety
of maintenance tasks in the post office.

+ The Message Transfer Agent (MTA) transfers messages between post offices and domains, and
performs a variety of other functions in the domain.

+ The Internet Agent (GWIA) converts GroupWise messages into SMTP format and transfers them
to the Internet SMTP hosts where recipients are located. In reverse, it receives SMTP messages
from Internet SMTP hosts and converts them into GroupWise format. The GWIA can also
provide access for POP3 and IMAP4 clients to access GroupWise mailboxes.

+ The Document Viewer Agent (DVA) converts attached document files from a wide variety of
formats into HTML format for indexing by the POA and for viewing in GroupWise WebAccess.
You can run up to three DVAs to service conversion requests for a single instance of the POA.
Each DVA must be installed on a different server.
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8.1

8.1.1

Planning Your GroupWise System

The GroupWise Installation Wizard helps you install the GroupWise software on GroupWise servers.
The GroupWise Installation console helps you create domains and post offices and configure the
GroupWise agents.

Print the following worksheets and fill them out as you plan your GroupWise system:
O Simple, single-server GroupWise system

Simple GroupWise System Worksheet

(J Typical, multiple-server GroupWise system

Primary Domain Worksheet
Secondary Domain Worksheet (one for each secondary domain)
Post Office Worksheet (one for each post office)

The topics in this section present the required information in a convenient planning sequence. The
worksheets organize the information in the order in which you need it during installation and setup. As
you review the planning information, record the specific details for your GroupWise system on the
appropriate worksheet.

+ Section 8.1, “Planning GroupWise System Information,” on page 43

+ Section 8.2, “Planning a Domain,” on page 44

+ Section 8.3, “Planning a Post Office,” on page 49

+ Section 8.4, “Planning Users,” on page 53

+ Section 8.5, “GroupWise System Worksheets,” on page 54

Planning GroupWise System Information

To identify your GroupWise system as a whole, the Installation console prompts you for the following
information:
+ GroupWise System Name

+ GroupWise Internet Domain Name

GroupWise System Name

You must provide a name for your GroupWise system. The system name can be your company name
(for example, Novell), GroupWise, or anything else that fits the naming scheme you want to use. The
system name is displayed only in the Admin console, so any characters can be used. You cannot
change the name after your GroupWise system is created.

WORKSHEET

Under System Settings, specify the name for your GroupWise system.
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8.1.2

8.2

8.2.1

GroupWise Internet Domain Name

Your GroupWise system also needs an Internet domain name. The Internet domain name is used
after the @ sign in GroupWise users’ email addresses. You should already have obtained an Internet
domain name from your Internet service provider (ISP).

WORKSHEET

Under GroupWise System Settings, specify the Internet domain name.

Under Create Internet Agent, specify the host name of the GWIA server as it appears in its DNS record.

Planning a Domain

The primary domain functions as the main administration unit for your GroupWise system.

In a simple, single-server GroupWise system, the primary domain owns one or more post offices and
a GWIA. In a typical, multiple-server GroupWise system, the primary domain can function as a hub
for the secondary domains where post offices and GWIAs are located, or it can own post offices that
are located on other servers.

As you create a domain, the Installation console prompts you for the following information about the
domain:

+ Domain Server

¢+ Domain Name

¢ Domain Folder

+ Domain Language

¢ Domain Time Zone

+ Domain Link (Secondary Domain Only)

+ Agents for the Domain

+ Administrator Access for Domain Creation

Domain Server

You can create a domain on Linux or Windows. Your GroupWise system can include both Linux
servers and Windows servers.

WORKSHEET

Under Platform, mark the operating system (Linux or Windows) that you plan to use for the domain.

Under Host, specify the IP address or DNS hostname of the server where you plan to create the domain.
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8.2.2

8.2.3

8.24

Domain Name

The name of the primary domain might reflect a company name (such as Novell). The name of a
secondary domain might reflect a location (such as Provo), a department (such as Engineering), or
some other element that makes sense for your organization. The name is used as the Domain
object’'s name in the Admin console.

The name should consist of a single string. Do not use any of the characters listed in Section C.1,
“Invalid Characters in GroupWise Object Names,” on page 247.

WORKSHEET

Under Domain Settings, specify the domain name.

Domain Folder

The domain requires a folder structure in which to store database files and temporary files that are
created during message routing. If you want, the folder name can reflect the domain name you chose.

You must specify an empty folder. If the folder does not already exist, it is automatically created. The
installation process can proceed more smoothly if you create the folder in advance.

Use the following platform-specific naming conventions for the folder name:

Linux: Use only lowercase characters.
Windows: No limitations.

WORKSHEET

Under Domain Settings, specify the full path for the domain folder.

Domain Language

The domain language determines the sort order for object lists in the Admin console. The primary
domain language becomes the default language for secondary domains. The owning domain
language becomes the default language for the domain’s post offices.

WORKSHEET

Under Primary Domain Settings, specify the language for the domain.

NOTE: The languages listed for selection in the Installation console includes more languages than
GroupWise supports. See “Multilingual GroupWise Systems” in the GroupWise 2014 Administration
Guide for a list of valid languages.
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8.2.5

8.2.6

8.2.7

Domain Time Zone

When a message is sent from a user in one time zone to a user in another time zone, GroupWise
adjusts the message’s time so that it is correct for the recipient’s time zone. For example, if a user in
New York (GMT -05:00, Eastern Time) schedules a user in Los Angeles (GMT -08:00, Pacific Time)
for a conference call at 4:00 p.m. Eastern Time, the appointment is scheduled in the Los Angeles
user’s calendar at 1:00 p.m. Pacific Time.

The primary domain time zone becomes the default time zone for secondary domains. The owning
domain time zone becomes the default time zone for the domain’s post offices.

WORKSHEET

Under Domain Settings, specify the time zone for the domain.

Domain Link (Secondary Domain Only)

When you add a new domain to your GroupWise system, links define how messages are routed from
one domain to another. When you add the first secondary domain, the links between the primary and
secondary domains are very simple. As the number of domains grows, the links among them can
become quite complex. For more information, see “Managing the Links between Domains and Post
Offices” in the GroupWise 2014 Administration Guide.

SECONDARY DOMAIN WORKSHEET

Under Domain Settings, specify the domain that you want to link the new secondary domain to.

Agents for the Domain

Two agents run for a domain. As you configure the agents for the domain, the Installation console
prompts you for the following information:

+ MTA Configuration
+ GWIA Configuration

The agent consoles are automatically available in the GroupWise Admin console. The agents are
configured to start automatically when the server restarts.

MTA Configuration

The Message Transfer Agent (MTA) transfers messages between post offices and domains, and
performs a variety of other functions in the domain.

The MTA requires a TCP/IP connection with POAs in the domain and with MTAs in other domains. In
order to configure the MTA, you need to plan the following port numbers:

+ Message Transfer Protocol Port: Used to communicate with the POA. The default MTP port
for the MTA is 7100.

¢+ HTTP Port: Used to communicate with your web browser to provide the MTA console. The
default HTTP port for the MTA is 7180.
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8.2.8

Use the default port number unless it is already in use on the server.

WORKSHEET

Under MTA Settings, specify the required port numbers.

For a complete list of default port numbers used by the GroupWise agents, see “GroupWise Port
Numbers” in the GroupWise 2014 Administration Guide.

GWIA Configuration

The Internet Agent (GWIA) converts GroupWise messages into SMTP format and transfers them to
the Internet SMTP hosts where recipients are located. In reverse, it receives SMTP messages from
Internet SMTP hosts and converts them into GroupWise format. The GWIA can also provide access
for POP3 and IMAP4 clients to access GroupWise mailboxes.

The GWIA requires that you provide the fully qualified Internet hostname of the server where the
GWIA runs, such as gwia.example.com, or the name of the "A record" in your DNS table that
associates the hostname with the server's IP address.

WORKSHEET

Under Create Internet Agent, specify the hostname of the GWIA server as it appears in its DNS record if you
want to run the GWIA for this domain.

As your GroupWise system grows, you might want to set up a standalone GWIA in a domain that
does not own post offices.

Administrator Access for Domain Creation

The GroupWise Administration Service provides the GroupWise Administration console for managing
your GroupWise system. For background information, see Section 3.2, “Administration Service
Architecture,” on page 22.

As you configure the domain, the Installation console prompts you for the following information:

¢ Domain Admin Port
+ Primary Domain: Super Admin Creation

¢ Secondary Domain: Primary Domain Access

Domain Admin Port

An instance of the Admin Service runs on each GroupWise domain server so that you can access the
Admin console at the following URL.:

https://domain server address:9710/gwadmin-console
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Replace domain server address with the IP address or DNS hostname of the domain server. The
default Admin port for a domain is 9710.

The Admin Service also uses the Admin port to communicate with the MTA for the domain.

WORKSHEET

Under MTA Settings, specify the Admin port for the domain.

Use the default port number unless it is already in use on the server.

Primary Domain: Super Admin Creation

When you create the primary domain of a new GroupWise system, you create a GroupWise Super
Admin user. The Super Admin has all administrative rights throughout your GroupWise system. The
Super Admin can designate other Admin users with lesser rights, perhaps for specific domains or
post offices. For more information, see “GroupWise Administrators” in the GroupWise 2014
Administration Guide.

WORKSHEET

Under Credential Settings, specify the name for the GroupWise Super Admin user and the accompanying
password.

If you need to reset the Super Admin password at a later time, you can use the GroupWise
Administration utility (GWAdminULtil). For more information, see “Using the GroupWise Administration
Utility” in the GroupWise 2014 Administration Guide.

Secondary Domain: Primary Domain Access

When you create a secondary domain, you must be the GroupWise Super Admin or a GroupWise
system administrator, and know the associated password. For more information, see “GroupWise
Administrators” in the GroupWise 2014 Administration Guide.

WORKSHEET

Under System Settings, specify the administrator user name and password that provide access to the primary
domain in the Admin console.

You also need to know the network address of the primary domain server and the Admin port number
for the domain. You must be connected to the primary domain in order to create a secondary domain.

WORKSHEET

Under System Settings, specify the IP address or DNS hostname of the primary domain server and the Admin
port.
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8.3

8.3.1

8.3.2

8.3.3

Planning a Post Office

A post office contains users’ mailboxes. Like a domain, a post office requires a name and has a folder
structure.

As you create the post office, the Installation console prompts you for the following information:

+ Post Office Server

+ Post Office Name

+ Post Office Folder

+ Post Office Language

+ Post Office Time Zone

+ Agents in the Post Office

+ Administrator Access for Post Office Creation

Post Office Server

You can create a post office on Linux or Windows. Your GroupWise system can include both Linux
servers and Windows servers.

WORKSHEET

Under Platform, mark the operating system (Linux or Windows) that you plan to use for the post office.

Under Host, specify the IP address or DNS hostname of the server where you plan to create the post office.

Post Office Name

A post office, like a domain, requires a unique name. The name can reflect any element that makes
sense for your organization. For example, you could use a location (such as Provo) or a department
(such as Engineering).

The name is used as the Post Office object’'s name in the Admin console. It can appear in the
GroupWise Address Book.

The name should consist of a single string. Do not use any of the characters listed in Section C.1,
“Invalid Characters in GroupWise Object Names,” on page 247.

WORKSHEET

Under Post Office Settings, specify the post office name.

Post Office Folder

A post office requires a folder structure in which to store database files and temporary files that are
created during message routing and delivery. If you want, the folder name can reflect the post office
name you chose.

You must specify an empty folder. If the folder does not already exist, it is automatically created. The
installation process can proceed more smoothly if you create the folder in advance.
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8.3.4

8.3.5

Use the following platform-specific naming conventions for the folder name:

Linux: Use only lowercase characters.
Windows: No limitations.

WORKSHEET

Under Post Office Settings, specify the full path for the post office folder.

Post Office Language

The post office language determines the sort order for items in the GroupWise Address Book.

The post office assumes the same language as its domain unless you specify otherwise. For
example, if you set the domain and post office language to English, the GroupWise Address Book
items are sorted according to English sort order rules. This is true even if some users in the post
office are running non-English GroupWise clients such as German or Japanese. Their client interface
and help files are in German or Japanese, but the sort order in the GroupWise Address Book is
according to English standards. Time, date, and number formats for the non-English clients default to
the workstation language.

WORKSHEET

Under Post Office Settings, specify the language for the post office.

NOTE: The languages listed for selection in the Installation console includes more languages than
GroupWise supports. See “Multilingual GroupWise Systems” in the GroupWise 2014 Administration
Guide for a list of valid languages.

Post Office Time Zone

When a message is sent from a user in one time zone to a user in another time zone, GroupWise
adjusts the message’s time so that it is correct for the recipient’s time zone. For example, if a user in
New York (GMT -05:00, Eastern Time) schedules a user in Los Angeles (GMT -08:00, Pacific Time)
for a conference call at 4:00 p.m. Eastern Time, the appointment is scheduled in the Los Angeles
user’s calendar at 1:00 p.m. Pacific Time.

In a simple, single-server GroupWise system, the post office is automatically created with the same
time zone as the primary domain. In a typical, multiple-server GroupWise system, the post office time
zone defaults to the domain time zone, but you can change it as you create the post office.

WORKSHEET

Under Post Office Settings, specify the time zone where the post office is located.
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8.3.6

Agents in the Post Office

Two agents run for a post office. As you configure the agents for the post office, the Installation
console prompts you for the following information:

+ POA Configuration

+ DVA Configuration

The agent consoles are automatically available in the GroupWise Admin console. The agents are
configured to start automatically when the server restarts.

POA Configuration

The Post Office Agent (POA) responds to GroupWise client requests for mailbox data and delivers
messages between users’ mailboxes in a post office. The POA also communicates with the MTA to
route messages to and from the post office. In addition, the POA performs a variety of maintenance
tasks in the post office.

The POA requires a TCP/IP connection with the domain’s MTA. It also requires TCP/IP connections
with GroupWise clients. In order to configure the POA, you need to plan the following port numbers:

+ Client/Server Port: Used to communicate with GroupWise clients. The default client/server port
is 1677.

+ Message Transfer Port: Used to communicate with the MTA. The default MTP port for the POA
is 7101.

¢+ HTTP Port: Used to communicate with your web browser to provide the POA console. The
default HTTP port for the POA is 7181.

+ SOAP Port: Used to communicate with SOAP clients such as WebAccess and the GroupWise
Mobility Service. The default SOAP port for the POA is 7191.

Use the default port number unless it is already in use on the server.

WORKSHEET

Under POA Settings, specify the required port numbers.

For a complete list of default port numbers used by the GroupWise agents, see “GroupWise Port
Numbers” in the GroupWise 2014 Administration Guide.

DVA Configuration

The Document Viewer Agent (DVA) converts attached document files from a wide variety of formats
into HTML format for indexing by the POA and for viewing in GroupWise WebAccess. You can run up
to three DVASs to service conversion requests for a single instance of the POA. Each DVA must be
installed on a different server.

The DVA requires a TCP/IP connection with a POA. The default DVA port is 8301. Typically, the DVA
is set up along with a post office.

WORKSHEET

Under Create Document Viewer Agent, mark Yes or No.
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8.3.7

If you need to create a DVA on a server that does not have a post office and POA on it, see “Scaling
Your DVA Installation” in the GroupWise 2014 Administration Guide.

Administrator Access for Post Office Creation

In order to create a new post office, you need access to the owning domain.

¢ Owning Domain Access
¢ Post Office Admin Port

Owning Domain Access

When you create a post office, you must be the GroupWise Super Admin, a GroupWise system
administrator, or a domain administrator for the owning domain, and you must know the associated
password. For more information, see “GroupWise Administrators” in the GroupWise 2014
Administration Guide.

WORKSHEET

Under System Settings, specify the administrator user name and password that provide access to the owning
domain in the Admin console.

You also need to know the network address of the primary domain server or the owning domain
server, and the Admin port number for the domain.

WORKSHEET

Under System Settings, specify the IP address or DNS hostname of the domain server and the Admin port for
the domain.

Post Office Admin Port

An instance of the Admin Service runs on each GroupWise post office server. You never use this port
when you connect to the Admin console, but the Admin Service uses it to communicate with the POA
for the post office. The default Admin port for a post office is 9711.

WORKSHEET

Under POA Settings, specify the Admin port for the post office.
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8.4

8.4.1

8.4.2

Use the default port number unless it is already in use on the server.

Planning Users

When you create a new GroupWise system, you can manually add a few users in order to test your

new system. When you see that everything is working smoothly, you can add all of the users to your

GroupWise system.

For a simple, single-server GroupWise system, you might want to add the users to the internal

GroupWise directory. For a larger number of users, you can import them from an LDAP directory such

as NetlQ eDirectory or Microsoft Active Directory.

+ Manually Created Users

+ Imported Users

Manually Created Users

You manually create GroupWise users in the Admin console. You can manually create users
specifically for testing a new GroupWise system, or you can initially create users in the internal
GroupWise directory and then later associate them with users in an LDAP directory.

WORKSHEET

Under Users, list any users that you want to create for testing purposes in your new GroupWise system.

Imported Users

In order to import users from an LDAP directory into GroupWise, you need to gather the following

information about the LDAP directory so that GroupWise agents can access it:

+ Type: NetlQ eDirectory or Microsoft Active Directory.

¢ Address: The IP address or DNS hostname of the LDAP server.

+ Port: 636 if the LDAP server requires SSL; 389 if SSL is not required.

+ SSL Certificate: The location of the LDAP root certificate file on the LDAP server.
+ LDAP User: The user name for accessing the LDAP directory.

The user must have sufficient rights to read the LDAP User and Group objects that you plan to

import. Specify the information in the format used by the LDAP server. For example:

cn=user name,ou=org unit,o=organization|
cn=user_name,ou=users,dc=server name,dc=company name,dc=com

+ Password: The password for the LDAP user.

+ Base DN: (Optional) The LDAP context under which User and Group objects are located.
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You must also establish a name for the LDAP directory to be known in your GroupWise system. The
name should be clear and easy to remember, especially if you plan to have multiple GroupWise
administrators.

WORKSHEET

Under LDAP Directory Information, specify the name for the LDAP directory and list the required information for
connecting to the LDAP server.

8.5 GroupWise System Worksheets

Section 8.5.1, “Simple GroupWise System Worksheet,” on page 54

*

*

Section 8.5.2, “Primary Domain Worksheet,” on page 56

*

Section 8.5.3, “Secondary Domain Worksheet,” on page 57
Section 8.5.4, “Post Office Worksheet,” on page 58

*

8.5.1 Simple GroupWise System Worksheet

Installation Console Field Value for Your Simple GroupWise Explanation
System
Platform “Domain Server” on page 44
¢ Linux
+ Windows
Folders “Domain Folder” on page 45
+ Domain folder “Post Office Folder” on page 49

+ Post office folder

System Settings “GroupWise System Name” on

page 43
¢ System Name
. “GroupWise Internet Domain
¢ Internet Domain Name Name” on page 44

¢ Host ) )
“Domain Server” on page 44
+ |P address

¢ DNS hostname

Primary Domain Settings “Planning a Domain” on page 44

* GroupWise Domain Name
+ Domain Folder
+ Language

+ Time zone
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Installation Console Field

Value for Your Simple GroupWise Explanation
System

MTA Settings
¢ MTP Port

(default 7100)
¢ HTTP Port

(default 7180)
¢ Admin Port

(default 9710)

“MTA Configuration” on page 46

“Domain Admin Port” on page 47

Create Internet Agent

+ Hostname/DNS “A Record”
Name

“GWIA Configuration” on page 47

Create Post Office

+ Post Office Name

+ Post Office Folder

“Planning a Post Office” on page 49

Create Document Viewer Agent

* Yes

+ No

“DVA Configuration” on page 51

POA Settings
+ Client/Server Port

(default 1677)
+ MTP Port
(default 7101)
¢ HTTP Port
(default 7181)
¢ SOAP Port
(default 7191)
¢ Admin Port
(default 9711)

“POA Configuration” on page 51

“Post Office Admin Port” on
page 52

Credential Settings

¢ Admin Name

+ Password

“Primary Domain: Super Admin
Creation” on page 48
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Installation Console Field

Value for Your Simple GroupWise Explanation

System

Users
+ GroupWise Directory
*

*
+ LDAP Directory
+ eDirectory

+ Active Directory

“Planning Users” on page 53

LDAP Directory Information

+ Name
+ Type

+ eDirectory

+ Active Directory
¢ Address
+ Port
¢ Use SSL

+ No

* Yes

SSL Certificate

+ LDAP User
+ LDAP User Password

“Imported Users” on page 53

8.5.2 Primary Domain Worksheet

Installation Console Field

Value for the Primary Domain

Explanation

Primary Domain Platform

¢ Linux

+ Windows

“Domain Server” on page 44

Primary Domain Folder

*

“Domain Folder” on page 45

System Settings

¢ System Name
¢ Internet Domain Name
+ Host

+ |IP address

¢ DNS hostname

“GroupWise System Name” on
page 43

“GroupWise Internet Domain
Name” on page 44

“Domain Server” on page 44
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Installation Console Field

Value for the Primary Domain Explanation

Domain Settings

+ GroupWise Domain Name
+ Domain Folder
+ Language

+ Time zone

“Planning a Domain” on page 44

MTA Settings
¢ MTP Port

(default 7100)
¢ HTTP Port

(default 7180)
¢ Admin Port

(default 9710)

“MTA Configuration” on page 46

“Domain Admin Port” on page 47

Credential Settings

¢ Admin Name

+ Password

“Primary Domain: Super Admin
Creation” on page 48

8.5.3 Secondary Domain Worksheet

Installation Console Field

Value for the Secondary Domain Explanation

Domain Platform

¢ Linux

+ Windows

“Domain Server” on page 44

Domain Folder

*

“Domain Folder” on page 45

System Settings

¢ Primary Domain Host
¢ Primary Domain Admin Port
¢ Admin Name

+ Password

Secondary Domain: Primary
Domain Access
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Installation Console Field Value for the Secondary Domain

Explanation

Domain Settings

+ GroupWise Domain Name
¢ Domain Folder

+ Host

¢ Link to Domain

+ Language

+ Time zone

“Planning a Domain” on page 44

MTA Settings
¢ MTP Port

(default 7100)
¢ HTTP Port

(default 7180)
¢ Admin Port

(default 9710)

“MTA Configuration” on page 46

“Domain Admin Port” on page 47

Create Internet Agent

+ Hostname/DNS “A Record”
Name

“GWIA Configuration” on page 47

8.5.4 Post Office Worksheet

Installation Console Field Value for the Post Office

Explanation

Post Office Platform

¢ Linux

+ Windows

“Post Office Server” on page 49

Post Office Folder

*

“Post Office Folder” on page 49

System Settings

¢ Owning Domain Host
¢ Owning Domain Admin Port
¢ Admin Name

+ Password

“Owning Domain Access” on
page 52
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Installation Console Field

Value for the Post Office Explanation

Post Office Settings

*

*

*

*

*

Post Office Name
Host

Post Office Folder
Language

Time zone

“Planning a Post Office” on page 49

Create Document Viewer Agent

*

*

Yes
No

“DVA Configuration” on page 51

POA Settings

*

Client/Server Port

(default 1677)
MTP Port
(default 7101)
HTTP Port
(default 7181)
SOAP Port
(default 7191)
Admin Port
(default 9711)

“POA Configuration” on page 51

“Post Office Admin Port” on
page 52

Users

*

*

GroupWise Directory

.
*

LDAP Directory
+ eDirectory

* Active Directory

“Planning Users” on page 53
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Installation Console Field

Value for the Post Office

Explanation

LDAP Directory Information

¢+ Name
+ Type

+ eDirectory

+ Active Directory
+ Address
+ Port
¢ Use SSL

+ No

* Yes

SSL Certificate

+ LDAP User
+ LDAP User Password

Section 8.4.2, “Imported Users,” on
page 53
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Installing the GroupWise Server
Software

You should have already reviewed Chapter 8, “Planning Your GroupWise System,” on page 43 and
filled out the appropriate GroupWise System Worksheets. The following sections step you through
using the GroupWise Installation Wizard to install the GroupWise Server software.

Follow the installation instructions for the platform where you are creating your GroupWise system:

¢ Section 9.1, “Linux: Installing the GroupWise Preparing the Linux Server for Your GroupWise
Server Software,” on page 61 System
Running the Linux GroupWise Installation Wizard

If you are new to Linux, you might want to review
“Linux Basics for GroupWise Administration” in the
GroupWise 2014 Administration Guide before
beginning to install your GroupWise system on Linux.

+ Section 9.2, “Windows: Installing the GroupWise Preparing the Windows Server
Server Software,” on page 63 Running the Windows GroupWise Installation Wizard

9.1 Linux: Installing the GroupWise Server Software

¢ Section 9.1.1, “Preparing the Linux Server for Your GroupWise System,” on page 61

+ Section 9.1.2, “Running the Linux GroupWise Installation Wizard,” on page 61

9.1.1 Preparing the Linux Server for Your GroupWise System

1 Ensure that the server for your GroupWise system meets the system requirements listed in
Chapter 4, “GroupWise Administration Requirements,” on page 27.

2 Ensure that the Linux operating system media is available, either physically or in a repository, in
case the Installation Wizard needs to install supporting packages on the Linux server.

3 Ensure that the server has a static IP address.

4 (Optional) Ensure that the folders exist where you want to create your domain and post office
folder structures, as described in “Domain Folder” on page 45 and “Post Office Folder” on
page 49.

5 Continue with Running the Linux GroupWise Installation Wizard.

9.1.2 Running the Linux GroupWise Installation Wizard

1 In a terminal window, become root by entering su - and the root password.

2 Start the GroupWise Installation Wizard at the root of the downloaded GroupWise 2014 software
image:

./install.sh
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3 Type the number for the language in which you want to run the GroupWise Installation Wizard,
then press Enter to select OK.

Please select an option:

"Woccimentation

f
|
| 2 Installation
L

e — |

< 0K =< Exit =

4 (Optional) Type 1 for Documentation, then press Enter to review the Readme, Quick Start, and
Installation Guide to better prepare yourself for the installation.

5 Type 2 for Installation, then press Enter.

6 Type a to accept the License Agreement and display the Software list.

Please select an option:

| WGrouptise Server]

|2 Groupwise WebAccess

|3 GroupwWise Calendar Publishing Host
|4 GroupWise Monitor Agent

|5 Groupwise Monitor Application

e < Back > < Exit >

7 Type 1 for GroupWise Server, then press Enter to display the Actions list.

Please select an option:

| W1nstall]

2 Configure

|
|
|
L

5
|
|
|

]

E! < Back = !

8 Type 1 for Install, then press Enter to install the GroupWise Server component.

The packages for the GroupWise Server component (Admin Service and agents) are installed on
the server. If any supporting packages are not available on the server, the Installation Wizard
automatically installs them from the operating system media.

9 When the installation is finished, press any key to return to the Installation Options list.

All of the GroupWise agents are installed on every GroupWise server. The MTA and, optionally,
the GWIA are configured to run on a domain server. The POA and the DVA are configured to run
on a post office server.

10 Type 2 for Configure, then press Enter to start the GroupWise Admin Service and display
instructions for accessing the Installation console to create a new GroupWise system.

11 Right-click the URL under To install or configure a new GroupWise server, then click Open Link
to open your web browser.

If your web browser does not offer this functionality, open your web browser, then copy the URL
into it.

12 Accept the self-signed certificate that the Installation Wizard has automatically provided for
accessing the Installation console.
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13 Skip to the instructions for the type of GroupWise system that you want to create:
+ Chapter 10, “Creating a Simple GroupWise System,” on page 67
+ Chapter 11, “Creating a Typical GroupWise System,” on page 71

9.2 Windows: Installing the GroupWise Server
Software

You should have already reviewed Chapter 8, “Planning Your GroupWise System,” on page 43 and
filled out the appropriate GroupWise System Worksheets. The following sections step you through
using the GroupWise Installation Wizard to install the GroupWise Server software.

¢ Section 9.2.1, “Preparing the Windows Server,” on page 63

¢ Section 9.2.2, “Running the Windows GroupWise Installation Wizard,” on page 63

9.21 Preparing the Windows Server

1 Ensure that the server for your GroupWise system meets the system requirements listed in
Chapter 4, “GroupWise Administration Requirements,” on page 27.

2 Ensure that the server has a static IP address.
3 Ensure that the firewall on the server has the ports open that are used by the GroupWise agents.
For assistance, see “GroupWise Port Numbers” in the GroupWise 2014 Administration Guide.

4 (Optional) Ensure that the folders exist where you want to create your domain and post office
folder structures, as described in “Domain Folder” on page 45 and “Post Office Folder” on
page 49.

5 Continue with Running the Windows GroupWise Installation Wizard.

9.22 Running the Windows GroupWise Installation Wizard

1 Log in to Windows as an Administrator-equivalent user.

2 Run setup.exe at the root of the downloaded GroupWise 2014 software image to start the
GroupWise Installation Wizard.

e Novell GroupWise -
Novell. GroupWise. 2014 e
Documentation

Readme

Quick Start

Installation Guide

Full Documentation
Installation

GroupWise Server

GroupWise Client

GroupWise WebAccess

GroupWise Calendar Publishing Host
GroupWise Monitor

GroupWise Free/Busy Service
GroupWise MMC Plugin

3 (Optional) Review the Readme, Quick Start, and Installation Guide to better prepare yourself for
the installation.
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4 Click GroupWise Server to install the GroupWise Server component.

5 Select the language in which you want to perform the installation, then click OK to start the
GroupWise Server Setup Wizard.

iz Novell GroupWise Server Setup == -
Welcome to the Novell GroupWise Server
e Setup Wizard
Novell. The Setup Wizard will install Novell GroupWise Server on
s your computer. Click Mext to continue or Cancel to exit the
GrOUleSE Setup Wizard,
2014
14.0.0.114938

Back Mext

‘ Cancel

6 Click Next to continue.
7 Accept the License Agreement, then click Next to display the Custom Setup page.

i) Novell GroupWise Server Setup |;|i-

Custom Setup
Select the way you want features to be installed.

Click the icons in the tree below to change the way features will be installed.

Files for the Post Office (POA),
Meszage Transport (MTA), Internet
Agent (GWIA), Document Viewer
(DVA) and REST agents.

=3 ~ | Client Auto-Update Repc

This feature requires 373MB on
your hard drive, It has 1of 1
subfeatures selected. The
subfeatures require 590MB on your

hard drive.
< mn b

Location: C:'\Program Files\Movell\GroupWise Server),

Reset ” Disk Usage | | Back ” Next | | Cancel ‘

The following components are available for installation:

+ GroupWise Server: (Required) Consists of the Admin Service, the POA, the MTA, the
GWIA, and the DVA.

All of the GroupWise agents are installed on every GroupWise server. The MTA and,
optionally, the GWIA are configured to run on a domain server. The POA and the DVA are
configured to run on a post office server.

+ Client Auto-Update Repository: (Optional) Helps you distribute the GroupWise client
software to users’ Windows workstations.

For usage instructions, see “Using Client Auto-Update to Distribute the GroupWise Client
Software” in the GroupWise 2014 Administration Guide.

8 Click Next to continue, then click Install to install the GroupWise software.

9 When the GroupWise software has been installed, click Finish to return to the main page of the
Installation Wizard, then close the Installation Wizard.
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The Installation Wizard has created two new icons on your Windows desktop.

10 On your Windows desktop, double-click GroupWise Install 2 to open your web browser and
access the Installation console.
This starts the GroupWise Admin Service and launches the GroupWise Installation console in
your web browser.
After installation, use GroupWise Admin Console B to access the Admin console for ongoing
GroupWise system administration.

11 Accept the self-signed certificate that the Installation Wizard has automatically provided for
accessing the Installation console.

12 Skip to the instructions for the type of GroupWise system that you want to create:
+ Chapter 10, “Creating a Simple GroupWise System,” on page 67
+ Chapter 11, “Creating a Typical GroupWise System,” on page 71
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Creating a Simple GroupWise System

Before you create your simple GroupWise system, you should have reviewed the following sections
and completed the associated tasks:

O “GroupWise System Overview” on page 39

O “Planning Your GroupWise System” on page 43

O “Simple GroupWise System Worksheet” on page 54
[ “Installing the GroupWise Server Software” on page 61

You are ready to use the Installation console to create your simple GroupWise system.

Novell. GroupWisa

&-l Upgrade an Existing Domatn or Post Office to GroupWise 2014
0 Add a New Domain
d Add a New Post Office

IMPORTANT: As a security feature, the Installation console times out after one hour. For instructions

I EVRUTEERERIREERY - <o (1 4 Handling an tnsiallaiion fimeout” on paoe /)

1 In the GroupWise Installation console, click 0 Create a New GroupWise System to display the
System Settings page.

Create a New GroupWise System

% System Settings

redential Settings System Name |Groupwisesystem
Y Internet Domain Name: |mydomain.com
Host [

J
J
J
GroupWise Domain Name:  [MyDomain |
J

Domain Folder \ﬂgmupwiseﬂdnmain Browse.
Language English - US
Time Zone: (GMT-0700) Mountain Time (US & Canada)
MTA Setlings
=

Admin Port. [ 9710/83

Options.

O Create Internet Agent
[ create Post Office

2 Fill in the following fields from the Simple GroupWise System Worksheet:

System Name
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Internet Domain Name
Host

GroupWise Domain Name
Domain Folder

Language

Time Zone

MTA Settings

MTA MTP Port

MTA HTTP Port

Admin Port

Internet Agent Settings
Create Internet Agent
Hostname/DNS “A Record” Name
Post Office Settings
Create Post Office

Post Office Name

Post Office Folder

Create Document Viewer Agent
POA Client/Server Port
POA HTTP Port

POA MTP Port

Admin Port

You can click Help for more information about the fields.
Click Next to display the Credential Settings page:

Create a New GroupWise System

System Settings
% Credential Settings Admin Name: |admin |

Summary
Password: | |

Confirm Password: | |

Fill in the following fields from the Simple GroupWise System Worksheet:

Admin Name
Password

You can click Help for more information about the fields.

5 Click Next to display the Summary page.
6 Review the information that you have provided, then click Finish to create your simple

GroupWise system.
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7 Click GroupWise Administration Console to log in to the GroupWise Admin console.

o

Administration

Novell GroupWise 2014
User Name:
Password:

Login

» Settings

8 Specify the GroupWise Super Admin user name and password, then click Login.
9 Skip to Chapter 12, “Adding Users to Your GroupWise System,” on page 79.
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1.1

Creating a Typical GroupWise System

Before you create your GroupWise system, you should have reviewed the following sections and
completed the associated tasks:

O “GroupWise System Overview” on page 39
“Planning Your GroupWise System” on page 43
“Primary Domain Worksheet” on page 56
“Secondary Domain Worksheet” on page 57

“Post Office Worksheet” on page 58

aaaaa

“Installing the GroupWise Server Software” on page 61
You are now ready to create your GroupWise system.

+ Section 11.1, “Creating the Primary Domain,” on page 71

+ Section 11.2, “Adding a Secondary Domain,” on page 73

+ Section 11.3, “Adding a Post Office,” on page 75

+ Section 11.4, “Handling an Installation Timeout,” on page 77

+ Section 11.5, “Changing the Authentication Mode for the Installation Console,” on page 78

IMPORTANT: If you plan to install GroupWise in a clustered server environment, see “Clustering” the
GroupWise 2014 Interoperability Guide before starting to set up your GroupWise system.

Creating the Primary Domain

When you are finished installing the GroupWise Server software, the Installation Wizard automatically
displays the GroupWise Installation console:

Novell. GroupWisa

‘ ' Create a New GroupWise System

&-l Upgrade an Existing Domain or Post Office to GroupWise 2014

0 Add a New Domain
d Add a New Fost Office
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IMPORTANT: As a security feature, the Installation console times out after one hour. For instructions
to renew the session, see Section 11.4, “Handling an Installation Timeout,” on page 77.

1 In the GroupWise Installation console, click Create a New GroupWise System to display the
System Settings page.

Create a New GroupWise System

% System Settings
Credential Settings System Name |GroupwiseSystem

summary Internet Domain Name: |mydomain.com

GroupWise Domain Name: ‘My'Dumam

|
\
Host [ |
\
J

Domain Folder ‘tgruupwiseﬂdumain

Language: | English- US
Time zone: ({G4107:00) Mountain Time (U5 & Canada
MTA Settings

MTPPort 7100/

HTTP Part. | 7180|5

Admin Port: | 9710/

Options

[ create Intemet Agent
[ create Post Office

NOTE: The following steps assume that you do not want to run the Internet Agent in the primary
domain and that you do not want to create a post office on the same server with the primary
domain.

2 Fill in the following fields from the Primary Domain Worksheet:

System Name

Internet Domain Name
Host

GroupWise Domain Name
Domain Folder
Language

Time Zone

MTA Settings

MTA MTP Port

MTA HTTP Port
Admin Port

You can click Help for more information about the fields.
3 Click Next to display the Credential Settings page:

Create a New GroupWise System

System Settings
% Credential Settings Admin Name: |admin |

Summary
Password: | |

Contirm Password: | |

4 Fill in the following fields from the Primary Domain Worksheet:

Admin Name
Password
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You can click Help for more information about the fields.
5 Click Next to display the Summary page.

6 Review the information that you have provided, then click Finish to create the primary domain for
your GroupWise system.

7 (Optional) Click GroupWise Administration Console to display the GroupWise Admin console
and administer the domain.

For usage instructions, see Chapter 13, “Working with the GroupWise Administration Console,”
on page 83.

8 Continue with the task that you want to do next:
¢ Section 11.2, “Adding a Secondary Domain,” on page 73
+ Section 11.3, “Adding a Post Office,” on page 75

11.2 Adding a Secondary Domain

1 Install the GroupWise Server software on the domain server that you listed on the Secondary
Domain Worksheet.

For instructions, see Chapter 9, “Installing the GroupWise Server Software,” on page 61.

When you are finished installing the GroupWise Server software, the Installation Wizard
automatically displays the GroupWise Installation console:

Novell. GroupWisa

‘ ' Create a New GroupWise System

&-l Upgrade an Existing Domain or Post Office to GroupWise 2014

0 Add a New Domain
d Add a New Fost Office

IMPORTANT: As a security feature, the Installation console times out after one hour. For
instructions to renew the session, see Section 11.4, “Handling an Installation Timeout,” on
page 77.

2 In the GroupWise Installation console, click 0 Add a New Domain to display the System
Settings page.

Add a New Domain

% System Settings

Domain Settings Primary Domain Host I ]

Summary ==
i Primary Domain Admin Port | 9710|s

Admin Name: |admin |

Passwaord: | |
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3 Fill in the following fields from the Secondary Domain Worksheet:

Primary Domain Host
Primary Domain Admin Port
Admin Name

Password

You can click Help for more information about the fields.
4 Click Next.

Because no GroupWise software is yet installed on the new GroupWise server, the connection
between it and the owning domain server is not yet trusted. This is normal.

Untrusted Server Connection Close %

The secure connection to the domain "137.6.7.18" 15 not trusted. Verfy the server certificate and
confim

Issuer DN:  CN=PROVO1-CA, OU=ADMIN, OU=GROUPWISE, O=EXAMPLEGROUPWISESYSTEM
Subject DM CH=Provol, OU=ADMIN, OU=GROUPWISE, O=EXAMPLEGROUPWISESYSTEM
‘alid Mot Before:  Jul 26, 2013 04:52:45 PM
Expires: Jul24, 2023 04:.52:45 PM

Trust Connection M Decline J

5 Click Trust Connection to display the Domain Settings page.

Aﬂd a New Domain

System Settings

= Domain Settings GroupWise Domain Mame: [NewDomain ]
Summary Domain Folder: [fgruupwise.fdumain ]
Host: [ ]
Link To Damain | Proval z|
Language: | English - Us )
Time Zone: | (GMT-07:00) Mountain Time (US & Canada) <
MTA Settings
MTP Port: 7100|5

HTTP Port | 7180/ 55

AdminPort: | 9710|53

[ create internet Agent

Hostname/DNS "A Record" Name:

6 Fill in the following fields from the Secondary Domain Worksheet:

GroupWise Domain Name
Domain Folder

Host

Link to Domain

Language

Time Zone

MTA Settings

MTA MTP Port

MTA HTTP Port
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Admin Port
Internet Agent Settings
Hostname/DNS “A Record” Name (optional)

You can click Help for more information about the fields.
7 Click Next to display the Summary page.

8 Review the information that you have provided, then click Finish to create a secondary domain in
your GroupWise system.

9 (Optional) Click GroupWise Administration Console to display the GroupWise Admin console
and administer the domain.

For usage instructions, see Chapter 13, “Working with the GroupWise Administration Console,”
on page 83.

10 Continue with Adding a Post Office.

11.3 Adding a Post Office

1 Install the GroupWise Server software on the post office server that you listed on the Post Office
Worksheet.

For instructions, see Chapter 9, “Installing the GroupWise Server Software,” on page 61.

When you are finished installing the GroupWise Server software, the Installation Wizard
automatically displays the GroupWise Installation console:

Novell. GroupWisa

‘ ' Create a New GroupWise System

&-l Upgrade an Existing Domain or Post Office to GroupWise 2014

0 Add a New Domain
d Add a New Fost Office

IMPORTANT: As a security feature, the Installation console times out after one hour. For
instructions to renew the session, see Section 11.4, “Handling an Installation Timeout,” on
page 77.

2 In the GroupWise Installation console, click d Add a New Post Office to display the System
Settings page.

Add a New Post Office

& System Settings
FOA Settings Owning Domain Host: H J

Summary prr—
! Owning Domain Admin Port. | 9710|853

Admin Name: |admin |

Password | |
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3 Fill in the following fields from the Post Office Worksheet:

Owning Domain Host
Owning Domain Admin Port
Admin Name

Password

You can click Help for more information about the fields.
4 Click Next.

Because no GroupWise software is yet installed on the new GroupWise server, the connection
between it and the owning domain server is not yet trusted. This is normal.

Untrusted Server Connection Close %

The secure connection to the domain "137.6.7.18" 15 not trusted. Verfy the server certificate and
confim

Issuer DN:  CN=PROVO1-CA, OU=ADMIN, OU=GROUPWISE, O=EXAMPLEGROUPWISESYSTEM
Subject DM CH=Provol, OU=ADMIN, OU=GROUPWISE, O=EXAMPLEGROUPWISESYSTEM
‘alid Mot Before:  Jul 26, 2013 04:52:45 PM
Expires: Jul24, 2023 04:.52:45 PM

Trust Connection M Decline J

5 Click Trust Connection to display the Post Office Settings page.

Add a New Post Office

System Settings

=% Post Office Settings GroupWise Domain Name:  Provol
Summary Post Office Name: {NeanstOﬁice ]
Host: ‘ |
Fost Office Folder: [Jgroupwiseinewpostoﬁice ]
Language: [English-us |z
Time Zone | (GMT-07:00) Mountain Time (US & Canada) e

[ create Document viewer Agent

POA Settings

ClientiServer Port: | 1677|E

MTP Part [ 7|5
HTTP Port: 71815
SOAP Port 7191|8

Adrmin Port [ o8

6 Fill in the following fields from the Post Office Worksheet:

Post Office Name

Host

Post Office Folder
Language

Time Zone

POA Settings

POA Client/Server Port
POA MTP Port

POA HTTP Port
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Admin Port
Create Document Viewer Agent

You can click Help for more information about the fields.
7 Click Next to display the Summary page.

8 Review the information that you have provided, then click Finish to create a new post office in
your GroupWise system.

9 Click GroupWise Administration Console to display the GroupWise Admin console.
10 Skip to Chapter 12, “Adding Users to Your GroupWise System,” on page 79.

Handling an Installation Timeout

As a security feature, the Installation console times out after one hour. This helps prevent access by
unauthorized persons if the Installation console is left unattended. When an installation session times
out, you see the following page:

o

Installation

Novell GroupWise 2014

Authorize Install

To proceed you must authorize this installation by
running the following command:

This screen will automatically advance upaon
authorization.

You then run the following command to obtain a new security token:

Linux: /opt/novell/groupwise/admin/gwadmin-ipc authorize token string

Windows: c:\Program Files\Novell\GroupWise Server\admin\gwadmin-ipc.exe
authorize token string

If the Timeout page does not provide a token string, use the following method to gain access to the
Installation console:

Linux: Reselect Configure in the Installation Wizard to authorize the Installation console session.
Windows: Close the existing browser window.

Double-click GroupWise Install E on the desktop to start a new authorized Installation console
session.
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11.5 Changing the Authentication Mode for the
Installation Console

By default, the Installation console uses token-based authentication. After initial installation, you can
change the authentication method as needed.

To configure the Installation console to prompt for a user name and password to allow access, use
the following command:

gwadminutil installcfg -m user -u user name -p

To configure the Installation console to not allow logins so that the configuration of your GroupWise
system cannot be changed by unauthorized users, use the following command:

gwadminutil installcfg -m disabled

To re-enable logins, specify an authentication method:

gwadminutil installcfg -m token
gwadminutil installcfg -m user -u user name -p
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Adding Users to Your GroupWise
System

You can add users to your new GroupWise system by manually typing the user information or by
importing the user information from an LDAP directory such as NetlQ eDirectory or Microsoft Active
Directory. You use the Admin console for either approach. You need to create at least two users in
order to test your new GroupWise system.

+ Section 12.1, “Manually Adding Users to the Internal GroupWise Directory,” on page 79
¢ Section 12.2, “Importing Users from an LDAP Directory,” on page 80
+ Section 12.3, “Testing the Users,” on page 82

121 Manually Adding Users to the Internal GroupWise
Directory

1 In the GroupWise Admin console, click Users > New.

UserMame:

First Mame:

LastMame:

Post Office: e
[T create another user

DK " Cancel
0 [ ok N Cancel ]

2 Specify the user’s GroupWise user name, along with the user’s first name and last name.
3 In the Post Office field, start typing the name of the post office to select it.
or
Select the post office from the drop-down list.
4 Select Create Another User to create at least one more user in your new GroupWise system.

For more detailed information about planning and adding users, see “Creating GroupWise
Accounts” in the GroupWise 2014 Administration Guide.

5 To provide additional information for each user, click Users, then click each user to display and
edit the properties of each User object.

6 After you have created at least two users, skip to Section 12.3, “Testing the Users,” on page 82.
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12.2 Importing Users from an LDAP Directory

In order to add users to your new GroupWise system from an LDAP directory such as NetlQ
eDirectory or Microsoft Active Directory, you must first provide configuration information about the
LDAP directory, and then import the users.

¢ Section 12.2.1, “Providing LDAP Directory Information,” on page 80
+ Section 12.2.2, “Importing Users,” on page 81

12.21 Providing LDAP Directory Information

1 In the GroupWise Admin console, click System > LDAP Servers > New Directory.

New Directory
General

Name: |

Description:

Type: eDirectory -
Address:
Pot 389 [FysessL
SSL Certificate: T ||
LDAP User.
LDAP User Password

Test Connection

Base DN
SyncDomain: | 7 -

[¥] Enable Synchronization

o Lok _J Cancel J

2 Fill in the following fields from the Simple GroupWise System Worksheet or the Post Office
Worksheet:

Name

Type

Address

Port

SSL Certificate (if needed)
LDAP User

LDAP User Password
Base DN (optional)

You can click Help for more information about the fields. For more detailed instructions, see
“Setting Up an LDAP Directory” in the GroupWise 2014 Administration Guide.

3 Click Test Connection to verify that you have specified the required information correctly.
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4 Click OK to save the LDAP directory information and add the LDAP directory to the list of LDAP

directories.

.LDAIQ' Servers. and birec‘tories

MNew D_\redory Mew LDAP Senver
[ MName

[l @ Example eDirectory

Description

5 Click Close to close the list and return to the main Admin console window.

6 Continue with Importing Users.

Importing Users

1 In the GroupWise Admin console, click System > User Import.

Import Users From Directory Close %'

Import User from LDAP directory into GroupWise.

Directory: |Example eDirectory E

Post Office:

Context Information

Base DN: ou=users,o=novell
Context
LDAP Filter.
[ search Sub tree
¥l search Users
Eindude Groups
)

Cancel

2 Select the post office to import the users into.

3 Click Preview to list the users to import.

4 (Conditional) If there are individual users that you do not want to import, delete them from the

list.

5 (Conditional) If the list is too long, use the Context and LDAP Filter fields to restrict the list, then

click Update Preview.

You can click Help for more information about the fields.

Preview

Users to import into GroupWise: 4
LDAP User Name

RS eman oU=US 815 0=ROVE
cn=fdriscoll, ou=users,o=novell
cn=nopdyke ou=users,o=novell

cn=rbranagan,ou=users,o=novell

Object ID

fdriscoll Marketing Pr.
nopdyke. Marketing.P_..

rbranagan.Marketing....

Update Preview

Action

Exclude [+]
Add x
add x
Add x
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6 When the list contains the correct set of users, click Import Users to perform the import.

Preview

Users imported: 3 Update Preview

LDAP User Name Object ID Action

cn=fdriscoll, ou=users,o=novell fdriscoll. Marketing.Pr_.. € Success

cn=nopdyke,ou=users,o=novell nopdyke. Marketing.P... @ Success

cn=rbranagan,ou=users,o=novell rbranagan.Marketing.... € Success
7 Click Close.

8 To see that the users have been imported, click Users.
9 Continue with Testing the Users.

12.3 Testing the Users

1 Install the GroupWise client in order to provide mailbox access on a Windows workstation.

See Chapter 19, “Installing the GroupWise Client,” on page 175 for workstation system
requirements and installation instructions.

2 Log in as each test user and exchange email messages in order to test the POA and the MTA.

3 Exchange email messages with colleagues whose email systems are across the Internet from
your GroupWise system in order to test the GWIA.

4 Continue with the next task that interests you:
+ Chapter 13, “Working with the GroupWise Administration Console,” on page 83
¢ Chapter 14, “Working with the GroupWise Agents,” on page 89
+ Chapter 15, “What’s Next,” on page 107
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13.1

Working with the GroupWise
Administration Console

The GroupWise Administration console enables you to perform GroupWise administration anywhere
you have a web browser and an Internet connection.

+ Section 13.1, “Accessing the Admin Console,” on page 83

*

Section 13.2, “Making the Most of the System Overview,” on page 84

*

Section 13.3, “Finding Objects in Object Lists,” on page 85

*

Section 13.4, “Finding Frequently Used Objects Quickly,” on page 86

*

Section 13.5, “Working with Objects and Object Properties,” on page 87

*

Section 13.6, “Using System Tools,” on page 87

Accessing the Admin Console

When you complete a session in the Installation console, you can go immediately into the Admin
console.

NOTE: If your installation session times out before you access the Admin console, see Section 11.4,
“Handling an Installation Timeout,” on page 77.

To access the Admin console directly:

1 Click the Admin console icon () on your desktop.
or

Display the following URL in your web browser:
https://groupwise server address:admin port/gwadmin-console

Replace groupwise server address with the IP address or DNS hostname of the GroupWise
server. If you are not using the default Admin port, replace admin port with the Admin port
number. If you are using the default Admin port number, you do not need to specify it.
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13.2

The Admin console displays:

Novell. G admin | Logout

Con nain: ( Provo es
Spem verven 0%

6‘ Ouarview ﬁ Provo1 0 Prova2 0 Provo3
System o B MTA o B VA o B v

e Domains @ - GWA @ -E GWA @ (@ Sales

|_-|| Past Offices @ (7] Engineering & (] Marketing

ﬂ Post Office Agents
E Message Transfer Agents

"E Internet Agents

& Users
ﬂ- Groups

! g] Resources

A Nicknames

ﬁ Libraries

Making the Most of the System Overview

On the System Overview page, you can quickly view and configure all domains, post offices, and
agents in your GroupWise system. The System Overview page also provides status information for all
GroupWise agents, with easy access to their agent consoles and to the controls for starting and
stopping them.

System Overview =) &
B rrovat @ Pz @ Prova

o R v o B via o8B via

@ -E GwiA @ -E GwiA © (] Sales

(] |j Engineering F)|j Marketing

Domains are automatically added to the System Overview page when you create them.
1 If you do not want a specific domain to be displayed, simply close it.
2 To display it again, click Options & > Add Domains.
3 Click a domain, post office, or agent to view its properties.

Agents display status indicators to show whether they are running.
To stop or start an agent:

1 Click Running &% or Stopped £3.

2 Click the name of the agent to display agent properties.

3 Click Stop Agent or Start Agent.

The agent consoles can also be displayed from the status icons and from the agent properties
pages when the agents are running.
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13.3 Finding Objects in Object Lists

Clck any objct tpe in oo

the Administration

. . ey Mew Export
panel to list all objects & Ovemiew ——
of that type in your System B Frovo
GroupWise system. & oomaine @ Frowez

|;-|| Post Offices @ Frowz

Click @ to collapse the
Administration panel SO Iﬂl Post Office Agents
that only the icons

E Message Transfer Agents
display.

=E Internet Agents

& Users
% Groups

| /ﬂ Resources

4 Nicknames

Nl Libraries

After you display Boma Proval

Domain Type

Primary
Secondary
Secondary

Description

()

object properties fora | 4.
domain or post office,
you can list just the

bjocts that belong to Ojecs

that domain or post

Maintenance Client Options More = Diagnostics =

New.
office. ] Past Offices Fl Name Past Office
Users [C] g aramirez  Engineering
{_ﬂ- LRI [ s gfamsw. Engineering
I Resources
2 Hickname B L owhee Engineering
21 Post Ofice Agents [ s jpangili. Engineering
ﬁ Message Transfer Agents [ pg mpalu Engineering
=Z Internet Agents [T =4 sjones Engineering
Wil Libraries [ pgthu Engineering

(@ Addressing Rules

To add more columns to an options list, click Options (&), then select the columns to add.

You can use the Search field to shorten a long list by including only those objects that match the

Export

Domain
Provol
Provo1
Provol
Provol
Provol
Proval

Provol

First Mame

Art

Greg
George W
Jon

Mike
Sophi

Tabitha

Last Mame
Ramirez
Farmsworth
Freeman
Pangilinan
Palu
Jones

Hu

File ID
ved
729
ulo
Ovg
gap
tca

dk&

search criteria. As a simple case in the list above, you could type the letter g and then press Enter to

list only the GroupWise user names that begin with “G.”
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But the Search field is much more powerful than that. You can search on any GroupWise object
attribute and list only those objects that have the matching attribute. To see a complete list of
attributes to search on for the displayed object type, press Ctrl+Spacebar in the Search field. Here
are some common searches:

Object List Search Criteria Explanation

Domain domainversion<2014 All domains that have not yet been upgraded
to GroupWise 2014.

Post Office intruderdetection=false All post offices where intruder detection has
not yet been enabled.

Post Office Agent soapenabled=false All POAs where SOAP is not enabled.

Message Transfer Agent loglevel=diagnostic All MTAs where the Log Level is set to
Diagnostic.

Internet Agent bindexclusive=false All GWIAs that are not configured to find to a

specific IP address.
User visibility!=system All users who are not visible to all other users
in the GroupWise Address Book.

For complete usage details, see Appendix B, “Attributes, Operators, and Values for Object Filters,” on
page 243.

13.4 Finding Frequently Used Objects Quickly

86

When you are not quite sure what you are looking for, the object lists available from the
Administration panel can help you find it. After you have gone to the same object many times, there
are faster ways to display the object that you want.

Global Search As you start typing in the Global Search field, the Admin console starts building a list of
objects that match. When you see what you want, click the object in order to go to its property

page.

Recent Every object that you go to is added to your Recent list, with the most recent object at the top
of the list. This makes it very easy to return to any object that you have worked with recently.

Favorites Any object you go to can be added to your Favorites list. Click ~  in the upper-right corner of
any object property page to add it to your Favorites list. Favorite objects are alphabetized in
the list so that your Favorites list has a predicable order.

A 7 on an object property page shows that it is on your Favorites list. Click = to remove that
object from your Favorites list.
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13.5

13.6

Working with Objects and Object Properties

You can edit the properties of any GroupWise objects that you have rights to modify. If you are logged
in to the GroupWise Admin console as the GroupWise Super Admin, you can edit all objects. If you
are logged in as a subordinate administrator, objects that you do not have rights to modify are
dimmed. GroupWise tools on the System page are dimmed if you do not have rights to use them

Usually, when you work with objects, your changes are saved immediately. Sometimes, changes
need to replicate throughout your GroupWise system before the change is complete. When that
happens, the object is dimmed and you cannot make further changes to the object until replication is
finished.

Using System Tools

You can find all of the GroupWise system operations and object-specific utilities on the System page.

Cj,g Addressing Rules Global Signatures ﬁ‘.g Recover Deleted Account
B8 Admin Defined Fields Li) Information £ Restore Area Management
',i_' Administrators @ Internet Addressing I-ng' System Preferences

alendar Publishing P> LoAP servers Time Zones
@ Directory Associations - Legacy & Trusted Applications
,@ Email Address Lookup .EI Link Configuration @ User Import
e ’ oy y .
F(© Expired Records &1 Pending Operations ﬁ User Move Status

2] External system Synchronization =) Record Enumerations

The System tools are described in detail in the GroupWise 2014 Administration Guide:

~#@ Addressing Rules: Configures GroupWise to perform text See “Addressing Rules.”
=¥8|  sybstitutions in email addresses when messages are sent.

== Admin-Defined Fields: Maps LDAP directory user fields to GroupWise See “Admin-Defined Fields.”
=22

fields so that they can be displayed in the GroupWise Address Book.

Lﬂ Administrators: Grants administrator rights to GroupWise users ona  See “Administrators.”
system, domain, and post office basis.

Calendar Publishing: Sets up and configures Calendar Publishing See “Calendar Publishing
Hosts, so that users can publish their GroupWise personal calendars on Host.”
the Internet.

mEEEm

Directory Associations: Creates or redefines links between users in ~ See “Directory Associations.”
#i= an LDAP directory (such as NetlQ eDirectory or Microsoft Active
Directory) and GroupWise.

B Document Viewer Agent: Converts attached document files into See “Document Viewer
'. HTML format for display in GroupWise WebAccess and for indexing by Agent.”
the POA, if the POA has been configured to use it.

= Email Address Lookup: Searches for the GroupWise object (User, See “Email Address Lookup.’
Resource, or Group) that an email address is associated with.
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Expired Records: Displays the GroupWise user accounts that have an
expiration date assigned to them.

External System Synchronization: Automatically synchronizes
information between your GroupWise system and an external
GroupWise system connected to your local system.

Global Signatures: Establishes a list of globally available signatures
that can be automatically appended to messages sent by GroupWise

users.

Information: Summarizes useful information about your GroupWise
system, including the numbers of all types of objects, along with
mailbox and license statistics.

Internet Addressing: Establishes the allowed and preferred formats
for Internet email addresses in your GroupWise system.

LDAP Servers: Defines LDAP directories (such as NetlQ eDirectory
and Microsoft Active Directory) and physical LDAP servers for use with

your GroupWise system.

Legacy: Provides for the removal of legacy software distribution
directories and gateways from your GroupWise 2014 system.

Link Configuration: Manages the links between domains throughout

your GroupWise system.

Pending Operations: Monitors and resolves the pending
administrative operations that have not yet been permanently written to
the appropriate GroupWise databases.

Record Enumerations: Displays by record type the data associated
with any record in a GroupWise database.

Recover Deleted Account: Re-creates recently deleted user and
resource accounts from a backup version of the GroupWise primary

domain database.

Restore Area Management: Manages backup copies of post offices
so that you or GroupWise users can retrieve mailbox items that are
unavailable in your live GroupWise system.

System Preferences: Configures the defaults for various GroupWise

system-wide settings.

Time Zones: Provides for modifying existing time zone definitions and

adding new definitions.

Trusted Applications: Creates and configures GroupWise trusted
applications, which log into POAs and GWIAs in order to access
GroupWise mailboxes without needing personal user passwords.

User Import: Imports user information from an LDAP directory (such as
NetlQ eDirectory or Microsoft Active Directory) when creating

GroupWise user accounts.

User Move Status: Manages the process of moving mailboxes from

one post office to another.
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14.1

Working with the GroupWise Agents

The GroupWise agent software is automatically installed when you create domains and post offices.
For a domain, you run the MTA and optionally the GWIA. For a post office, you run the POA and
optionally the DVA. All of the agents are configured to automatically restart whenever the server
restarts.

Basic agent monitoring and management is most easily performed on the System Overview page in
the Admin console. For instructions, see Section 13.2, “Making the Most of the System Overview,” on
page 84.

This section covers additional agent management tasks that apply to all of the GroupWise agents:

+ Section 14.1, “Linux: Managing the Manually Starting and Stopping the Linux GroupWise Agents
GroupWise Agents,” on page 89  Running the Linux GroupWise Agents as a Non-root User

Automatically Restarting the Linux GroupWise Agents with the
GroupWise High Availability Service

Monitoring the Agents from Your Web Browser
Using the Linux GroupWise Agent Log Files
Uninstalling the Linux GroupWise Agents and Applications

If you are new to Linux, you might want to review “Linux Basics for
GroupWise Administration” in the GroupWise 2014 Administration
Guide before you work with the GroupWise agents on Linux.

+ Section 14.2, “Windows: Managing Manually Starting and Stopping the Windows GroupWise Agents
the GroupWise Agents,” on Monitoring the Agents from Your Web Browser
page 102 Using the Windows GroupWise Agent Log Files
Uninstalling the Windows GroupWise Agents and Applications

For detailed configuration information about each agent, see the following sections in the GroupWise
2014 Administration Guide:

+ “Post Office Agent”

+ “Message Transfer Agent”

¢ “Internet Agent”

+ “Document Viewer Agent”

Linux: Managing the GroupWise Agents

Basic agent monitoring and management is most easily performed on the System Overview page in
the Admin console. For instructions, see Section 13.2, “Making the Most of the System Overview,” on
page 84. Refer to the following additional tasks as you maintain all the GroupWise agents on Linux:
¢ Section 14.1.1, “Manually Starting and Stopping the Linux GroupWise Agents,” on page 90
¢ Section 14.1.2, “Running the Linux GroupWise Agents as a Non-root User,” on page 92

+ Section 14.1.3, “Automatically Restarting the Linux GroupWise Agents with the GroupWise High
Availability Service,” on page 95
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14.1.1

+ Section 14.1.4, “Using the Linux GroupWise Agent Log Files,” on page 101
+ Section 14.1.5, “Uninstalling the Linux GroupWise Agents and Applications,” on page 101

If you are new to Linux, you might want to review “Linux Basics for GroupWise Administration” in the
GroupWise 2014 Administration Guide before you work with the GroupWise agents on Linux.

Manually Starting and Stopping the Linux GroupWise
Agents

+ “Starting and Stopping the Linux Agents as Services” on page 90

¢ “Starting the Linux Agents with a User Interface for Troubleshooting” on page 91

Starting and Stopping the Linux Agents as Services

+ “Using the grpwise Script” on page 90
¢ “Using the gwsc Command” on page 91

Using the grpwise Script

All of the Linux GroupWise agents except the Monitor Agent can be started as services by using the
grpwise script. The Monitor Agent uses its own customized grpwise-ma script that works essentially
the same way. When the agents run as services, they do not have a user interface.

In the grpwise script, each agent is designated in terms of the name of the domain and post office
associated with it, in the following format:

POA: post_office.domain
MTA: domain

GWIA: gwia.domain

DVA: gwdva

Use the following set of rcgrpwise commands to start and stop the agents as services and verify
their status:

rcgrpwise status Displays the status of the GroupWise agents that are
configured to run on the server.

rcgrpwise status agent location name Displays the status of the specified agent.

rcgrpwise start Starts/restarts the GroupWise agents that are

rcgrpwise restart configured to run on the server.

rcgrpwise start agent location name Starts/restarts the specified agent.

rcgrpwise restart agent location name

rcgrpwise stop Stops the GroupWise agents that are configured to
run on the server.

rcgrpwise stop agent location name Stops the specified agent.

If an agent does not respond to the rcgrpwise
stop command, you can use the Linux kill
pid_number command to stop it.
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rcgrpwise print Lists the contents of the gwha . conf file where the
agents are configured.

For information about the gwha.conf file, see
Section 14.1.3, “Automatically Restarting the Linux
GroupWise Agents with the GroupWise High
Availability Service,” on page 95.

When the agents run without a user interface, you can monitor them by using their agent consoles.
See Section 14.3, “Monitoring the Agents from Your Web Browser,” on page 105.

Using the gwsc Command

You can also manage the GroupWise agents by using the gwsc command, which is short for the
gwadminutil services command.

For the gwsc command, each agent is designated in terms of its object name or of the name of the
domain and post office associated with it:

POA: poa_object name or post office name
MTA: mta_object name or domain name
GWIA: gwia object name

DVA: dva_object name

Use the following set of gwsc commands to start and stop the agents as services and verify their
status:

gwsc -query Displays the status of the GroupWise agents that are
configured to run on the server.
gwsc -query name Displays the status of the specified agent.

gwsc -start Starts the GroupWise agents that are configured to
run on the server.

gwsc -start name Starts the specified agent.

gwsc -stop Stops the GroupWise agents that are configured to
run on the server.

gwsc -stop name Stops the specified agent.
gwsc -list Lists the agent services that are configured on the
server.

Starting the Linux Agents with a User Interface for Troubleshooting

In general, you should run the Linux agents as services without a user interface, so that they can be
managed in the Admin console.

Occasionally, when troubleshooting a problem that occurs at agent startup, the problem can occur
before the agent console can be displayed and before error messages can be written to the agent log
file. Under such circumstances, you can start an agent with a user interface in order to view any
errors that the agent displays on the server console before the agent stops again.
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IMPORTANT: When an agent is running with a user interface, it cannot be managed in the Admin
console.

1 In a terminal window, become root by entering su - and the root password.
2 Change to the GroupWise agent bin directory.
cd /opt/novell/groupwise/agents/bin
3 Enter one of the following commands to start an agent with a user interface:
Syntax:

./gwpoa --show --home /post office folder &
./gwmta --show --home /domain folder &
./gwia --show --home /gwia folder &

Example:

./gwpoa --show --home /mail/polnx &
./gwmta --show --home /mail/domlnx &
./gwia --show --home /mail/domlnx/gwia &

The --show startup switch starts the agent with a server console interface. This user interface
requires that the X Window System and Open Motif be running on the Linux server.

The --home startup switch specifies the directory that is required to start the agent.

The ampersand (&) causes the agent to run in the background, so that the terminal window you
started it in is again available for use.

NOTE: The DVA cannot be started with a user interface.

Running the Linux GroupWise Agents as a Non-root User

For security reasons, it is preferable that the GroupWise agents do not run with root user privileges.
For example, if an intruder manages to assume the identity of a GroupWise agent, the intruder gains
all the privileges of the commandeered process. If the process is running with root user privileges,
then the intruder has root access to your system. If the process is running as a user with minimal
privileges, then the intruder has only restricted access to your system. Therefore, your system is
more secure if the GroupWise agents do not run as root.

The root user still needs to start the agents, because the agents do need to access some root-only
resources on startup. However, you can configure the agents to switch to a different user after they
start. After the agents are running as the non-root user, they need adequate access to the locations
where each domain, post office, and library is located.

+ “Setting Up Typical Non-root Access” on page 93

+ “Setting Up Non-root Access on an NSS Volume on Novell Open Enterprise Server” on page 93

+ “Changing the Non-root User” on page 95

NOTE: You can configure the POA, MTA, and GWIA to run as a non-root user. The DVA must still
run as root. Unlike the other agents, the Monitor Agent can be started as a non-root user by default,
s0 no setup is required for it to run as a non-root user.
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Setting Up Typical Non-root Access

To configure the GroupWise agents to switch users after startup:

1
2

Ensure that you are logged in as root.

Select a Linux user for the agents to run as, and ensure that the user is listed in the /etc/
passwd file.

You might want to create a new user specifically for this purpose, perhaps named gwagents. The
user name must not match any local user names on the Linux server.

IMPORTANT: All agents running on the same server must run as the same user.

Change to the groupwise folder under /etc:
cd /etc/opt/novell/groupwise
Create a new agents folder, then change to that folder:

mkdir agents
cd agents

5 Create a file named uid. conf.

6 Type the selected user name in the file, for example:

9

gwagents

Stop and then start the agents.

While starting as root, the agents automatically change the ownership of the domain and post
office folder structures from root to the user you specified in the uid. conf file. Then they switch
users and run as the user you specified, rather than as root.

IMPORTANT: The first time you start an agent as a non-root user (or if you change from one
non-root user to another), the agent might take longer than usual to start, because of the
change in ownership of the directories and files accessed by that agent. This is especially true of
a POA that services a large post office and that requires access to a restore area, especially a
restore area on a remote server.

(Optional) List the agent processes to see that they are no longer running as root.
ps -eaf | grep gw

Repeat Step 1 through Step 8 on each domain and post office server.

Later on, if you want to change the user that the agents are running as, follow the instructions in
“Changing the Non-root User” on page 95.

Setting Up Non-root Access on an NSS Volume on Novell Open
Enterprise Server

When your domains, post offices, and libraries are located on a Novell Open Enterprise Server (OES)
NSS volume, you must set up an eDirectory user for the agents to run as and you must Linux-enable
that user. On OES, you can use NetlQ iManager to accomplish these tasks.

To configure the agents to switch users after startup and provide access to an NSS volume:

1

Select or create an eDirectory user for the agents to run as.
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You might want to create a new user specifically for this purpose, perhaps named gwagents. The
user name must not match any local user names on the Linux server.

1a From the Open Enterprise Server Welcome page in your web browser, click the
Management Services tab, then click iManager.

1b To log in to iManager, specify a user name, a password, and a tree.
1c In the left pane, expand Users, then click Create User.
1d Provide the required information, then click OK.

The user does not need a password

IMPORTANT: All agents running on the same server must run as the same user.

Linux-enable the user you just created:

2a In the left pane, expand Linux User Management, then click Enable User for Linux.
2b Browse to and select the user you just created, then click OK.

2c Select the primary group for the user to belong to (for example, admingroup).

2d Change /bin/bash to /bin/false because the user does not need a shell.

2e Click OK to Linux-enable the user.

3 Ensure that you are logged in as root.

4 Change to the groupwise folder under /etc:

cd /etc/opt/novell/groupwise
Create a new agents folder, then change to that folder:

mkdir agents
cd agents

6 Create a file named uid. conf.

7 Type the selected user name in the file, for example:

10

gwagents
Use the following command to grant the user the required rights to the folders that the agents
need to access on the local server:

rights -f /folder name -r rwcemf trustee user.context.tree

The POA needs access to the post office folder. The MTA and the GWIA need access to the
domain folder.

Stop and then start the agents.

While starting as root, the agents automatically change the ownership of the domain and post
office folder structures from root to the user you specified in the uid. conf file. Then they switch
users and run as the user you specified, rather than as root.

IMPORTANT: The first time you start an agent as a non-root user (or if you change from one
non-root user to another), the agent might take longer than usual to start, because of the
change in ownership of the directories and files accessed by that agent. This is especially true of
a POA that services a large post office and that requires access to a restore area, especially a
restore area on a remote server.

(Optional) List the agent processes to see that they are no longer running as root.
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ps -eaf | grep gw
11 Repeat Step 3 through Step 10 on each domain and post office server.

Later on, if you want to change the user that the agents are running as, follow the instructions in
“Changing the Non-root User” on page 95.

Changing the Non-root User

To prevent an agent from running as a different user than the one for which it was originally
configured, the GroupWise agents create a uid. run file in the domain or post office folder that they
service. The GWIA creates the uid. run file in its gwia directory (typically domain/wpgate/gwia).

If, for any reason, the user specified in the uid. run file does not match the user specified in the
uid.conf file, the agent displays the following message:

Error: Running the agent with conflicting effective users

This could happen if the user specified in the uid. conf file is manually edited, or if the uid. conf file
is deleted, thus changing or removing the information about the user that the agent should run as. If
this message appears, verify that the uid. conf file specifies the desired user, then delete the
uid.run file.

After displaying the message, the agent does not start, because it no longer has appropriate
permissions in the domain or post office folder that it needs to service. By deleting the uid. run file,
you enable the agent to reset the permissions in the domain or post office folder to the appropriate
user and then start successfully.

After configuring an agent to run as a specific non-root user:

+ If you want the agent to run as a different non-root user, modify the uid. conf file in the /etc/
opt/novell/groupwise/agents folder to specify the desired non-root user. Then delete the
uid.run file from the folder serviced by the agent.

+ If you want the agent to run as root again, delete the uid.conf file from the /etc/opt/novell/
groupwise/agents folder, and delete the uid. run file from the folder serviced by the agent.

Automatically Restarting the Linux GroupWise Agents with
the GroupWise High Availability Service

You can use the GroupWise High Availability Service (gwha), in conjunction with GroupWise Monitor,
to detect when a Linux GroupWise agent has stopped unexpectedly and to restart it automatically.

NOTE: On Windows, Microsoft Clustering Services can automatically restart a GroupWise agent
service that is not responding. However, on Linux, some clustering environments do not include this
capability, so it is provided by the GroupWise High Availability Service.

The GroupWise High Availability Service is installed automatically. After you enable it, it automatically
starts when your server starts.

The High Availability Service relies on the Monitor Agent to detect when a Linux GroupWise agent is
no longer running. The Monitor Agent notifies the GroupWise High Availability Service of any
problem. Then the GroupWise High Availability Service then issues the command by using the
grpwise script to start the problem agent. The GroupWise High Availability Service runs as root, as
configured in the /etc/xinetd.d/gwha file.

Working with the GroupWise Agents 95



96

A single Monitor Agent can service multiple instances of the GroupWise High Availability Service on
multiple servers, as long as all instances use the same user name and password to communicate
with the Monitor Agent.

NOTE: You can use either the Linux Monitor Agent or the Windows Monitor Agent to monitor the
Linux GroupWise agents. However, you cannot use the GroupWise High Availability Service to restart
the Windows GroupWise agents.

+ “Reconfiguring the GroupWise High Availability Service (Optional)” on page 96
+ “Enabling the GroupWise High Availability Service” on page 98
+ “Creating a GroupWise High Availability Service User” on page 99

+ “Configuring the Monitor Agent to Communicate with the GroupWise High Availability Service”
on page 99

+ “Testing the High Availability Service” on page 101

Reconfiguring the GroupWise High Availability Service (Optional)

The default configuration of the High Availability Service is often appropriate, but you can optionally
edit its configuration files to customize its functionality:

+ “Editing the gwha File to Change the Port Number (Optional)” on page 96

+ “Editing the gwha.conf File to Enable SSL and Customize Agent Management (Optional)” on
page 97

Editing the gwha File to Change the Port Number (Optional)

The basic configuration for the GroupWise High Availability Service is contained in the /etc/
xinetd.d/gwha file:

socket type = stream

user = root

server = /opt/novell/groupwise/agents/bin/gwha
wait = no

instances = 1

protocol = tcp

type = UNLISTED

port = 8400

disable = yes

The only option you can change in this file is the port number. By default, the GroupWise High
Availability service listens on port 8400. If that port number is already in use on the server where you
are setting up the GroupWise High Availability service, you can change the port number in the gwha
file.

IMPORTANT: The GroupWise High Availability service must use the same port number on all servers
where you want it to restart the GroupWise agents.

1 In a terminal window, become root by entering su - and the root password.
2 Edit the gwha file in an ASCII text editor.

3 Change the port number as needed.

IMPORTANT: Do not change any other options in this file.

4 Save the file, then exit the text editor.
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5 Continue with Editing the gwha.conf File to Enable SSL and Customize Agent Management
(Optional).

or

Skip to “Enabling the GroupWise High Availability Service” on page 98.

Editing the gwha.conf File to Enable SSL and Customize Agent Management
(Optional)

The interaction between the GroupWise High Availability service and the GroupWise agents is
controlled by the following file:

/etc/opt/novell/groupwise/gwha.conf

You can reconfigure the following functionality:

+ Enable SSL between the High Availability Service and the Monitor Agent.

+ Change the length of time between when the grpwise script issues the command to start an
agent, and when the script displays a message indicating that the agent has started.

+ If you changed the port number in the /etc/xinetd.d/gwha file, make the corresponding
change in the gwha. conf file.

At the top of the gwha.conf file, in the [gwha] section, is a section for configuring SSL for
communication between the GroupWise High Availability service and the Monitor Agent. After the
[gwha] section are sections for each agent that is configured to run on the server, as shown. The
headings for the agent sections match the agent designations listed in “Starting and Stopping the
Linux Agents as Services” on page 90.

[gwha]
ssl

key

cert
password

no

[domain name]

server = /opt/novell/groupwise/agents/bin/gwmta
command = /etc/init.d/grpwise

startup = domain name.mta

delay =2

wait = 10

[post _office name.domain name]

server = /opt/novell/groupwise/agents/bin/gwpoa
command = /etc/init.d/grpwise

startup = post office name.poa

delay =2

wait = 10

[gwia.domain name]

server = /opt/novell/groupwise/agents/bin/gwia
command = /etc/init.d/grpwise

startup = gwia.cfg

delay =2

wait = 10

[gwdva]

server = /opt/novell/groupwise/agents/bin/gwdva
command = /etc/init.d/grpwise

startup = gwdva.dva

delay =2

wait = 10
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To reconfigure the GroupWise High Availability service in the gwha.conf file:

1 In a terminal window, become root by entering su - and the root password.
2 Edit the gwha.conf file in an ASCII text editor.
3 (Conditional) If you use SSL, fill in the following fields in the [gwha] section:

[gwhal

ssl = yes

key = file name.key
cert = file name.crt
password = password

4 (Conditional) If you changed the port number for the GroupWise High Availability service, as

described in “Reconfiguring the GroupWise High Availability Service (Optional)’ on page 96, add
the following line to the [gwha] section:

port = port number

Replace port number with the new port number you specified in the gwha file.

5 (Optional) If you want to control how the grpwise script manages starting and stopping the

agents, modify the delay = and wait = settings.

The delay = setting controls the length of time between when the script issues the command to
start an agent and when the script displays a message indicating that the agent has started. The
default delay time is 2 seconds. Under certain circumstances, an agent could encounter a
problem and fail to start after 2 seconds. In this case, you would receive the success message,
but the agent would not be running. You need to increase the delay = setting to accommodate
the length of time it typically takes for the agent to start successfully on your system.

The wait = setting controls the length of time between when the script issues the command to
stop an agent and when the script kills the agent if the agent has not yet stopped. The default
wait time is 10 seconds. Under certain circumstances, an agent could take longer than 10
seconds to perform a normal shutdown, and killing the agent under those circumstances would
not be appropriate. You need to increase the wait = setting to accommodate the length of time
it usually takes for the agent to shut down. A message notifies you if the script kills an agent
because its shutdown exceeds the wait = setting.

The default settings are usually appropriate, so you do not need to change them unless you
frequently encounter problems with starting or stopping an agent with the script.

6 Save the file, then exit the text editor.

7 Continue with Enabling the GroupWise High Availability Service.

Enabling the GroupWise High Availability Service

1 In YaST, click Network Services > Network Services (xinetd).

(Conditional) If necessary, select Enable to activate the list of services.

3 Scroll down to the gwha line, select it, then click Toggle Status (On or Off) to change the status to

On.

4 Click Finish.
5 Repeat Step 1 through Step 4 on all servers where you want the GroupWise High Availability

service to restart the GroupWise agents.

Continue with Creating a GroupWise High Availability Service User.
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Creating a GroupWise High Availability Service User

The GroupWise High Availability service needs a login user on each server where GroupWise agents
need to be restarted.

1 Create a new user and associated password on the local Linux server to represent the
GroupWise High Availability service.

You might name it gwhauser.

IMPORTANT: Use a local user account for use only by the GroupWise High Availability service.
Do not use a Novell Linux-enabled user. Do not use root.

2 Create the same user on each Linux server where you want the GroupWise High Availability
service to restart the GroupWise agents.

3 On each Linux server, configure the gwha.allow file for the new user:

3a Change to the following folder:

/etc/opt/novell/groupwise
3b Edit the gwha.allow file in an ASCII text editor.
3c Specify the user that you created in Step 1.
3d Save the file, then exit the text editor.

4 Continue with Configuring the Monitor Agent to Communicate with the GroupWise High
Availability Service.

Configuring the Monitor Agent to Communicate with the GroupWise
High Availability Service
After you have the GroupWise High Availability service set up and working correctly on all Linux

servers where you want it to restart the GroupWise agents, you need to configure the Monitor Agent
to communicate with it, and then test it to ensure that you can rely on it in the future.

IMPORTANT: Although you need a GroupWise High Availability service running on each Linux
server where there are GroupWise agents, you need only one Monitor Agent to monitor all agents in
your GroupWise system.

+ “Configuring the Linux Monitor Agent” on page 99
+ “Configuring the Windows Monitor Agent” on page 100

Configuring the Linux Monitor Agent

1 Install the Linux Monitor Agent.
For installation instructions, see Chapter 18, “Setting Up GroupWise Monitor,” on page 155.

2 Configure the Linux Monitor Agent with the --hauser, --hapassword, and --hapoll startup
switches.

The Monitor Agent uses the --hauser and --hapassword switches to communicate with the
GroupWise High Availability service on port 8400, as configured in the /etc/xinetd.d/gwha
file. When the Monitor Agent notices that a GroupWise agent has stopped, it notifies the
GroupWise High Availability Service. Then the GroupWise High Availability Service issues the
command to restart the problem agent.

Working with the GroupWise Agents 99


https://www.novell.com/documentation/groupwise2014/pdfdoc/gw2014_guide_admin/gw2014_guide_admin.pdf#bxbkjf2
https://www.novell.com/documentation/groupwise2014/pdfdoc/gw2014_guide_admin/gw2014_guide_admin.pdf#bxbkjd4

100

For more information, see “Using Monitor Agent Startup Switches” in the GroupWise 2014
Administration Guide.

2a In YaST, click System > /etc/sysconfig Editor.
2b Expand Network > Mail > GroupWise.
2¢ Click GROUPWISE_MA_OPTIONS.

2d In the Setting field, set the --hauser and --hapassword switches for the user that you created
in “Creating a GroupWise High Availability Service User” on page 99.

TIP: An easy way to create the string is to copy the example at the bottom of the
Description paragraph and replace username and password as needed.

2e In the Setting field, set the --hapoll switch for the number of seconds in the poll cycle on
which the Monitor Agent contacts the GroupWise High Availability Service to provide agent
status information.

2f Click OK to save the settings.
2g Click OK again to save the change.
2h Exit YaST.

3 Start the Monitor Agent.

rcgrpwise-ma start

4 Skip to “Testing the High Availability Service” on page 101.

Configuring the Windows Monitor Agent

1 Install the Windows Monitor Agent as either an application with a server console Ul on the server

or as a Windows service without Ul on the server.
For installation instructions, see Chapter 18, “Setting Up GroupWise Monitor,” on page 155.

NOTE: The Windows Monitor Agent provides a server console that is not available on Linux. For
more information, see “Comparing the Monitor Consoles” in the GroupWise 2014 Administration
Guide.

Configure the Windows Monitor Agent with the /hauser, /hapassword, and /hapoll startup
switches.

The Monitor Agent uses the --hauser and --hapassword switches to communicate with the
GroupWise High Availability service on port 8400, as configured in the /etc/xinetd.d/gwha
file. When the Monitor Agent notices that a GroupWise agent has stopped, it notifies the
GroupWise High Availability Service. Then the GroupWise High Availability Service issues the
command to restart the problem agent.

For more information, see “Using Monitor Agent Startup Switches” in the GroupWise 2014
Administration Guide.

3 (Conditional) If you installed the Windows Monitor Agent as an application:

3a Create a batch file similar to the following example:

c:\Program Files\Novell\GroupWise Server\Monitor\gwmon.exe
/hauser-gwha /hapassword-gwha /hapoll-60

3b Create a desktop icon for running the batch file.
3c To start the Monitor Agent, run the batch file.
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4 (Conditional) If you installed the Windows Monitor Agent as a Windows service:
4a In the Control Panel, click Administrator Tools > Services.
4b Right-click GroupWise Monitor, then click Properties.
4c In the Start Parameters field, specify the required Monitor Agent startup switches, then click
OK. For example:

/hauser-gwha /hapassword-gwha /hapoll-60
4d To start the Monitor Agent, right-click GroupWise Monitor, then click Start.

Testing the High Availability Service

1 Stop one of the Linux agents, as described in “Starting and Stopping the Linux Agents as
Services” on page 90.

2 Check the status of the agent you stopped to make sure it is stopped.
3 Wait for the next Monitor Agent polling cycle.

You can check and, if necessary, change the Monitor Agent polling cycle in the Monitor Agent
console. Click Preferences, then scroll down to the HTTP Settings section.

4 After the polling cycle has passed, check the status of the agent again.
The agent that you stopped should now be running again.

141.4 Using the Linux GroupWise Agent Log Files

Agent status messages and error messages are written to the agent log files (mmddagent . nnn) in
agent-specific subfolders of the following folder:

/var/log/novell/groupwise

The log file name includes the month and day when it was created, the name of the agent, and an
incrementing extension to accommodate multiple log files on the same day.

The agents also maintain a symbolic link to a file named agent . currentlog, where agent is the
name of the agent object in the Admin console. This link points to the current agent log file,
regardless of the date and incrementing extension of the actual agent log file name. This facilitates
monitoring the current agent log file using the tail command.

NOTE: The agent.currentlog symbolic link is not available for the DVA log files.

14.1.5 Uninstalling the Linux GroupWise Agents and Applications

If you move the GroupWise agents to a different server, the GroupWise agent software can be
uninstalled just like any other software on Linux. To determine what GroupWise software is currently
installed on the Linux server, use the following command:

rpm -ga | grep groupwise
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14.2

14.2.1

This lists all of the GroupWise RPM packages on the server. The POA, the MTA, the GWIA, and the
DVA are together in the same RPM. WebAccess has its own RPM. Monitor has two RPMs, one for
the agent software and one for the application software.

The following list shows all GroupWise RPMs that you might need to uninstall from a server:

POA, MTA, GWIA, and DVA: novell-groupwise-server-version-date
WebAccess Application: novell-groupwise-webaccess-version-date
Monitor Agent: novell-groupwise-gwmon-version-date
Monitor Application: novell-groupwise-monitor-version-date
Calendar Publishing Host Application: novell-groupwise-calhost-version-date
GroupWise High Availability Service: novell-groupwise-gwha-version-date
GroupWise Check: novell-groupwise-gwcheck-version-date
GroupWise Database Copy: novell-groupwise-dbcopy-version-date

Use the following command to uninstall a GroupWise RPM package:

rpm -e novell-groupwise-package

Uninstalling the RPMs does not uninstall files created after installation by the GroupWise programs.
To completely uninstall GroupWise, delete GroupWise files from the following locations:

/etc/init.d

/usr/sbin

/etc/xinetd.d
/etc/opt/novell/groupwise
/var/opt/novell/groupwise
/var/log/novell/groupwise

Windows: Managing the GroupWise Agents

Basic agent monitoring and management is most easily performed on the System Overview page in
the Admin console. For instructions, see Section 13.2, “Making the Most of the System Overview,” on
page 84. Refer to the following additional tasks as you maintain all the GroupWise agents on
Windows:

¢ Section 14.2.1, “Manually Starting and Stopping the Windows GroupWise Agents,” on page 102
+ Section 14.2.2, “Using the Windows GroupWise Agent Log Files,” on page 104
+ Section 14.2.3, “Uninstalling the Windows GroupWise Agents and Applications,” on page 105

Manually Starting and Stopping the Windows GroupWise
Agents
+ “Manually Starting and Stopping the GroupWise Agents as Services” on page 102

+ “Manually Starting the Windows Agents As Applications for Troubleshooting” on page 103

Manually Starting and Stopping the GroupWise Agents as Services

+ “By Using the Windows Services Tool” on page 103
+ “By Using the gwsc Command” on page 103
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By Using the Windows Services Tool
You can manage the GroupWise agents just as you would any other Windows services.
For example, on Windows Server 2012:

1 From the Windows desktop, click Start > Administrative Tools > Services.
2 Select the agent service, then click Start.
or
Select the agent service, then click Stop.
When the agents run without a user interface, you can monitor them by using their agent consoles.
See Section 14.3, “Monitoring the Agents from Your Web Browser,” on page 105.

By Using the gwsc Command

You can also manage the GroupWise agents by using the gwsc command, which is short for the
gwadminutil services command.

For the gwsc command, each agent is designated in terms of its object name or of the name of the
domain and post office associated with it:

POA: poa_object name or post office name
MTA: mta_object name or domain name
GWIA: gwia object name

DVA: dva_object name

Use the following set of gwsc commands to start and stop the agents as services and verify their
status:

gwsc -query Displays the status of the GroupWise agents that are
configured to run on the server.
gwsc -query name Displays the status of the specified agent.

gwsc -start Starts the GroupWise agents that are configured to
run on the server.

gwsc -start name Starts the specified agent.

gwsc -stop Stops the GroupWise agents that are configured to
run on the server.

gwsc -stop name Stops the specified agent.
gwsc -list Lists the agent services that are configured on the
server.

Manually Starting the Windows Agents As Applications for
Troubleshooting

In general, you should run the Windows agents as services without a user interface, so that they can
be managed in the Admin console.
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Occasionally, when troubleshooting a problem that occurs at agent startup, the problem can occur
before the agent console can be displayed and before error messages can be written to the agent log
file. Under such circumstances, you can start an agent with a user interface in order to view any
errors that the agent displays on the server console before the agent stops again.

IMPORTANT: When an agent is running with a user interface, it cannot be managed in the Admin
console.

To run the agents as applications, you can create desktop shortcuts for them. The desktop shortcuts
need to contain the following commands:

Syntax:

c:\Program Files\Novell\GroupWise Server\agents\gwpoa.exe

/home \post office folder
c:\Program Files\Novell\GroupWise Server\agents\gwmta.exe

/home \domain folder
c:\Program Files\Novell\GroupWise Server\agents\gwia.exe

/home /gwia folder
c:\Program Files\Novell\GroupWise Server\agents\Monitor\gwmon.exe

/home \domain folder

Example:

c:\Program Files\Novell\GroupWise Server\agents\gwpoa.exe

/home \mail\powin
c:\Program Files\Novell\GroupWise Server\agents\gwmta.exe

/home \mail\domwin
c:\Program Files\Novell\GroupWise Server\agents\gwia.exe

/home \mail\domwin\gwia
c:\Program Files\Novell\GroupWise Server\agents\Monitor\gwmon.exe

/home \mail\domwin

14.2.2 Using the Windows GroupWise Agent Log Files

Agent status messages and error messages are written to the agent log files (mmddagent . nnn) in the
following directories:

POA: post_office folder\wpcs\ofs

MTA: domain folder\mslocal

GWIA: domain folder\wpgate\gwia\000.prc

DVA: c:\ProgramData\Novell\GroupWise\gwdva
Monitor: c:\ProgramData\Novell\GroupWise Monitor

NOTE: On some versions of Windows Server, the Programbata folder is not visible by default. To
display it in File Explorer, click View, then select Hidden items.
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14.2.3

14.3

Uninstalling the Windows GroupWise Agents and

Applications

If you move the GroupWise agents to a different server, you can uninstall the agent software from the

old location to reclaim disk space.

Agents: In the Control Panel, click Programs and Features. Right-click Novell GroupWise Server, then
click Uninstall.
Monitor: Stop the Monitor Agent, then delete the ¢ : \Program Files\Novell\GroupWise

Server\Monitor folder.

Applications: Stop Tomcat, then delete the following folder:

c:\Novell

Monitoring the Agents from Your Web Browser

To monitor any GroupWise agent from your web browser, view the agent console by supplying the IP
address or DNS hostname and the port number of the agent. The following table lists the default port

numbers:
POA: http://server network address:
MTA: http://server network address:

GWIA: http://server network address:
DVA: http://server network address:
Monitor: http://server network address:

7181
7180
9850
8301
8200

For more information about the agent consoles, including instructions on protecting the agent

consoles with passwords, see the following sections in the GroupWise 2014 Administration Guide:

¢ “Using the POA Console”

+ “Using the MTA Console”

+ “Using the GWIA Console”

¢ “Using the DVA Console”

¢ “Using the Monitor Web Console”
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What’s Next

After you have created your GroupWise system, you can expand the system in the following ways:

Task

Setting up GroupWise WebAccess so that users
can access their mailboxes through a web browser
on a computer or mobile device

Setting up a GroupWise Calendar Publishing Host
so that GroupWise users can share their personal
calendars and free/busy information with Internet
users

Setting up GroupWise Monitor to monitor your
GroupWise agents

Setting up users to run the GroupWise client on
their workstations

Setting up synchronization between users’

GroupWise mailboxes and their mobile devices

Setting up instant messaging capabilities for users

Setting up team collaboration capabilities

After your GroupWise system is fully installed,

following ways:

Task

Adding multiple domains to your GroupWise
system

Adding post offices to new domains
Adding more users to post offices
Defining resources that users can schedule

Defining groups of users that GroupWise users can
select when addressing messages

Changing the GroupWise client from Online mode
to Caching mode so that users’ messages are
stored on a local drive as well as in the post office

Section in This Guide

See Chapter 16, “Setting Up GroupWise WebAccess,” on
page 111.

See Chapter 17, “Setting Up the GroupWise Calendar
Publishing Host,” on page 129.

See Chapter 18, “Setting Up GroupWise Monitor,” on
page 155.

See Chapter 19, “Installing the GroupWise Client,” on
page 175.

See Section 20.1, “Using the GroupWise Mobility Service
to Synchronize GroupWise Data to Mobile Devices,” on
page 181.

See Section 20.2, “Using Novell Messenger to Provide
Secure Instant Messaging for GroupWise Users,” on
page 181.

See Section 20.3, “Using Novell Vibe to Provide Team
Workspaces for GroupWise Users,” on page 182.

you can maintain your GroupWise system in the

Section in the GroupWise 2014 Administration Guide

See “Domains.”

See “Post Offices.”
See “Users.”
See “Resources.”

See “Groups.”

See “Client.”
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Task Section in the GroupWise 2014 Administration Guide

Setting up GroupWise Remote so that GroupWise See “Client.”
client users can access their mailboxes from a

computer that is not directly connected to your

network

Controlling the functionality of users’ GroupWise See “Client.”
client software

Setting up a library See “Libraries and Documents.”

Configuring the agents to support secure See “Post Office Agent,” “Message Transfer Agent,”
connections (SSL) “Internet Agent,” and “Document Viewer Agent.”
Configuring GroupWise to run in a clustering See the “Clustering” in the GroupWise 2014
environment Interoperability Guide.
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GroupWise Component Installation
and Setup

*

Chapter 16, “Setting Up GroupWise WebAccess,” on page 111

*

Chapter 17, “Setting Up the GroupWise Calendar Publishing Host,” on page 129

*

Chapter 18, “Setting Up GroupWise Monitor,” on page 155

*

Chapter 19, “Installing the GroupWise Client,” on page 175

*

Chapter 20, “Using Other Novell Products with GroupWise,” on page 181

GroupWise Component Installation and Setup 109



110  GroupWise 2014 Installation Guide



16.1

16.1.1

Setting Up GroupWise WebAccess

GroupWise WebAccess enables users to access GroupWise mailboxes through desktop web
browsers, through tablet devices such as Apple iPads, and through mobile devices. The following
sections provide information to help you successfully install the GroupWise WebAccess Application in
your existing GroupWise system.

+ Section 16.1, “GroupWise WebAccess Overview,” on page 111

+ Section 16.2, “GroupWise WebAccess System Requirements,” on page 114

¢ Section 16.3, “Planning GroupWise WebAccess,” on page 116

+ Section 16.4, “Installing the GroupWise WebAccess Software,” on page 118

+ Section 16.5, “Testing GroupWise WebAccess,” on page 123

+ Section 16.6, “What’s Next,” on page 126

+ Section 16.7, “GroupWise WebAccess Installation Worksheet,” on page 127

GroupWise WebAccess Overview

+ Section 16.1.1, “GroupWise WebAccess Functionality,” on page 111
+ Section 16.1.2, “GroupWise WebAccess Components,” on page 112

+ Section 16.1.3, “WebAccess Security Requirements,” on page 112

GroupWise WebAccess Functionality

When used in a desktop web browser, GroupWise WebAccess provides much of the functionality
available in the GroupWise client. On a tablet device, the most commonly used functionality is
available. WebAccess functionality on mobile devices is limited compared to WebAccess in a desktop
browser or on a tablet device.

See the following guides for WebAccess user functionality details:

+ GroupWise 2014 WebAccess User Guide
+ GroupWise 2014 WebAccess Mobile User Guide

+ WebAccess Basic Interface Quick Start

After you set up GroupWise WebAccess, see Section 16.6, “What's Next,” on page 126 for additional
information that you might want to be aware of as you configure, maintain, and expand GroupWise
WebAccess.
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16.1.2

16.1.3

GroupWise WebAccess Components

GroupWise WebAccess consists of four components: the browser-based WebAccess user interface
(desktop computer, tablet device, or mobile device), the WebAccess Application, the Post Office
Agent (POA), and the Document Viewer Agent (DVA).

WebAccess WebAccess — —J Office
Secure  pApplication Agent
Login
YR
= 3 D E—
i3 Document
Web Browser Internet Web Server —> ) Viewer
Agent

+ WebAccess User Interface: The WebAccess user interface in web browsers gives users
access to their GroupWise mailboxes anywhere an Internet connection is available.

+ WebAccess Application: The WebAccess Application, which resides on the web server,
provides the GroupWise WebAccess user interface. As users perform actions in WebAccess,
the WebAccess Application passes information between the web browser and the Post Office
Agent.

+ Post Office Agent: The POA receives user requests from the WebAccess Application,
accesses post offices and libraries to process the requests, and then passes information back to
the WebAccess Application.

+ Document Viewer Agent: The DVA isolates the conversion process for attached document
files. The DVA can simultaneously convert multiple document files into HTML format. If it
encounters a problem converting a document file, the problem does not affect conversion of
other document files, nor does it affect the functioning of the WebAccess Application. Therefore,
GroupWise WebAccess users do not experience interruptions because of document files that fail
to convert into HTML. Document files that fail in the conversion process simply cannot be viewed
in WebAccess. The DVA is typically installed along with the POA.

WebAccess Security Requirements

The WebAccess Application can be configured to support the level of security you have established
for your Internet/intranet communication.

If you are not concerned about security issues (for example, you only plan to use the WebAccess
Application on a secured intranet), you can install the WebAccess Application to any web server that
provides access for your users and meets the requirements listed in Section 16.2, “GroupWise
WebAccess System Requirements,” on page 114.

If you plan to use the WebAccess Application to provide users with access to their mailboxes from
anywhere on the Internet (rather than only within a secured intranet), and you already have a firewall
in place to provide security, you have the following options for configuring the WebAccess
Application:

+ Install the WebAccess Application inside your firewall and use a proxy service. See “WebAccess
with a Proxy Service” on page 113. This is the recommended configuration.

+ Install the WebAccess Application on a web server outside your firewall, and install the POA and
the DVA on a server inside your firewall. See “WebAccess without a Proxy Service” on page 113.
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WebAccess with a Proxy Service

If your firewall includes a proxy service, you can install the WebAccess Application to a web server
inside your firewall. The POA and the DVA are located on a post office server, which is also inside the

firewall.

In this configuration, only the firewall server with the proxy service is located outside the firewall, as

shown in the following illustration.
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Network
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If your firewall does not provide a proxy service, you need to install the WebAccess Application to a
web server that is outside the firewall. The POA and the DVA are located on a post office server,

which is inside the firewall.

In this configuration, both the web server and the firewall server are located outside the firewall, as

shown in the following illustration.
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The firewall must allow inbound IP packets to be sent from the web server to the IP address and port

of the POA (for example, 172.16.5.18:1677).

In addition, the firewall must allow outbound IP packets to be sent from the POA to the web server.
This requires all high ports (above 1023) to be open to outbound IP packets.
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16.2 GroupWise WebAccess System Requirements

Section 16.2.1, “Hardware and Operating System Requirements,” on page 114

*

*

Section 16.2.2, “Web Server Requirements,” on page 114

*

Section 16.2.3, “GroupWise Requirements,” on page 115

*

Section 16.2.4, “User Requirements,” on page 115

16.2.1 Hardware and Operating System Requirements

0 x86-64 or x86-32 processor

[ Any of the following server operating systems for the WebAccess Application:
+ Novell Open Enterprise Server (OES) 11, plus the latest Support Pack
¢ SUSE Linux Enterprise Server (SLES) 11, plus the latest Service Pack

NOTE: On Linux, the X Window System and Open Motif are required by the GUI
GroupWise agent server consoles for the Post Office Agent, the Message Transfer Agent,
and the Internet Agent.

By default, the GroupWise Linux agents run as services without user interfaces. Starting
and stopping the agents when they are running with a user interface is not supported in the
GroupWise Administration console.

+ Windows Server 2008 R2, Windows Server 2012, or Windows Server 2012 R2, plus the
latest Service Pack

(0 Adequate server memory as required by the operating system
O Adequate server disk space:

+ Approximately 525 MB (shared with the Calendar Publishing Host Application and the
Monitor Application when they are installed on the same web server; varies by platform)

16.2.2 Web Server Requirements

The web server that is supported for your operating system:

(J x86-64 or x86-32 processor

(J OES 11/SLES 11
Apache 2.2 plus:
+ Tomcat 6
+ |IBM Java 6 Runtime Environment (JRE)
+ ModProxy Module

A Linux repository should be available when you run the GroupWise Installation Wizard. Apache,
Tomcat, the JRE, and the ModProxy Module are automatically installed from the Linux repository
if they are not already present on the Linux server.

If no Linux repository is available during the GroupWise installation, you are prompted to
manually install these required components from the Linux media, and then restart the
GroupWise installation.
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(0 Windows Server 2008 R2 / Windows Server 2012 / Windows Server 2012 R2
Microsoft Internet Information Server (11S) 7 or later plus:
+ Tomcat 6
+ IBM Java 6 Runtime Environment (JRE)
+ Jakarta Connector 1.2

Tomcat 6.0.24, Oracle JRE 6 Update 26, and Jakarta Connector 1.2 are automatically
installed along with the GroupWise software if they are not already present on the Windows
server.

+ ISAPI support
16.2.3 GroupWise Requirements

J One or more Post Office Agents (POAs) configured for SOAP and secure SSL connections

(J One or more Document Viewer Agents (DVAs) configured to communicate with the POAs

16.2.4 User Requirements
+ “WebAccess User Requirements” on page 115
+ “WebAccess Mobile User Requirements” on page 115
WebAccess User Requirements

(3 Any of the following web browsers:
¢ Linux: Mozilla Firefox; Google Chrome

+ Windows: Microsoft Internet Explorer 9 or later; Mozilla Firefox; Google Chrome; Spartan

NOTE: On Windows XP, Microsoft Internet Explorer 8.0 is also supported.

+ Macintosh: The latest version of Safari for your version of Mac OS; Mozilla Firefox; Google
Chrome

(0 Any mobile device that supports Wireless Access Protocol (WAP) and has a microbrowser that
supports Hypertext Markup Language (HTML) 4.0 or later
WebAccess Mobile User Requirements
Any of the following tablet operating systems and tablets:

O Android 4.1, 5.0, or later, with Google Chrome, on any Android device
O Apple iOS 7.x, 8.x, or later, with Apple Safari
O Kindle Fire, with Amazon Silk
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(J RIM Tablet OS 2.1 or later, with Google Chrome, on the Blackberry Playbook

O Windows Mobile 8.0 or later Pro, with Microsoft Internet Explorer, on any Windows device (full
WebAccess, no template)

16.3 Planning GroupWise WebAccess

Use the “GroupWise WebAccess Installation Worksheet” on page 127 to record the information
required to install the WebAccess Application.

The topics in this section present the required information in a convenient planning sequence. The
Installation Worksheet organizes the information in the order in which you need it during installation.
+ Section 16.3.1, “Selecting the WebAccess Application Platform,” on page 116
+ Section 16.3.2, “Gathering Web Server Information,” on page 116
+ Section 16.3.3, “Determining the WebAccess Application’s Configuration,” on page 117
+ Section 16.3.4, “Connecting the WebAccess Application with Supporting Agents,” on page 117

16.3.1 Selecting the WebAccess Application Platform

The WebAccess Application can be installed to a web server on Linux or Windows. See Section 16.2,
“GroupWise WebAccess System Requirements,” on page 114 for supported web servers.

GROUPWISE WEBACCESS APPLICATION INSTALLATION WORKSHEET

Under Web Server Platform, mark whether you plan to install the WebAccess Application to a Linux or
Windows web server.

16.3.2 Gathering Web Server Information

The WebAccess Application integrates with your web server to pass mailbox information gathered by
the POA to your web browser for display in WebAccess. The location of the WebAccess Application
files that are installed depends on the web server that it is being integrated with.

The default web server paths vary by platform:

Apache Web Server on OES 11: /etc/opt/novell/httpd/conf.d
Tomcat on OES 11: /var/opt/novell/tomcat6/webapps
Apache Web Server on SLES 11: /etc/apache2/conf.d

Tomcat on SLES 11: /usr/share/tomcat6/webapps
Microsoft Internet Information Server (1IS) on Windows: c:\inetpub\wwwroot

Tomcat on Windows: c:\novell\tomcaté\webapps
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GROUPWISE WEBACCESS APPLICATION INSTALLATION WORKSHEET

Under Web Server Information, select the type of web server where you plan to install the WebAccess
Application. Also specify the web server’s root directory.

On Windows, if the Internet Information Server services more than one website, specify the website where you
want to install the WebAccess Application.

16.3.3 Determining the WebAccess Application’s Configuration

WebAccess Application configuration information is stored in a configuration file (webacc.cfg). The
webacc. cfg file is located in the following folders:

Linux: /var/opt/novell/groupwise/webaccess
Windows: c:\novell\groupwise\webaccess

To change the WebAccess Application’s configuration, you must manually modify the webacc.cfg
file.

GROUPWISE WEBACCESS APPLICATION INSTALLATION WORKSHEET

Under Configuration File Location, note the location of the webacc . cfg file for the platform where you are
installing WebAccess.

16.3.4 Connecting the WebAccess Application with Supporting
Agents

The WebAccess Agent needs to communicate with a POA and a DVA.

GROUPWISE WEBACCESS APPLICATION INSTALLATION WORKSHEET

Under POA Network Address, specify the IP address or DNS hostname of a POA that the WebAccess
Application can communicate with, along with that POA’s SOAP port. The default SOAP port for the POA is
7191.

Under DVA Network Address, specify the IP address or DNS hostname of a DVA that the WebAccess
Application can communicate with, along with that DVA’s TCP port. The default DVA port is 8301.

IMPORTANT: The POA that the WebAccess Application communicates with must be configured for
SOAP. A secure SSL connection between the POA and the WebAccess Application is highly
recommended.

For instructions on preparing the POA to work successfully with the WebAccess Application, see the
following sections in the GroupWise 2014 Administration Guide:

+ “Supporting SOAP Clients”
+ “Securing the Post Office with SSL Connections to the POA”
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For instructions on preparing the DVA to work successfully with the WebAccess Application, see the
following sections in the GroupWise 2014 Administration Guide:

+ “Multiple DVAs for WebAccess”

¢ “Installing the DVA”

16.4 Installing the GroupWise WebAccess Software

As you install the WebAccess software, use the GroupWise WebAccess Installation Worksheet that
you filled out in Section 16.3, “Planning GroupWise WebAccess,” on page 116 to provide the required
information.

+ Section 16.4.1, “Linux: Installing the GroupWise Preparing the Linux Server for GroupWise WebAccess
WebAccess Software,” on page 118 Installing the Linux WebAccess Software

If you are new to Linux, you might want to review
“Linux Basics for GroupWise Administration” in the
GroupWise 2014 Administration Guide

+ Section 16.4.2, “Windows: Installing the Preparing the Windows Server for GroupWise
GroupWise WebAccess Software,” on page 120 WebAccess
Installing the Windows WebAccess Software

16.4.1 Linux: Installing the GroupWise WebAccess Software

+ “Preparing the Linux Server for GroupWise WebAccess” on page 118

+ “Installing the Linux WebAccess Software” on page 118

Preparing the Linux Server for GroupWise WebAccess

1 Ensure that the web server where you are installing the WebAccess Application meets the
system requirements listed in Section 16.2, “GroupWise WebAccess System Requirements,” on
page 114.

2 Ensure that the Linux operating system media is available, either physically or in a repository, in
case the Installation Wizard needs to install supporting packages on the Linux server.

3 Ensure that the server has a static IP address.

4 Ensure that the POA that the WebAccess Application will communicate with has SOAP enabled
on a secure SSL connection, as described in Section 16.3.4, “Connecting the WebAccess
Application with Supporting Agents,” on page 117.

5 Continue with Installing the Linux WebAccess Software.

Installing the Linux WebAccess Software

1 In a terminal window, become root by entering su - and the root password.

2 Start the GroupWise Installation Wizard at the root of the downloaded GroupWise 2014 software
image:

./install.sh
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3 Type the number for the language in which you want to run the GroupWise Installation Wizard,
then press Enter to select OK.

1
Please select an option: |
[ [
| 1 |
| 2 Installation |
- [
: 1

< 0K < Exit = |

|

4 (Optional) Type 1 for Documentation, then press Enter to review the Readme, Quick Start, and
Installation Guide to better prepare yourself for the installation.

5 Type 2 for Installation, then press Enter.

6 Type a to accept the License Agreement and display the Software list.

Please select an option:

(1

|2 Groupwise WebAccess

|3 GroupwWise Calendar Publishing Host
|4 GroupWise Monitor Agent

|5 Groupwise Monitor Application

e < Back > < Exit >

7 Type 2 for GroupWise WebAccess, then press Enter to display the Actions list.

1
Please select an option: |
[ [
| | [
| 2 configure |
t [
.I
[
]

E! < Back =

8 Type 1 for Install, then press Enter to install GroupWise WebAccess.

The WebAccess package is installed on the server. If any supporting packages are not available
on the server, the Installation Wizard automatically installs them from the operating system
media.

9 When the installation is finished, press any key to return to the Installation Options list.
10 Type 2 for Configure, then press Enter to configure the WebAccess Application.

11 Follow the prompts to configure the WebAccess Application, using the following information from
the GroupWise WebAccess Installation Worksheet:

POA Network Address
DVA Network Address
Web Server Information

12 Press any key to exit WebAccess Configuration.
13 Exit the GroupWise Installation Wizard.

14 Verify the status of the DVA that you configured the WebAccess Application to communicate
with.
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For instructions, see Chapter 14, “Working with the GroupWise Agents,” on page 89. For more
information about the DVA, see “Document Viewer Agent” in the GroupWise 2014 Administration
Guide.

15 Skip to Section 16.5, “Testing GroupWise WebAccess,” on page 123.

16.4.2 Windows: Installing the GroupWise WebAccess Software

+ “Preparing the Windows Server for GroupWise WebAccess” on page 120
+ ‘“Installing the Windows WebAccess Software” on page 120

Preparing the Windows Server for GroupWise WebAccess

1 Ensure that the web server where you are installing the WebAccess Application meets the
system requirements listed in Section 16.2, “GroupWise WebAccess System Requirements,” on
page 114.

2 Ensure that the server has a static IP address.

3 Ensure that the POA that the WebAccess Application will communicate with has SOAP enabled
on a secure SSL connection, as described in Section 16.3.4, “Connecting the WebAccess
Application with Supporting Agents,” on page 117.

4 Continue with Installing the Windows WebAccess Software.

Installing the Windows WebAccess Software

1 Run setup.exe at the root of the downloaded GroupWise 2014 software image to start the
GroupWise Installation Wizard.

e Novell GroupWise .
Novell. GroupWise. 2014 e
Documentation

Readme

Quick Start

Installation Guide

Full Documentation
Installation

GroupWise Server

GroupWise Client

GroupWise WebAccess

GroupWise Calendar Publishing Host
GroupWise Monitor

GroupWise Free/Busy Service
GroupWise MMC Plugin

2 (Optional) Review the Readme, Quick Start, and Installation Guide to better prepare yourself for
the installation.
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3 Click GroupWise WebAccess.

i) GroupWise WebAccess

Welcome to the Novell GroupWise WebAccess
Installation Program

e The InstallShield{R) Wizard will install Movell GroupWise
WebAccess on your computer. To continue, dlick Next,

Novell

GroupWise

2014

WARNING: This program is protected by copyright law and
international treaties,

< Back Next > | | Cancel

4 Click Next to display the Web Server Information page.

i) GroupWise WebAccess

Web Server Information

The WebAccess Application must be installed to Microsoft Internet Information
Server (II5).

O

[ Web Browser

Web Server
WebAccess

Application

|
E B

DVA POA

Select the destination Web site,

Default Web Site (C:Yjnetpubiwwwroot)

Installshield

T T

The Installation Wizard provides diagrams that help you understand how the various
components interact with each other. Review the diagrams as you provide the requested

information.

the GroupWise WebAccess Installation Worksheet:

Web Server Information
POA Network Address
DVA Network Address
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6 Click Next to display the Installation Summary.

5 GroupWise WebAccess -
Installation Summary
If you want to review or change any settings, dick Badk. Click Install to begin
copying files.
] Web Browser Installation summary:
] Group\Wise WebAccess Application ~
GroupWise 2014 -version: 14.0.0 =
® Web Server
% WebAccess LRL to log in to Groupiise WebAcress: http:[/137.65.67.1
Applicaion Web server
FPlatform: Microsoft Internet Information Server (I15)
WebSite: Default Web Site
Root directory: C:linetpublwwwroot
Default Language is: English
% % The following language(s) will be installed: ”
L=} = Brazilian Portinusse
< m bl
DVA POA
Instalishield
Installation Guide < Back H Install | | Cancel

7 Review the Installation Summary page, then click Install to install the WebAccess Application.

8 (Conditional) If prompts appear because your web server is running, decide whether you want
the Installation Wizard to stop your web server.

9 When the installation is complete, click Finish to exit the WebAccess Installation Wizard.

i) GroupWise WebAccess .

WebAccess Installation Complete

e The WebAccess Installation program has successfully installed

Movell GroupWise WebAccess. Click Finish.
Novell

GroupWise o
2014 Launch installation summary

Restart Web server

You can choose to have the Installation Wizard restart the web server for you.

Along with the WebAccess Application, the WebAccess Installation Wizard also installs Tomcat 6
to c:\novell\tomcats, integrates it with your web server, and automatically starts it to support
the WebAccess Application.

10 Exit the GroupWise Installation Wizard.

11 Verify the status of the DVA that you configured the WebAccess Application to communicate
with.

For instructions, see Chapter 14, “Working with the GroupWise Agents,” on page 89. For more
information about the DVA, see “Document Viewer Agent” in the GroupWise 2014 Administration
Guide.

12 Continue with Testing GroupWise WebAccess.
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16.5 Testing GroupWise WebAccess

After you have installed WebAccess, you should test it in the environments where you think that your
GroupWise users will typically use it.

+ Section 16.5.1, “Testing WebAccess on a Workstation,” on page 123

*

Section 16.5.2, “Testing WebAccess on a Tablet Device,” on page 124

*

Section 16.5.3, “Testing the WebAccess Basic Interface on a Mobile Device,” on page 125

*

Section 16.5.4, “Assisting Users with Login Problems,” on page 126

*

Section 16.5.5, “Monitoring the WebAccess Application,” on page 126

16.5.1 Testing WebAccess on a Workstation

1 To access GroupWise WebAccess, use the following URL:

http://web_server address/gw/webacc

Replace web_server_address with the IP address or DNS hosthame of your web server. If the
web server uses SSL, use https rather than http.

[~

Novell.
GroupWise

Usemame

2 Type your GroupWise user name in the User Name field and your GroupWise mailbox password
in the Password field.

3 (Optional) Click Settings, then select the interface language you want from the Language drop-
down list.
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4 Click Login to display the GroupWise WebAccess main window.

Novell. GroupWise Mailbox Galendar Gontacts Documents Logout %,
= Mail - @ Appointment Eﬂ Task |2| Reminder Note % Froxy rﬁ Folders 19 Find
2% N
7l Tabitha Hu (e T Delete [ Accept [ Decline [ Gomplete g Mark Unread g Mark Read = Gategories
(—]
Name Subject Date = Size
Unopened ltems —
& senttems =
Marie Bamard Gonference number 8/23/11 2:21 PM 2 KB
b [ Galendar
Marie Bamard Please forward along to your teams 8/12/11 2:00 PM 2 KB
b & Frequent Gontacts
Marie Barnard Fwd: Meetin 8/8/11 1139 AM 2 KB
Vi Taskiist £ g

EI/1 Work In Progress
H cabinet
M Trasn

5 Click Options EX¥ > Help for more information about using GroupWise WebAccess.

16.5.2 Testing WebAccess on a Tablet Device

1 To access GroupWise WebAccess on a tablet device such as an iPad, use the following URL:

http://web_server address/gw/webacc

Replace web_server_address with the IP address or DNS hostname of your web server. If the
web server uses SSL, use https rather than http.

Novell.
GroupWise

Settings »

or

(Conditional) If you have a tablet device that is not yet supported, but you want to see how well
the mobile interface works on your device, use the following URL:

http://web_server address/gw/webacc?User.interface=mobile

Replace web_server_address with the IP address or DNS hostname of your web server. If the
web server uses SSL, use https rather than http.

2 Type your GroupWise user name in the User Name field and your GroupWise mailbox password
in the Password field.
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3 (Optional) Tap Settings, then select the interface language you want from the Language drop-
down list.

4 Tap Login to display the GroupWise WebAccess main window.

2:38 PM
Novell GroupWise (Marie Barnard)
« @B M [P | 137.65.67.217/gwiwebacc
Novell. GroupWise. ?
Mailbox C i, | « 5 @ v

George Smith 51111 Mail
[ Training Slides

Campaign Strategy for Product X

Mike Palu anam -Show Details-
[¥1 Expense report-Delegated
’ Marie,
Mike Palu 9/13/11
- TSI (D T I Please let me know ASAP what ideas you have for this campaign.
Marie, Please let me know ASAP what idea...
Mike Palu orian1|  -Mike

= Briefing Notes

Mike Palu 913
(L Market Analysis Review

Marie Barnard 8/25/11
4 Julio Chavez 8015557867

Marie Barnard 8/15/11
& George's Birthday

Mike Palu 81111

5 Tap Options %% > Help for more information about using GroupWise WebAccess on your iPad.

16.5.3 Testing the WebAccess Basic Interface on a Mobile Device

1 To access GroupWise WebAccess in the web browser on your mobile device, use the following
URL:

http://web_server address/gw/webacc

Replace web_server_address with the IP address or DNS hosthame of your web server. If the
web server uses SSL, use https rather than http.

2 Follow the instructions in your mobile device’s documentation to add this URL to your Favorites
or Bookmarks so you do not need to type the URL every time you log in on your mobile device.

3 Type your GroupWise user name in the User Name field and your GroupWise mailbox password
in the Password field.
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4 Tap Login to display the GroupWise WebAccess main window.

The appearance of the WebAccess basic interface varies depending on the size of the screen
where it is displayed.

Novell GroupWise

= Mailbox |+ Compose
Folders (EJAddress Book

[Fcalendar || Documents
J4-Eind i Options
2 Exit

About Novell GroupWise

For more information about using WebAccess on your mobile device, see the WebAccess Basic
Interface Quick Start (https://www.novell.com/documentation/groupwise2014/
gw2014_qgs_webaccbasic/data/gw2014 _qs_webaccbasic.html).

As an alternative to this limited interface, you can synchronize GroupWise data to your mobile device
using the GroupWise Mobility Service. For more information, see the GroupWise Mobility Service
website (http://www.novell.com/documentation/groupwisemobility2).

16.5.4 Assisting Users with Login Problems

The WebAccess Login page includes a Can't log in link, which provides the following information to
WebAccess users by default:

If you have forgotten your GroupWise password, contact your local GroupWise
administrator.

For your convenience and for the convenience of your WebAccess users, you can customize the
information that is provided by the Can’t log in link. For setup instructions, see “Helping Users Who
Forget Their GroupWise Passwords” in the GroupWise 2014 Administration Guide.

16.5.5 Monitoring the WebAccess Application

You can monitor the WebAccess Application from your web browser. For more information, see
“Using the WebAccess Application Console” in the GroupWise 2014 Administration Guide.

16.6 What’s Next

You can further configure and maintain GroupWise WebAccess in the following ways:

Task Section in the GroupWise 2014 Administration Guide

Scale GroupWise WebAccess to meet the needs of See “Scaling Your GroupWise WebAccess Installation.”
your users and environment

Control users’ access to GroupWise WebAccess  See “Managing User Access” and “Helping Users Who
Forget Their GroupWise Passwords.”

Configure the WebAccess Application See “Configuring the WebAccess Application.”
Monitor the WebAccess Application See “Monitoring the WebAccess Application.”

Control logging for the WebAccess Application See “Using WebAccess Application Log Files.”
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16.7

GroupWise WebAccess Installation Worksheet

Installation Wizard Field

Value for Your GroupWise
System

Explanation

Web Server Platform

* Linux

+ Windows

Section 16.3.1, “Selecting the

WebAccess Application Platform,”

on page 116

POA Network Address

+ |P address
+ SOAP port
(default 7191)

Section 16.3.4, “Connecting the
WebAccess Application with
Supporting Agents,” on page 117

DVA Network Address

+ |P address
¢ TCP port
(default 8301)

Section 16.3.4, “Connecting the
WebAccess Application with
Supporting Agents,” on page 117

Web Server Information

OES 11

* Apache path

/etc/opt/novell/httpd/

conf.d
+ Tomcat path

/var/opt/novell/
tomcat6/webapps

Section 16.3.2, “Gathering Web
Server Information,” on page 116

Web Server Information

SLES 11
+ Apache path

/etc/apache2/conf.d
¢ Tomcat path

/usr/share/tomcat6/
webapps

Section 16.3.2, “Gathering Web
Server Information,” on page 116

Web Server Information

Windows

+ Microsoft Internet Information

Server (IIS) for Windows

+ Path to the web server’s root

directory
* Website

Section 16.3.2, “Gathering Web
Server Information,” on page 116
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Installation Wizard Field Value for Your GroupWise Explanation

System
Configuration File Location Section 16.3.2, “Gathering Web
Server Information,” on page 116
Linux
/var/opt/novell/

groupwise/webaccess

Windows

c:\novell\groupwise\
webaccess
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17.1

1711

Setting Up the GroupWise Calendar
Publishing Host

The GroupWise Calendar Publishing (CalPub) Host publishes GroupWise users’ calendars to the
Internet, so that the calendars are readily available to colleagues who are not part of the GroupWise
system. The CalPub Host also returns free/busy schedule status to Internet colleagues who want to
set up appointments with GroupWise users. The free/busy search checks the main GroupWise
Calendar and personal calendars.

*

*

*

*

Section 17.1, “GroupWise Calendar Publishing Host Overview,” on page 129

Section 17.2, “GroupWise Calendar Publishing Host System Requirements,” on page 132
Section 17.3, “Planning a GroupWise Calendar Publishing Host,” on page 133

Section 17.4, “Installing the GroupWise Calendar Publishing Host,” on page 138

Section 17.5, “Configuring GroupWise to Support the Calendar Publishing Host,” on page 144
Section 17.6, “Testing GroupWise Calendar Publishing,” on page 148

Section 17.7, “What’s Next,” on page 150

Section 17.8, “GroupWise Calendar Publishing Host Worksheets,” on page 151

GroupWise Calendar Publishing Host Overview

*

*

*

Section 17.1.1, “GroupWise Calendar Publishing Host Functionality,” on page 129
Section 17.1.2, “GroupWise Calendar Publishing Host Components,” on page 130
Section 17.1.3, “GroupWise Calendar Publishing Host Security Requirements,” on page 130

GroupWise Calendar Publishing Host Functionality

The CalPub Host enables Internet users to view GroupWise users’ published calendars and to
retrieve free/busy information from their calendars to assist with scheduling available appointment
times. Internet users do not need login access to the GroupWise system in order to view published
calendars and obtain free/busy status. Information provided by the CalPub Host is publicly available
to Internet users everywhere.

For calendar publishing user functionality details, see the Calendar Publishing User Quick Start
(https://www.novell.com/documentation/groupwise2014/gw2014 _gs_calpubuser/data/
gw2014_qgs_calpubuser.html).
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17.1.2

171.3

GroupWise Calendar Publishing Host Components

The CalPub Host includes three components: the CalPub Host Application, which connects to the
Internet through a web server, the Post Office Agent (POA), which connects to your GroupWise
system, and the GroupWise Administration Service, which provides authentication to the CalPub
Host Administration console.

Published Calendar

Calendar PUHEQ”Q _J on?iscte
No Application Agent
Login

EEE
Web Browser Internet Web Server L> GroupWise

Admin Service

+ Calendar Publishing Host Application: The CalPub Host Application, which resides on the
web server, provides the browser interface for users across the Internet. As users request
calendar and free/busy information from GroupWise users, the CalPub Host Application passes
the information between the web browser and the POA.

+ Post Office Agent: The POA receives user requests from the CalPub Host Application,
accesses post offices and mailboxes to process the requests, and then passes information back
to the CalPub Host Application in the form of ICS (Internet Calendaring and Scheduling) files and
IFB (Internet Free Busy) files. These files can be imported into GroupWise, Outlook, and
Macintosh iCal calendaring applications.

+ GroupWise Admin Service: The CalPub Host has an Administration console for configuration
and management tasks. You can authenticate to the CalPub Host Admin console by using the
user name and password of any GroupWise administrator user.

GroupWise Calendar Publishing Host Security
Requirements

The CalPub Host Application can be configured to support the level of security you have established
for your Internet/intranet communication.

If you are not concerned about security issues (for example, you only plan to use the CalPub Host
Application on a secured intranet), you can install the CalPub Host Application to any web server that
provides access for your users and meets the requirements listed in Section 17.2, “GroupWise
Calendar Publishing Host System Requirements,” on page 132.

If you plan to use the CalPub Host Application to provide calendar and free/busy information to users
anywhere on the Internet (rather than simply within a secured intranet), and you already have a
firewall in place to provide security, you have the following options for configuring the CalPub Host
Application:

+ Install the CalPub Host Application inside your firewall and use a proxy service, as described in
“Calendar Publishing Host with a Proxy Service” on page 131. This is the recommended
configuration.

+ |Install the CalPub Host Application on a web server outside your firewall and have it
communicate with a POA through your firewall, as described in “Calendar Publishing Host
without a Proxy Service” on page 131.
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Calendar Publishing Host with a Proxy Service

If your firewall includes a proxy service, you can install the CalPub Host Application to a web server
inside your firewall. The POA is located on a post office server, which is also located inside the
firewall.

In this configuration, only the firewall server with the proxy service is located outside the firewall, as
shown in the following illustration.

Published
Calendar
= - Ez
Web Web Web

Browser Browser Browser

t I Calendar b
Publishing ost
1 [ Firewall Host _J Office
No Application Agent
Login
——— — D
Internet Firewall Server Web GroupWise

with Proxy Server Admin Service
Service

Calendar Publishing Host without a Proxy Service

If your firewall does not provide a proxy service, you need to install the CalPub Host Application to a
web server that is outside the firewall. The POA is located on a post office server, which is located the
firewall.

In this configuration, both the web server and the firewall server are located outside the firewall, as
shown in the following illustration.

Published

Calendar
| ] ]
EEH FEH i
Web Web Web

Browser Browser Browser

[ Calendar

Publishing Post

1 [ Host Firewall 4]  Office

No  Application Agent
Login ! !

Internet Web Firewall L GroupWise

Server Server Admin Service

The firewall must allow inbound IP packets to be sent from the web server to the POA’s internal or
external IP address and the calendar publishing port for the POA (for example, 172.16.5.18:7171). If
you are using an external IP address, all POAs that support calendar publishing must be configured
to use the same external IP address. For more information about external POA IP addresses, see
“Securing Client Access through an External Proxy Server” in the GroupWise 2014 Administration
Guide.
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In addition, the firewall must allow outbound IP packets to be sent from the POA to the web server.
This requires all high ports (above 1023) to be open to outbound IP packets.

17.2 GroupWise Calendar Publishing Host System
Requirements

¢ Section 17.2.1, “Hardware and Operating System Requirements,” on page 132
+ Section 17.2.2, “Web Server Requirements,” on page 132

+ Section 17.2.3, “Web Browser Requirements,” on page 133

17.21 Hardware and Operating System Requirements

J x86-64 or x86-32 processor
(J Any of the following server operating systems for the Calendar Publishing Host Application:

+ Novell Open Enterprise Server (OES) 11, plus the latest Support Pack
¢ SUSE Linux Enterprise Server (SLES) 11, plus the latest Service Pack

NOTE: On Linux, the X Window System and Open Motif are required by the GUI
GroupWise agent server consoles for the Post Office Agent, the Message Transfer Agent,
and the Internet Agent.

By default, the GroupWise Linux agents run as services without user interfaces. Starting
and stopping the agents when they are running with a user interface is not supported in the
GroupWise Administration console.

+ Windows Server 2008 R2, Windows Server 2012, or Windows Server 2012 R2, plus the
latest Service Pack

(0 Adequate server memory as required by the operating system
(J Adequate server disk space:

+ Approximately 525 MB (shared with the WebAccess Application and the Monitor Application
when they are installed on the same web server; varies by platform)

+ 50 KB per published calendar
+ 50 KB per user for free/busy searching

17.2.2 Web Server Requirements
The web server that is supported for your operating system:

(J x86-64 or x86-32 processor
(J OES 11/SLES 11
Apache 2.2 plus:
¢ Tomcat 6
+ |BM Java 6 Runtime Environment (JRE)
+ ModProxy Module
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17.2.3

17.3

A Linux repository should be available when you run the GroupWise Installation Wizard. Apache,
Tomcat, the JRE, and the ModProxy Module are automatically installed from the Linux repository
if they are not already present on the Linux server.

If no Linux repository is available during the GroupWise installation, you are prompted to
manually install these required components from the Linux media, and then restart the
GroupWise installation.

0 windows Server 2008 R2 / Windows Server 2012 / Windows Server 2012 R2
Microsoft Internet Information Server (1I1S) 7 or later plus:
¢ Tomcat 6
+ |BM Java 6 Runtime Environment (JRE)
+ Jakarta Connector 1.2

Tomcat 6.0.24, Oracle JRE 6 Update 26, and Jakarta Connector 1.2 are automatically
installed along with the GroupWise software if they are not already present on the Windows
server.

+ |ISAPI support

Web Browser Requirements

Any of the following web browsers for the GroupWise Calendar Publishing Host user web pages and
the Calendar Publishing Host Administration console:

O Linux: Mozilla Firefox; Google Chrome

O Windows: Microsoft Internet Explorer 9 or later; Mozilla Firefox; Google Chrome; Spartan

NOTE: On Windows XP, Microsoft Internet Explorer 8.0 is also supported.

(J Macintosh: The latest version of Safari for your version of Mac OS; Mozilla Firefox; Google
Chrome

Planning a GroupWise Calendar Publishing Host

Use the “GroupWise Calendar Publishing Host Worksheets” on page 151 to record the information
required to install and configure the CalPub Host Application.

The topics in this section present the required information in a convenient planning sequence. The
Installation Worksheet organizes the information in the order in which you need it during installation.

¢ Section 17.3.1, “Selecting the Calendar Publishing Host Application Platform,” on page 134

+ Section 17.3.2, “Gathering Web Server Information,” on page 134

¢ Section 17.3.3, “Choosing the Calendar Publishing Host Name,” on page 135

¢ Section 17.3.4, “Determining the URL of the Calendar Publishing Host,” on page 135

+ Section 17.3.5, “Selecting a Calendar Publishing Host Administrator,” on page 136

+ Section 17.3.6, “Connecting the Calendar Publishing Host to a POA,” on page 136

¢ Section 17.3.7, “Designing Your Calendar Browse List,” on page 136

+ Section 17.3.8, “Selecting Calendar Publishing Settings,” on page 137
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17.3.1

17.3.2

Selecting the Calendar Publishing Host Application
Platform

The CalPub Host can be installed to a web server on Linux or Windows. See Section 17.2,

“GroupWise Calendar Publishing Host System Requirements,” on page 132 for supported web
servers.

GROUPWISE CALENDAR PUBLISHING HOST INSTALLATION WORKSHEET

Under Web Server Platform, mark whether you plan to install the CalPub Host Application to a Linux or
Windows web server.

Gathering Web Server Information

The CalPub Host Application integrates with your web server to pass calendar information gathered
by the Post Office Agent to your web browser for display. The location of the CalPub Application files
that are installed depends on the web server that it is being integrated with.

The default web server paths vary by platform:

Apache Web Server on OES 11: /etc/opt/novell/httpd/conf.d
Tomcat on OES 11: /var/opt/novell/tomcaté6/webapps
Apache Web Server on SLES 11: /etc/apache2/conf.d

Tomcat on SLES 11: /usr/share/tomcaté/webapps
Microsoft Internet Information Server (IIS) on Windows: ¢:\inetpub\wwwroot

Tomcat on Windows: c:\novell\tomcat6\webapps

GROUPWISE CALENDAR PUBLISHING HOST INSTALLATION WORKSHEET

Under Web Server Information, select the type of web server where you plan to install the CalPub Host
Application. Also specify the web server’s root directory.

On Windows, if the Internet Information Server services more than one website, specify the website where you
want to install the CalPub Host Application.

The CalPub Host needs the IP address and TCP port number of the web server so that they can
communicate.

GROUPWISE CALENDAR PUBLISHING HOST CONFIGURATION WORKSHEET

Under Calendar Publishing Host Configuration, list the IP address of the web server and the web server port
number (by default, 80).

134  GroupWise 2014 Installation Guide



17.3.3

17.3.4

Choosing the Calendar Publishing Host Name

You must provide a unique and descriptive name for the CalPub Host. The name might include the
platform or location of the CalPub Host, or perhaps the users it serves. You specify this name when
you install the CalPub Host Application and again when you configure it in the GroupWise Admin
console. The name must be specified identically in both places, including spacing and capitalization.

The CalPub Host name is stored in the calhost . cfg file, located in the following folders:

Linux: /var/opt/novell/groupwise/calhost
Windows: c:\novell\groupwise\calhost

GROUPWISE CALENDAR PUBLISHING HOST INSTALLATION WORKSHEET

Under Calendar Publishing Host Name, specify a unique name for this CalPub Host.

GROUPWISE CALENDAR PUBLISHING HOST CONFIGURATION WORKSHEET

Under Calendar Publishing Host Configuration, list the name for the CalPub Host name again. Ensure that the
names are specified identically on both worksheets.

If desired, provide a helpful description of the CalPub Host.

Determining the URL of the Calendar Publishing Host

The CalPub Host uses the DNS hostname of the web server as part of its base URL.

http://web_server address:port/gwcal

Replace web server address with the DNS hostname of the web server. Replace port with the port
number on which the CalPub Host communicates with the web server. The default port number is 80;
it does not need to be specified if your web server uses that default.

IMPORTANT: Select the URL carefully. This URL is disseminated by GroupWise users to their
Internet colleagues when they publish their personal calendars and free/busy information. If you
change the URL later, GroupWise users need to send updated information to Internet colleagues.

You might want to create a generic URL, such as http://gwcal.example.com/gwcal, and then
configure your network to redirect incoming traffic to the CalPub Host server.

GROUPWISE CALENDAR PUBLISHING HOST CONFIGURATION WORKSHEET

Under Calendar Publishing Host Configuration, list the CalPub Host base URL (http://
web_server address/gwcal).

You typically need only one CalPub Host in your GroupWise system. However, depending on the size
of your GroupWise system and the locations of your GroupWise users, you might need multiple
CalPub Hosts in various locations if some users experience slowness when accessing the initial
location.
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17.3.5

17.3.6

17.3.7

Selecting a Calendar Publishing Host Administrator

The web-based CalPub Admin console is provided for additional configuration of the CalPub Host.
You must select at least one GroupWise user to access the Calpub Admin console. You might want to
select a GroupWise user who is already a GroupWise system administrator, domain administrator, or
post office administrator, but this is not required. Any GroupWise user can be a CalPub Host
administrator.

The CalPub administrator logs into the CalPub Admin console using the same user name and
password that is used for mailbox access.

GROUPWISE CALENDAR PUBLISHING HOST CONFIGURATION WORKSHEET

Under Authentication Information, list at least one GroupWise user to serve as a CalPub Host administrator.

Connecting the Calendar Publishing Host to a POA

The CalPub Host connects to your GroupWise system through the POA of a post office. For initial
installation, you enable one POA for calendar publishing. As you roll out calendar publishing to your
GroupWise users, you must enable calendar publishing for the POA of every post office where users
publish calendars and free/busy information.

The initially selected POA must be configured to communicate with the CalPub Host. The POA
server's IP address or DNS hostname is required, along with a calendar publishing port. The default
calendar publishing port is 7171.

Use the default port number unless it is already in use on the server.

GROUPWISE CALENDAR PUBLISHING HOST INSTALLATION WORKSHEET

Under Post Office Agent Information, specify the IP address or DNS hostname of the POA that will
communicate with the CalPub Host, along with the calendar publishing port number. The default calendar
publishing port is 7171.

GROUPWISE CALENDAR PUBLISHING HOST CONFIGURATION WORKSHEET

Under Calendar Publishing Post Office, transfer the IP address or DNS hostname of the POA, along with the
calendar publishing port from the Installation Worksheet to the Configuration Worksheet. You need this
information during installation and during configuration.

For a complete list of default port numbers used by the GroupWise agents, see “GroupWise Port
Numbers” in the GroupWise 2014 Administration Guide.

Designing Your Calendar Browse List

The CalPub Host collects a list of published calendars for Internet users to browse and select from at
the following URL.:

http://web server address/gwcal/calendar
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However, by default, no calendars are displayed in this calendar browse list. You can handle the
calendar browse list in three different ways:

+ Do not provide a calendar browse list.
Users need to notify Internet colleagues by email of the URL to access their published
calendars.

+ Use the calendar browse list only for calendars of general corporate interest.

If you want to have such a corporate browse list, you restrict which users can list calendars on
the browse list, by allowing only a few specific users who manage the corporate calendars to
publish to the calendar browse list.

+ Allow most, if not all, users to publish their personal calendars on the calendar browse list.

This open approach to the calendar browse list makes users’ published calendars easily
accessible to anyone who knows the URL of the calendar browse list for your GroupWise
system.

GROUPWISE CALENDAR PUBLISHING HOST CONFIGURATION WORKSHEET

Under Calendar Browse List, mark whether you want to enable the calendar browse list, and if so, what
kind (corporate or open).

17.3.8 Selecting Calendar Publishing Settings

After you have set up the CalPub Host, you can configure how you want it to work for your
GroupWise users. The following settings are available in the CalPub Admin console:

+ Enable Calendar Publishing: Lets users publish personal GroupWise calendars on the
Internet. When calendar publishing is enabled, users of the GroupWise client and GroupWise
WebAccess can right-click a personal calendar, and then click Publish to select options for
publishing a personal calendar.

+ Enable Rules To Move Items to a Published Calendar: Allows users to create rules that
move specific items to a published GroupWise calendar. Rules are disabled by default.

+ Enable Publish Free/Busy Search: Allows users to make their appointment information
available to external users, so that external users can perform Free/Busy Searches on users'
GroupWise calendars. Free/Busy searching is disabled by default. Free/busy publishing can be
enabled even if no Calendar Publishing Host has been selected.

+ Enable Subscribe to Calendar: Allows users to subscribe to Internet calendars that are
updated on a regular basis, such as calendars for sporting events. Calendar subscription is
disabled by default. Calendar subscription can be enabled even if no Calendar Publishing Host
has been selected.

GROUPWISE CALENDAR PUBLISHING HOST CONFIGURATION WORKSHEET

Under Calendar Publishing Options, mark the options you want to enable for the CalPub Host.
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17.4 Installing the GroupWise Calendar Publishing
Host

As you set up the CalPub Host, use the GroupWise Calendar Publishing Host Worksheets that you
filled out in Section 17.3, “Planning a GroupWise Calendar Publishing Host,” on page 133 to provide
the required information.

¢ Section 17.4.1, “Linux: Installing the Calendar Preparing the Linux Server for the Calendar Publishing
Publishing Host Software,” on page 138 Host
Installing the Linux Calendar Publishing Host Software

If you are new to Linux, you might want to review
“Linux Basics for GroupWise Administration” in the
GroupWise 2014 Administration Guide before you
work with the GroupWise agents on Linux.

+ Section 17.4.2, “Windows: Installing the Calendar Preparing the Windows Server for the Calendar
Publishing Host Software,” on page 140 Publishing Host
“Installing the Windows Calendar Publishing Host
Software” on page 141

1741 Linux: Installing the Calendar Publishing Host Software

+ “Preparing the Linux Server for the Calendar Publishing Host” on page 138

+ “Installing the Linux Calendar Publishing Host Software” on page 138

Preparing the Linux Server for the Calendar Publishing Host

1 Ensure that the web server where you are installing the CalPub Host Application meets the
system requirements listed in Section 17.2, “GroupWise Calendar Publishing Host System
Requirements,” on page 132.

2 Ensure that the Linux operating system media is available, either physically or in a repository, in
case the Installation Wizard needs to install supporting packages on the Linux server.

3 Ensure that the server has a static IP address.

4 Continue with Installing the Linux Calendar Publishing Host Software.

Installing the Linux Calendar Publishing Host Software

1 In a terminal window, become root by entering su - and the root password.

2 Start the GroupWise Installation Wizard at the root of the downloaded GroupWise 2014 software
image:

./install.sh
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3 Type the number for the language in which you want to run the GroupWise Installation Wizard,
then press Enter to select OK.

1
Please select an option: |
[ [
| 1 |
| 2 Installation |
- [
: 1

< 0K < Exit = |

|

4 (Optional) Type 1 for Documentation, then press Enter to review the Readme, Quick Start, and
Installation Guide to better prepare yourself for the installation.

5 Type 2 for Installation, then press Enter.

6 Type a to accept the License Agreement and display the Software list.

Please select an option:

(1

|2 Groupwise WebAccess

|3 GroupwWise Calendar Publishing Host
|4 GroupWise Monitor Agent

|5 Groupwise Monitor Application

e < Back > < Exit >

7 Type 3 for Calendar Publishing Host, then press Enter to display the Actions list.

1
Please select an option: |
[ [
| | [
| 2 configure |
t [
.I
[
]

E! < Back =

8 Type 1 for Install, then press Enter to install the GroupWise Calendar Publishing Host.

The CalPub Host package is installed on the server. If any supporting packages are not available
on the server, the Installation Wizard automatically installs them from the operating system
media.

9 When the installation is finished, press any key to return to the Installation Options list.
10 Type 2 for Configure, then press Enter to configure the CalPub Host Application

11 Follow the prompts to configure the CalPub Host Application, using the following information
from the Calendar Publishing Host Installation Worksheet:

Calendar Publishing Host Name
Post Office Agent Information
Web Server Information
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12 When the installation is finished, review the instructions for configuring the Calendar Publishing
Host.

GroupWise Calendar Publishing Host Configuration Complete

To finish setting up the Calendar Publishing Host, complete the following
steps after you exit the Installation program:

- In the GroupWise Admin console, click System > Calendar Publishing, then
create a host with the exact name that you specified during installation:

SLES calendar Publishing Host.

- In the GroupWise Admin console, use Client Options > Calendar > Web
Calendar to enable Calendar Publishing for GroupWise clients.

- In the GroupWise Admin console, on each POA object, click Agent
Settings, then select Enabled under Calendar Publishing, so that the POAs
start looking up calendar information to display in users' published
calendars.

- Start Tomcat and Apache.

Press any key to exit the configuration.[j

13 Press any key to exit CalPub Host Configuration.
14 Exit the GroupWise Installation Wizard.

15 Skip to “Configuring the Calendar Publishing Host in the GroupWise Admin Console” on
page 144.

17.4.2 Windows: Installing the Calendar Publishing Host Software

+ “Preparing the Windows Server for the Calendar Publishing Host” on page 140

+ “Installing the Windows Calendar Publishing Host Software” on page 141

Preparing the Windows Server for the Calendar Publishing Host

1 Ensure that the web server where you are installing the CalPub Host Application meets the
system requirements listed in Section 17.2, “GroupWise Calendar Publishing Host System
Requirements,” on page 132.

2 Ensure that the server has a static IP address.
3 Continue with Installing the Windows Calendar Publishing Host Software.
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Installing the Windows Calendar Publishing Host Software

1 Run setup.exe at the root of the downloaded GroupWise 2014 software image to start the

GroupWise Installation Wizard.

Installation Guide
Full Documentation

Installation

GroupWise Server

GroupWise Client

GroupWise WebAccess

GroupWise Calendar Publishing Host
GroupWise Monitor

GroupWise Free/Busy Service
GroupWise MMC Plugin

3¢ Novell GroupWise .
Novell. GroupWise. 2014 e
Documentation

Readme
Quick Start

2 (Optional) Review the Readme, Quick Start, and Installation Guide to better prepare yourself for

the installation.
3 Click GroupWise Calendar Publishing Host.

international treaties.

i GroupWise Calendar Publishing Host

Welcome to the Novell GroupWise Calendar
Publishing Host Installation Program

e The InstallShield(R) Wizard wil install Novell GroupWise
Calendar Publishing Host on your computer. To continue, dick

Novell. ext.

GroupWise

2014

WARNING: This program is protected by copyright law and

ck Next > | | Cancel
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4 Click Next to display the Calendar Publishing Host Name page.

0

I The Calendar Publishing Host Name that you spedify in the
Installation program must be the same as the name that
E Web Server you specify in the GroupWise Admin console when you
configure the Calendar Publishing Host.

iz GroupWise Calendar Publishing Host

Calendar Publishing Host Name

The Calendar Publishing Host needs a unique name in your GroupWise system
(e.g. GW Calendar Publishing Host).

[ Web Browser

Publishing
Host Application

Calendar Publishing Host Name:

|CaIHostName1
LDAP
Server POA

InstallShield

Instaliation Guide

< Back ” Next = | | Cancel

The Installation Wizard provides diagrams that help you understand how the various

components interact with each other. Review the diagrams as you provide the requested
information.

5 Follow the prompts to configure the CalPub Host Application, using the following information
from the Calendar Publishing Host Installation Worksheet:

Calendar Publishing Host Name
Web Server Information
Post Office Agent Information

6 Click Next to display the Installation Summary.

iz GroupWise Calendar Publishing Host .
Installation Summary
If you want to review or change any settings, dick Back. Click Install to begin
copying files.
] Web Browser Installation summary:
I GroupWise Calendar Publishing Host -
M Web Server
™ be GroupWise 2014 - version: 14.0.0
Eeel Calendar
Publishing Web server =
Host Application Platform: Microsoft Internet Information Server (II5) fol
WebSite: Default Web Site
[ I Root directory: C:linetpubwwwroot
Application home directary
% % Lacation: C:\Novel\GroupWise\calhost
s Falenar Puhlishinn Host Name i
LDAP < m >
Server POA
Instalishield
Installation Guide < Back ” Instal ‘ | Cancel

7 (Conditional) If prompts appear because your web server is running, decide whether you want
the Installation Wizard to stop your web server.
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8 When the installation is finished, review the instructions for configuring the Calendar Publishing

Host.
i GroupWise Calendar Publishing Host -
Calendar Publishing Host Setup
Additional setup is required after you install the Calendar Publishing Host
Application.

To finish setting up the Calendar Publishing Host, complete the following steps after you
exit the Installation program:

& In the GroupiWise Admin console, dick System > Calendar Publishing, then create a
host with the exact name that you spedified during installation:

Windows Calendar Publishing Host

& In the Group\Wise Admin console, use Client Options > Calendar > Web Calendar to
enable Calendar Publishing for Group\Wise dients.

» In the GroupWise Admin console, on each POA object, dick Agent Settings, then
select Enabled under Calendar Publishing, so that the POAs start looking up calendar
information to display in users' published calendars.

Installshield
Installation Guide < Back Cancel

9 Click Next to continue.

10 When the installation is complete, click Finish to exit the Calendar Publishing Host Installation

Wizard.

e The Calendar Publishing Host Installation program has

successfully installed Movell GroupWise Calendar Publishing

Novell Host. Click Finish.
GroupWise. _ )
2014 Launch installation summary

Restart Weh server

1 GroupWise Calendar Publishing Host -

Calendar Publishing Host Installation Complete

You can choose to have the Installation Wizard restart the web server for you.

Along with the Calendar Publishing Host Application, the Calendar Publishing Host Installation

Wizard also installs Tomcat 6 to c: \novell\tomcaté, integrates it with your web server, and
automatically starts it to support the Calendar Publishing Host Application.

11 Exit the GroupWise Installation Wizard.

12 Continue with Configuring GroupWise to Support the Calendar Publishing Host.
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17.5 Configuring GroupWise to Support the Calendar
Publishing Host

After your install the Calendar Publishing Host Application, additional configuration is still required.

¢ Section 17.5.1, “Configuring the Calendar Publishing Host in the GroupWise Admin Console,” on
page 144

*

Section 17.5.2, “Enabling Calendar Publishing,” on page 145

*

Section 17.5.3, “Configuring a POA for Calendar Publishing,” on page 146

*

Section 17.5.4, “Setting Up Calendar Publishing Administration,” on page 147

*

Section 17.5.5, “Using the Published Calendar Browse List,” on page 148

17.5.1 Configuring the Calendar Publishing Host in the GroupWise
Admin Console

Use the information under Calendar Publishing Host Configuration and Calendar Browse List on your
Calendar Publishing Host Configuration Worksheet as you configure the CalPub Host.

1 In the GroupWise Admin console, click System > Calendar Publishing, then click New.

Mame: |

URL:

Diescription:

Address:

Port: =

o

2 Fill in the fields to configure the CalPub Host, using the following information from the Calendar
Publishing Host Configuration Worksheet

Name:
URL:
Description:
Address:
Port:

IMPORTANT: The name that you specify in the GroupWise Admin console must be the identical
name that you specified during installation, including spacing and capitalization, as described in
Section 17.3.3, “Choosing the Calendar Publishing Host Name,” on page 135.

If you decide that you want to use a different name after you have already installed the CalPub
Host Application, you must reinstall the software, and then specify the identical name during the
reinstallation that you specify in the GroupWise Admin console.
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3 Click OK to save the CalPub Host configuration information.

Calendar Publishing

New...
[F]  MName Description
[F1  Example CalPub Host

1-1 0f 1

[ElEnable Publishing of calendars to the Browse list

o [0k N Cancel

4 If you want to allow users to add their published calendars to the calendar browse list as the
default for your GroupWise system, select Enable Publishing of Calendars to the Browse List.

or

If you want to set up a corporate calendar browse list or provide no calendar browse list, leave
Enable Publishing of Calendars to the Browse List deselected.

5 Click OK when you are finished.
6 Continue with Enabling Calendar Publishing.

17.5.2 Enabling Calendar Publishing

Use the information under Calendar Publishing Options on your GroupWise Calendar Publishing
Host Worksheets as you enable calendar publishing.

1 In the GroupWise Admin console, click Post Offices, then click the name of the post office where
you want to enable calendar publishing.

For convenience in testing your Calendar Publishing Host setup, you might want to start with
your post office.
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2 Click Client Options > Calendar > Web Calendar.

Client Options - Post Office: Engineering

Calendar
Web Calendar Publishing Host  None - |2
General
m, Calendar Publishing
Busy Search Enable Calendar =1
Enable rules to lendar =1
Free/Busy Searching
Enable publish free/busy search =1 ]
Calendar Subscription
[F1Enable subscribe to calendar ='e
Restore Default Settings
) « D D

As you roll out calendar publishing, you can use Client Options to enable it at the domain, post
office, and user level.

3 Select a Calendar Publishing Host from the drop-down list.

4 Set the Web Calendar options as you planned on your Calendar Publishing Host Installation
Worksheet.

5 Click OK to save the Web Calendar settings, then click Close.
6 Restart Tomcat:

OES 11: rcnovell-tomcaté restart
SLES 11: rctomcat6 restart
Windows 1. At the Windows server, click Start > Administrative Tools > Services.

2. Right-click Tomcat 6, then click Restart.

7 Continue with Configuring a POA for Calendar Publishing.

17.5.3 Configuring a POA for Calendar Publishing

After calendar publishing is enabled, the POA can look up calendar information and return it to the
CalPub Host in the form of ICS (Internet Calendaring and Scheduling) or IFB (Internet Free Busy)
files. Internet users can import these files into GroupWise, Outlook, and Macintosh iCal calendaring
applications.

1 In the GroupWise Admin console, click Post Office Agents, then click the name of the POA that
you want to configure for calendar publishing.

2 Click Agent Settings, then scroll down to the Calendar Publishing section.

Calendar Publishing

[ enabled Max Calendar Publishing Threads 4 s

Port: e
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17.5.4

3 Select Enabled.

(Optional) Decrease the number in the Max Calendar Publishing Threads field as needed.

The default maximum number of calendar publishing threads is 4. By default, the POA creates 2
calendar publishing threads and adds more as needed. However, you cannot set the maximum

higher than 4. The default setting is highly recommended.

5 Click OK to save the calendar publishing configuration settings.

6 As you roll out calendar publishing to your GroupWise users, enable calendar publishing on the

POA for each post office where users will publish calendars and free/busy information.

To determine which POAs have been enabled for calendar publishing, see “Viewing Calendar

Publishing Status in the POA Console” in the GroupWise 2014 Administration Guide.
Continue with Setting Up Calendar Publishing Administration.

Setting Up Calendar Publishing Administration

After calendar publishing has been enabled and the POA is communicating with the CalPub Host,

you use the CalPub Admin console to monitor the CalPub Host and to make configuration changes
as needed. Any GroupWise administrator user can access the CalPub Host Admin console. Use the
information under Authentication Information on your Calendar Publishing Host Configuration
Worksheet as you set up Calendar Publishing Host administration.

1

o g A~ W

Edit the calhost.cfg file in the following folder:

Linux: /var/opt/novell/groupwise/calhost
Windows: c¢:\Novell\GroupWise\calhost

Search to find the following line:

#Admin.WebConsole.enable=false

Remove the pound sign (#) to activate the setting.
Change false to true.

Save the file, then exit the text editor.

Restart Tomcat:

OES 11: rcnovell-tomcat6é restart
SLES 11: rctomcat6 restart
Windows 1. At the Windows server, click Start > Administrative Tools > Services.

2. Right-click Tomcat 6, then click Restart.

Display the CalPub Host Admin console:

http://server network address/gwcal/admin
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8 Log in to the CalPub Host Admin console using any GroupWise administrator user name and
password.

Novell. GroupWise. Calendar Publishing Host

Post office network address: 137.65.67.218

Specify the IP address or DNS hostname of the Fost Office that publishes calendars and
free/busy schedules. The publishing host queries this post office for the other post offices

Logging
that are also publishing calendars and free/busy schedules.

Authentication Post office TCP port: 7171

Specify the TCP port that the post office is listening on for publishing calendars and free/busy

Customize schedules.
[save]

Note: It may take up to 10 minutes for configuration changes fo take effect.

For more information about the CalPub Host Admin console, see “Using the CalPub Admin
Console” in the GroupWise 2014 Administration Guide.

9 (Conditional) If additional GroupWise administrators need to access the CalPub Admin console,
notify them of the URL to access.

10 Continue with Using the Published Calendar Browse List.

17.5.5 Using the Published Calendar Browse List

If you selected Enable Publishing of Calendars to the Browse List as your GroupWise system default,
skip to Section 17.6, “Testing GroupWise Calendar Publishing,” on page 148.

If you are planning to implement a corporate calendar browse list in the future, you can enable
publishing of calendars to the browse list for yourself for testing purposes.

1 Browse to and right-click your User object, then click Properties.

2 Click GroupWise > Calendar Publishing.

3 Select Override, then select Enable Publishing of Calendars to the Browse List.

This gives you the right to add your calendars to the calendar browse list so that you can test the
setup of the Calendar Publishing Host.

4 Continue with Testing GroupWise Calendar Publishing.

17.6 Testing GroupWise Calendar Publishing

Now that you have set up a Calendar Publishing Host, you can test it by doing the following:

¢ Section 17.6.1, “Publishing a Personal Calendar,” on page 149
¢ Section 17.6.2, “Displaying the Browse List of Calendars,” on page 149
+ Section 17.6.3, “Publishing Free/Busy Information,” on page 150
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17.6.1

Publishing a Personal Calendar

1 In the GroupWise client, create and populate a personal calendar, as described in “Creating a

Personal Calendar” in the GroupWise 2014 Client User Guide.

2 Right-click the personal calendar, then click Publish.

-
Mike's Department Calendar Properties ‘

===

General | Display | Sharing | Publish

[] Publish this calendar

Time period: (@) Erttire calendar

Previous |7 days through next | 30 days

Include private items

http://137 6567 218/gwcal /calendar/bXBhbHVAZXhhbXBsZS5b 20
_Y249NTIORUI4REUUHvdm &Lk VuZAuZWiya)
NUYuM@

Send Publish Location. .

AraWanLiEwMC4xNzAZMTY3LEu “

L — —

3 Select Publish This Calendar.

For more information, see “Publishing Personal Calendars on the Internet” in the GroupWise

2014 Client User Guide.

This feature is also available in GroupWise WebAccess, as described in “Publishing Personal

Calendars on the Internet” in the GroupWise 2014 WebAccess User Guide.

For more information, see the GroupWise 2014 Calendar Publishing Host User Quick Start.

4 Click Send Publish Location, then address and send the resulting message, which provides the
URL from which Internet colleagues can obtain your calendar information.

The URL has the following format:

http://calpubhost server/gwcal/freebusy/user name@internet domain

5 Click OK to publish the selected personal calendar.

6 Check your mailbox for the notification sent by the Calendar Publishing Host.

7 Continue with Displaying the Browse List of Calendars.

17.6.2 Displaying the Browse List of Calendars

1 Display the following URL:

http://web_server address/gwcal/calendar

Novell. GroupWise. Calendar Publishing H

ost Jan 22, 2014 (Wednesday)

Owner Calendar Actions

George Smith Personal Calendar [Download] [Subscribe]
Mike Palu Mike's Department Calendar [Download] [Subscribe]
Tabitha Hu Tabitha's Sales Calendar [Download] [Subscribe]
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Your newly published personal calendar should appear on the list.

2 Click your calendar to view it in its published format.

This assures you that your calendar is available for access by users across the Internet.

17.6.3 Publishing Free/Busy Information

1 In the GroupWise client, click Tools > Options.

2 Click Calendar > Free/Busy.

Calendar

| General | Work Schedule | Busy Search | Date/Time |

Default Busy Search Options

Searchrange: |7 = days Diays to search Monday
Tuesday
From: gopam [ Wednesday
Thursday
To: 5.00FM ] Friday
[ Saturday
[ Sunday

Intemet Free/Busy
Publish my free/busy information
Location
http://137.65.67.218/gwcal freebusy.thu@example com

Send Free/Busy Publish Location...

3 Click Send Free/Busy Publish Location, then address and send the resulting message, which
provides the URL from which Internet colleagues can obtain your free/busy information.

4 Click OK, then click Close.

5 Check your mailbox for the notification sent by the Calendar Publishing Host.

6 Continue with What’'s Next.

17.7 What’s Next

You can further configure and maintain the Calendar Publishing Host in the following ways:

Task

Using the CalPub Host Admin console to change
the configuration of the CalPub Host

Changing the appearance of the calendar browse
list to represent your company

Restricting the posted list of calendars to those of
corporate importance

Monitoring the CalPub Host at the POA console
and through CalPub Host log files
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17.8 GroupWise Calendar Publishing Host Worksheets

+ Section 17.8.1, “Calendar Publishing Host Installation Worksheet,” on page 151
+ Section 17.8.2, “Calendar Publishing Host Configuration Worksheet,” on page 152

17.8.1 Calendar Publishing Host Installation Worksheet

Installation Wizard Field Value for Your GroupWise Explanation
System
Web Server Platform Section 17.3.1, “Selecting the
) Calendar Publishing Host
¢ Linux Application Platform,” on
+ Windows page 134
Calendar Publishing Host Name Section 17.3.3, “Choosing the

Calendar Publishing Host
Name,” on page 135

Post Office Agent Information Section 17.3.6, “Connecting
the Calendar Publishing Host
¢ POA network address to a POA,” on page 136

* |P address
¢ DNS hostname

¢ Calendar publishing port

(default 7171)
Web Server Information Section 17.3.2, “Gathering Web
Server Information,” on
OES 11 page 134
+ Apache path
/etc/opt/novell/httpd/
conf.d
¢ Tomcat path
/var/opt/novell/tomcat6/
webapps
Web Server Information Section 17.3.2, “Gathering Web
Server Information,” on
SLES 11 page 134

* Apache path

/etc/apache2/conf.d
+ Tomcat path

/usr/share/tomcaté/webapps
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Installation Wizard Field

Value for Your GroupWise
System

Explanation

Web Server Information

Windows

*

Microsoft Internet Information
Server (IIS) for Windows

Path to the web server’s root
directory

Website

Section 17.3.2, “Gathering Web
Server Information,” on
page 134

17.8.2

Calendar Publishing Host Configuration Worksheet

Configuration Field

Value for Your GroupWise
System

Explanation

Calendar Publishing Host
Configuration

*

*

*

*

*

Name

URL
Description
IP address
TCP port

Section 17.3.3, “Choosing the
Calendar Publishing Host
Name,” on page 135

Section 17.3.4, “Determining
the URL of the Calendar
Publishing Host,” on page 135

Section 17.3.2, “Gathering Web
Server Information,” on
page 134

Calendar Browse List

*

*

Yes
+ Corporate (restricted)
+ Open

No

Section 17.3.7, “Designing
Your Calendar Browse List,” on
page 136

Calendar Publishing Options

*

*

Enable calendar publishing

Enable rules to move items to a
published calendar

Enable subscribe to calendar

Enable publish free/busy searches

Section 17.3.8, “Selecting
Calendar Publishing Settings,”
on page 137
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Configuration Field

Value for Your GroupWise
System

Explanation

Calendar Publishing Post Office
¢+ Name

+ POA network address
+ |P address
+ DNS hostname
¢ Calendar publishing port
(default 7171)

Section 17.3.6, “Connecting
the Calendar Publishing Host
to a POA,” on page 136

Authentication Information

+ GroupWise user name

Section 17.3.5, “Selecting a
Calendar Publishing Host
Administrator,” on page 136
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18.1

18.1.1

Setting Up GroupWise Monitor

GroupWise Monitor is a monitoring and management tool that allows you to monitor GroupWise
agents from any location where you are connected to the Internet and have access to a web browser.
Some agent administration can also be performed from your web browser if the agent console is
password protected.

+ Section 18.1, “GroupWise Monitor Overview,” on page 155

+ Section 18.2, “GroupWise Monitor System Requirements,” on page 158

+ Section 18.3, “Planning GroupWise Monitor,” on page 160

+ Section 18.4, “Installing the GroupWise Monitor Software,” on page 163

+ Section 18.5, “Testing GroupWise Monitor,” on page 170

+ Section 18.6, “GroupWise Monitor Installation Worksheets,” on page 172

IMPORTANT: If you are installing GroupWise Monitor in a clustered server environment, see the
“Clustering” in the GroupWise 2014 Interoperability Guide before you install Monitor.

GroupWise Monitor Overview

+ Section 18.1.1, “GroupWise Monitor Functionality,” on page 155

*

Section 18.1.2, “GroupWise Monitor Components,” on page 156

*

Section 18.1.3, “One Monitor Server versus Two,” on page 156

*

Section 18.1.4, “Monitor Security Requirements,” on page 157

*

Section 18.1.5, “Monitor and the GroupWise High Availability Service on Linux,” on page 158

GroupWise Monitor Functionality

GroupWise Monitor is a monitoring and management tool that allows you to monitor GroupWise
agents from any location where you are connected to the Internet and have access to a web browser.
Some agent administration can also be performed from your web browser. Monitor provides more
detail than is provided on the System page in the GroupWise Admin console.

You can install Monitor on either Linux or Windows. Either version can monitor agents on both Linux
and Windows. Depending on the installation platform, two or three different monitoring environments
are available:

+ Monitor Web Console: The Monitor Web console, provided by the Monitor Application, takes
advantage of your web server’s capabilities to make agent status information available to you
when you are outside your firewall.

Setting Up GroupWise Monitor 155


https://www.novell.com/documentation/groupwise2014/pdfdoc/gw2014_guide_interop/gw2014_guide_interop.pdf#interopclustering
https://www.novell.com/documentation/groupwise2014/pdfdoc/gw2014_guide_interop/gw2014_guide_interop.pdf#interopfront

+ Monitor Agent Console: The Monitor Agent console, provided by the Monitor Agent itself, can
be used only behind your firewall, but it provides capabilities that are not available in the main
Monitor Web console. This section focuses on using the full-featured Monitor Agent console.

NOTE: The Monitor Web console and the Monitor Agent console are available on both Linux and
Windows because they are browser based.

+ Windows Monitor Agent Server Console: The Windows Monitor Agent server console is
available only on the Windows server where the Windows Monitor Agent runs and only if you run
the Monitor Agent as an application, rather than as a Windows service. All agent configuration
tasks can be performed at the Windows Monitor Agent server console, but some reports are not
available.

Specific differences in functionality between the three Monitor consoles are summarized in
“Comparing the Monitor Consoles” in the GroupWise 2014 Administration Guide.

18.1.2 GroupWise Monitor Components

GroupWise Monitor consists of two components: the Monitor Agent and the Monitor Application.

Internal
Monitor
Console

1

T

Web

External Browser
Monitor

Console

I _J Post Office
. Agents
- Monitor I
Application
Message Transfer
E;I — G !9 < , < > E Agents
Web Browser Internet Web Server Monitor
Agent E'E: Internet

Agents

+ Monitor Agent: The Monitor Agent continuously polls the POA, MTA, and GWIA; gathers status
information from them; and displays the status information in the Monitor Agent console. The
Monitor Agent also services requests for agent status information from the Monitor Application,
which displays the Monitor Web console.

+ Monitor Application: The Monitor Application extends the capability of your web server so that
agent status information can be displayed in your web browser in the Monitor Web console.

18.1.3 One Monitor Server versus Two

The Monitor Agent and the Monitor Application can run together on a Linux server or a Windows
server. The server where they run together must be a web server because the Monitor Application is
installed into the web server.

The Monitor Agent and the Monitor Application can also run on different servers. The security issues
discussed in Monitor Security Requirements might determine whether you run the Monitor Agent on
the same server with the web server and the Monitor Application.
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18.1.4 Monitor Security Requirements

GroupWise Monitor can be configured to support the level of security you have established for your
Internet/intranet communication.

If you are not concerned about security issues (for example, you plan to use Monitor only on a
secured intranet), you can install the Monitor components to any servers that provide access for your
GroupWise administrators and that meet the requirements listed in Section 18.2, “GroupWise Monitor
System Requirements,” on page 158.

If you plan to use Monitor to provide GroupWise administrators with access to your GroupWise
system from anywhere on the Internet (rather than simply within a secured intranet), and you already
have a firewall in place to provide security, you have the following options for configuring Monitor:

+ Install both Monitor components inside your firewall and use a proxy service. See “Configuring
Monitor with a Proxy Service” on page 157. This is the recommended configuration.

+ Install the Monitor Application to a web server outside your firewall and the Monitor Agent on a
server inside your firewall. See “Configuring Monitor without a Proxy Service” on page 158.

Configuring Monitor with a Proxy Service

If your firewall includes a proxy service, you can install the Monitor Application to a web server inside
your firewall, and the Monitor Agent to another server inside the firewall.

In this configuration, only the firewall server with the proxy service is located outside the firewall, as
shown in the following illustration.

External Internal
Monitor Monitor
Console Console
] ] ] .
it i i it
Web Web Web Web
Browser Browser Browser Browser

{

Post Office
—> —J Agents

1 l [ Firewall Monitor
Application

! !:) ! @ Message Transfer
< > s > < > > % Agents
| - - st
Internet Firewall Server Web Network
with Proxy Server Server —> I=l{: T\;eergteé’t
Service with Monitor
Agent

If desired, the Monitor Agent can also be installed to the web server rather than to a separate server,
as described in Section 18.1.3, “One Monitor Server versus Two,” on page 156.
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18.1.5

18.2

Configuring Monitor without a Proxy Service

If your firewall does not provide a proxy service, you need to install the Monitor Application to a web
server that is outside the firewall. However, the Monitor Agent requires direct access to a GroupWise
domain folder, so it needs to be installed to a server that is located within the firewall. It should be
installed to the same server where a domain folder is located.

In this configuration, both the web server and the firewall server are located outside the firewall, as
shown in the following illustration.

External Internal
Monitor Monitor
Console Console
] ] ] ]
EEFE EEE EEEE) o
Web Web Web Web
Browser Browser Browser Browser

[ 1 [ _J Post Office
Monitor Firewall — Agents
Application
—! Message Transfer
— !:)~ > !~ ET TS > ! < > E Agents

Y —
Internet Web Firewall Server Network Internet
Server Server — |=r[: Agents
with Monitor
Agent

The firewall must allow inbound IP packets to be sent from the web server to the IP address and port
number of the Monitor Agent (for example, 172.16.5.18:8200).

In addition, the firewall must allow outbound IP packets to be sent from the Monitor Agent to the web
server. This requires all high ports (above 1023) to be open to outbound IP packets.

Monitor and the GroupWise High Availability Service on
Linux

The Monitor Agent can be used with the GroupWise High Availability service (gwha), which runs on
Linux, to automatically restart GroupWise agents when they stop unexpectedly. For setup
instructions, see “Automatically Restarting the Linux GroupWise Agents with the GroupWise High
Availability Service” on page 95.

There is no GroupWise High Availability service on Windows. Windows includes a mechanism for
restarting services automatically when they stop unexpectedly. For more information, see “Clustering”
in the GroupWise 2014 Interoperability Guide.

GroupWise Monitor System Requirements

+ Section 18.2.1, “Hardware and Operating System Requirements,” on page 159
+ Section 18.2.2, “Web Server Requirements,” on page 159

+ Section 18.2.3, “Web Browser Requirements,” on page 160
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18.2.1 Hardware and Operating System Requirements

(J x86-64 processor for the Monitor Agent
J x86-64 or x86-32 processor for the Monitor Application
(0 Any of the following server operating systems for the Monitor Agent and the Monitor Application:

+ Novell Open Enterprise Server (OES) 11, plus the latest Support Pack
¢ SUSE Linux Enterprise Server (SLES) 11, plus the latest Service Pack

NOTE: On Linux, the X Window System and Open Motif are required by the GUI
GroupWise agent server consoles for the Post Office Agent, the Message Transfer Agent,
and the Internet Agent.

By default, the GroupWise Linux agents run as services without user interfaces. Starting
and stopping the agents when they are running with a user interface is not supported in the
GroupWise Administration console.

+ Windows Server 2008 R2, Windows Server 2012, or Windows Server 2012 R2, plus the
latest Service Pack

(0 Adequate server memory as required by the operating system
O Adequate server disk space:
+ Approximately 40 MB for the Monitor Agent (varies by platform)

+ Approximately 525 MB for the Monitor Application (shared with the WebAccess Application
and the Calendar Publishing Host Application when they are installed on the same web
server; varies by platform)

18.2.2 Web Server Requirements
The web server that is supported for your operating system:

0 x86-64 or x86-32 processor
(J OES 11/SLES 11
Apache 2.2 plus:
+ Tomcat 6
+ IBM Java 6 Runtime Environment (JRE)
¢ ModProxy Module

A Linux repository should be available when you run the GroupWise Installation Wizard. Apache,
Tomcat, the JRE, and the ModProxy Module are automatically installed from the Linux repository
if they are not already present on the Linux server.

If no Linux repository is available during the GroupWise installation, you are prompted to
manually install these required components from the Linux media, and then restart the
GroupWise installation.

O Wwindows Server 2008 R2 / Windows Server 2012 / Windows Server 2012 R2
Microsoft Internet Information Server (11S) 7 or later plus:
¢ Tomcat 6
+ |IBM Java 6 Runtime Environment (JRE)
+ Jakarta Connector 1.2
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18.2.3

18.3

18.3.1

Tomcat 6.0.24, Oracle JRE 6 Update 26, and Jakarta Connector 1.2 are automatically
installed along with the GroupWise software if they are not already present on the Windows
server.

+ ISAPI support

Web Browser Requirements

Any of the following web browsers for the Monitor console:

O Linux: Mozilla Firefox
(J Windows: Microsoft Internet Explorer 10 or later; Mozilla Firefox

O Macintosh: Mozilla Firefox

Planning GroupWise Monitor

Use the “GroupWise Monitor Installation Worksheets” on page 172 to record your decisions about
how to install GroupWise Monitor.

The topics in this section present the required information in a convenient planning sequence. The
Installation Worksheet organizes the information in the order in which you need it during installation.
+ Section 18.3.1, “Deciding Where to Install the GroupWise Monitor Components,” on page 160

+ Section 18.3.2, “Determining the Monitor Agent’s Configuration,” on page 162

+ Section 18.3.3, “Determining the Monitor Application’s Configuration,” on page 163

IMPORTANT: If you are installing GroupWise Monitor in a clustered server environment, see the
“Clustering” in the GroupWise 2014 Interoperability Guide before you install Monitor.

Deciding Where to Install the GroupWise Monitor
Components

After reviewing Section 18.1, “GroupWise Monitor Overview,” on page 155 and the system
requirements listed in Section 18.2, “GroupWise Monitor System Requirements,” on page 158, plan
where you want to install the Monitor components in your system.

+ “Monitor Agent Server” on page 161

+ “Web Server” on page 161
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Monitor Agent Server

The Monitor Agent runs on Linux and Windows. On Linux, the Monitor Agent runs as a daemon. On
Windows, the Monitor Agent runs as a Windows service or as an application. When the Monitor Agent
runs as an application, it has a user interface on the Windows server. When it runs as a Windows
service, it does not.

If you want to install the Monitor Agent and the Monitor Application to the same server, you can install
them at the same time. If you want to install them to different servers, you must run the Monitor
Installation program twice, once for each server. For example, you might want to install the Monitor
Application on Linux for use with a Linux web server, but you might want to install the Monitor Agent
on Windows so that you can use its server console, which is not available on Linux.

The Monitor Agent needs to communicate with an MTA. If possible, install the Monitor Agent on the
same server where a domain and MTA are already located. If you want to install the Monitor Agent on
its own server, consider creating a domain on that server specifically for helping the Monitor Agent
communicate with the rest of your GroupWise system.

The installation folder for the Monitor Agent depends on the platform:

Linux: The Linux Monitor Agent is automatically installed to /opt /novell/groupwise/agents.
Windows:  The default installation directory is c: \Program Files\Novell\GroupWise Monitor.

On Windows, you can specify a different directory during installation. On Linux, you cannot.

GROUPWISE MONITOR AGENT INSTALLATION WORKSHEET

Under Agent Software Platform, mark the platform (Linux or Windows) where you plan to install the Monitor
Agent.

Under Server Information, specify the directory on the Linux or Windows server where you plan to install the
Monitor Agent software.

Web Server

The Monitor Application can be installed to a web server on Linux or Windows.

GROUPWISE MONITOR APPLICATION INSTALLATION WORKSHEET

Under Web Server Platform, mark whether you plan to install the Monitor Application to a Linux or Windows
web server.
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18.3.2

The Monitor Application integrates with your web server to pass agent status information gathered by
the Monitor Agent to your web browser for display in the Monitor web console. The location of the
Monitor Application files that are installed depends on the web server that it is being integrated with.
The default web server paths vary by platform:

Apache Web Server on OES 11: /etc/opt/novell/httpd/conf.d
Tomcat on OES 11: /var/opt/novell/tomcat6/webapps
Apache Web Server on SLES 11: /etc/apache2/conf.d

Tomcat on SLES 11: /usr/share/tomcat6/webapps
Microsoft Internet Information Server (1IS) on Windows: c:\inetpub\wwwroot

Tomcat on Windows: c:\novell\tomcaté\webapps

GROUPWISE MONITOR APPLICATION INSTALLATION WORKSHEET

Under Web Server Information, select the type of web server you want to use with Monitor, and specify the
directory path to the web server root directory.

On Windows, if the Internet Information Server services more than one website, specify the website where you
want to install the Monitor Application.

Determining the Monitor Agent’s Configuration

As you install the Monitor Agent, you are prompted to supply the configuration information:

+ Monitor Agent Network Address
+ Domain Folder

Monitor Agent Network Address

The Monitor Agent communicates with the Monitor Application and with monitored agents by way of
TCPI/IP.

GROUPWISE MONITOR AGENT INSTALLATION WORKSHEET

Under Server Information, record the IP address or DNS hostname of the Linux or Windows server where you
plan to install the Monitor Agent software. Use the default port number of 8200 unless that number is already in
use on that server.

If you are installing the Monitor Application on a different server from where you are installing the Monitor
Agent, record the same information under Monitor Agent Information on the GroupWise Monitor Agent
Installation Worksheet.

For a complete list of default port numbers used by the GroupWise agents, see “GroupWise Port
Numbers” in the GroupWise 2014 Administration Guide.

Domain Folder

The Monitor Agent can gather information about the locations of GroupWise agents to monitor by
reading from a domain database. Using the gathered information, the Monitor Agent can display a list
of monitored agents when you start it for the first time.
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18.3.3

18.4

GROUPWISE MONITOR AGENT INSTALLATION WORKSHEET

Under Domain Location, specify the path to a domain folder where an MTA is running.

If the domain is located on a different server from where you are installing the Monitor Agent, specify the IP
address or DNS hostname of the domain server.

Service vs. Application (Windows Only)

On Windows, you can choose to install the Monitor Agent as a Windows service or an application.

When you install the Monitor Agent as an application, it displays a Monitor Agent console on the
server where it runs. You can start the Windows Monitor Agent on the Windows Start menu, or you
can create a desktop icon for it.

When you install the Monitor Agent as a service, it does not display a server console. You manage it
by using the Windows Services administrative tool.

GROUPWISE MONITOR AGENT INSTALLATION WORKSHEET

Under Windows Installation Option, mark Service or Application.

Determining the Monitor Application’s Configuration

Monitor Application configuration information is stored in a configuration file (gwmonitor.cfg),
located in the following directories:

Linux: /var/opt/novell/groupwise/monitor
Windows:  ¢:\novell\groupwise\gwmonitor

The default configuration information is sufficient for an initial Monitor Application installation. For
more information about configuring the Monitor Application, see “Configuring the Monitor Application”
in the GroupWise 2014 Administration Guide after you have installed the Monitor Application.

Installing the GroupWise Monitor Software

As you install the Monitor software, use the GroupWise Monitor Installation Worksheets that you filled
out in Section 18.3, “Planning GroupWise Monitor,” on page 160 to provide the required information.

+ Section 18.4.1, “Linux: Installing the GroupWise Preparing the Linux Server for GroupWise Monitor
Monitor Software,” on page 164 Installing and Configuring the Linux Monitor Agent

Installing and Configuring the Linux Monitor
Application
Starting the Linux Monitor Agent

If you are new to Linux, you might want to review
“Linux Basics for GroupWise Administration” in the
GroupWise 2014 Administration Guide.
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¢ Section 18.4.2, “Windows: Installing the Preparing the Windows Server for GroupWise Monitor
GroupWise Monitor Software,” on page 167 Installing the Windows GroupWise Monitor Software
Starting the Windows Monitor Agent

IMPORTANT: If you are installing GroupWise Monitor in a clustered server environment, see the
“Clustering” in the GroupWise 2014 Interoperability Guide before you install Monitor.

18.41 Linux: Installing the GroupWise Monitor Software

+ “Preparing the Linux Server for GroupWise Monitor” on page 164
+ “Installing and Configuring the Linux Monitor Agent” on page 164
+ “Installing and Configuring the Linux Monitor Application” on page 166

¢ “Starting the Linux Monitor Agent” on page 167

Preparing the Linux Server for GroupWise Monitor

1 Ensure that the server where you are installing the Monitor Agent meets the system
requirements listed in Section 18.6, “GroupWise Monitor Installation Worksheets,” on page 172.

2 Ensure that the web server where you are installing the Monitor Application meets the system
requirements listed in Section 18.2.2, “Web Server Requirements,” on page 159.

3 Ensure that the server has a static IP address.

4 Ensure that the firewall on the server has the ports open that are used by the Monitor Agent and/
or the Monitor Application and the web server.

For assistance, see “GroupWise Port Numbers” in the GroupWise 2014 Administration Guide.

5 Continue with Installing and Configuring the Linux Monitor Agent.

Installing and Configuring the Linux Monitor Agent

1 In a terminal window, become root by entering su - and the root password.

2 Start the GroupWise Installation Wizard at the root of the downloaded GroupWise 2014 software
image:
./install.sh

3 Type the number for the language in which you want to run the GroupWise Installation Wizard,
then press Enter to select OK.

N
Please select an option: |
[ [
| "Woccunentation |
| 2 Installation |
: 4'

TR - et |

4 (Optional) Type 1 for Documentation, then press Enter to review the Readme, Quick Start, and
Installation Guide to better prepare yourself for the installation.

5 Type 2 for Installation, then press Enter.
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6 Type a to accept the License Agreement and display the Software list.

Please select an option:

(1

|2 Groupwise WebAccess

|3 GroupwWise Calendar Publishing Host
|4 GroupWise Monitor Agent

|5 Groupwise Monitor Application

e < Back > < Exit >

7 Type 4 for GroupWise Monitor Agent, then press Enter to display the Actions list.

10

1"

12
13
14

15

1
Please select an option: |
[ [
| | [
| 2 configure |
t [
.I
[
]

E! < Back =

Type 1 for Install, then press Enter to install the Monitor Agent.

The Monitor Agent package is installed on the server. If any supporting packages are not
available on the server, the Installation Wizard automatically installs them from the operating
system media.

During the installation, any other GroupWise agents on the server are stopped and then started
again after the Monitor software has been installed.

Type 2 for Configure, then press Enter to configure the Monitor Agent.

Follow the prompts to configure the Monitor Agent, using the following information from the
GroupWise Monitor Agent Installation Worksheet:

Domain Directory Path

Type 1 for Yes, then press Enter, to configure the Monitor Agent to automatically start when the
server restarts.

IMPORTANT: The Monitor Agent must be running in order for the GroupWise High Availability
Service (gwha) to automatically restart the GroupWise agents if they stop unexpectedly. For
more information, see “Automatically Restarting the Linux GroupWise Agents with the
GroupWise High Availability Service” on page 95.

Press any key to exit the Monitor Agent Configuration.
Type b for Back to return to the Software list.

In a terminal window, start the Monitor Agent:

rcgrpwise-ma start

NOTE: Unlike the other GroupWise agents, you do not need to be logged in as root in order to
start the Monitor Agent.

Continue with Installing and Configuring the Linux Monitor Application.
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Installing and Configuring the Linux Monitor Application
1 If you are installing the Monitor Application on the same server where you just installed the
Monitor Agent, skip to Step 2.
or

If you are installing the Monitor Application on a different server from where you installed the
Monitor Agent:

1a Access the web server where you want to install the Monitor Application.
1b In a terminal window, become root by entering su - and the root password.

1c Start the GroupWise Installation Wizard at the root of the downloaded GroupWise 2014
software image:

./install.sh

1d Type the number for the language in which you want to run the GroupWise Installation
Wizard, then press Enter to select OK.

Please select an option:

"Woocumentation

2 Installation

I
|
|
L

< 0K > < Exit =

1
|
|
|
|
i
|
|

1e Type 2 for Installation, then press Enter.

1f Type a to accept the License Agreement and display the Software list.

Please select an option:

[Wroupwise server

|2 GroupWise WebAccess

|3 GroupwWise cCalendar Publishing Host
|4 GroupWise Monitor Agent

|5 GroupWise Monitor Application

u ! < Back > < Exit =

2 Type 5 for GroupWise Monitor Application, then press Enter to display the Actions list.

1
Please select an option: |
[ |
| i |
| 2 configure |
L |

< [k > < Back > !

3 Type 1 for Install, then press Enter to install the Monitor Application.

The Monitor Application is installed on the server. If any supporting packages are not available
on the server, the Installation Wizard automatically installs them from the operating system
media.

4 When the installation is finished, press any key to return to the Installation Options list.
5 Type 2 for Configure, then press Enter to configure the Monitor Application.
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6 Follow the prompts to configure the Monitor Application, using the following information from the
GroupWise Monitor Application Installation Worksheet:

Server Information

Web Server Information
7 Press any key to exit Monitor Application Configuration.
8 Exit the GroupWise Installation Wizard.

9 (Conditional) If you use a proxy service, follow the instructions in “Configuring Proxy Service
Support for the Monitor Console” in the GroupWise 2014 Administration Guide.

10 Continue with Starting the Linux Monitor Agent.

Starting the Linux Monitor Agent

1 Use the following commands to manage the Monitor Agent:

rcgrpwise-ma start
rcgrpwise-ma restart
rcgrpwise-ma stop
rcgrpwise-ma status

2 (Optional) If desired, you can run the Monitor Agent executable directly:

2a Change to the GroupWise agent bin folder.
cd /opt/novell/groupwise/agents/bin
2b Use one of the following commands to start the Monitor Agent:

./gwmon --home /domain folder &
./gwmon --ipa domain server ip address --ipp mta port number &

3 For instructions on using the Monitor consoles, skip to Section 18.5, “Testing GroupWise
Monitor,” on page 170.

18.4.2 Windows: Installing the GroupWise Monitor Software

+ “Preparing the Windows Server for GroupWise Monitor” on page 167
+ “Installing the Windows GroupWise Monitor Software” on page 168

+ “Starting the Windows Monitor Agent” on page 170

Preparing the Windows Server for GroupWise Monitor

1 Ensure that the server where you are installing the Monitor Agent meets the system
requirements listed in Section 18.6, “GroupWise Monitor Installation Worksheets,” on page 172.

2 Ensure that the web server where you are installing the Monitor Application meets the system
requirements listed in Section 18.2.2, “Web Server Requirements,” on page 159.

3 Ensure that the server has a static IP address.

4 Ensure that no GroupWise agents are currently running on the Windows server where you plan
to install the Monitor Agent.

5 Ensure that the firewall on the server has the ports open that are used by the Monitor Agent and/
or the Monitor Application and the web server.

For assistance, see “GroupWise Port Numbers” in the GroupWise 2014 Administration Guide.

6 Continue with Installing the Windows GroupWise Monitor Software.
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Installing the Windows GroupWise Monitor Software

1 Run setup.exe at the root of the downloaded GroupWise 2014 software image to start the
GroupWise Installation Wizard.

3¢ Novell GroupWise .
Novell. GroupWise. 2014 e

Documentation

Readme

Quick Start
Installation Guide
Full Documentation

Installation

GroupWise Server

GroupWise Client

GroupWise WebAccess

GroupWise Calendar Publishing Host
GroupWise Monitor

GroupWise Free/Busy Service
GroupWise MMC Plugin

2 Click GroupWise Monitor, accept the License Agreement, then click Next.

il GroupWise Monitor -

Welcome to the Novell GroupWise Monitor
Installation Program

e The InstallShield{R) Wizard will install Movell GroupWise Monitor

on your computer. To continue, dick MNext.

Novell.
GroupWise
2014

WARNING: This program is protected by copyright law and
international treaties.

< Back Next > | | Cancel

3 Click Next to display the GroupWise Monitor Components page.

s GroupWise Monitor -

~

P itor C it
By default, the Monitor Agent and the Monitor Application are installed together
on the same server.

[0 Web Browser Which component do you want to install on this server?

I GroupWise Monitor Agent
= L Gathers and displays status information from GroupWise
[===] Monitor agents (MTA, POA and Internet Agent). Must be installed
Application on Windows.
i :
E= Monitor Agent Grouplise Monitor Application
I I i Communicates with the Web server and Monitor Agent to
display status information about GroupWise agents (MTA,
% % % POA and Internet Agent) in a Web browser. Must be
= = = installed on a Windows Web server running Microsoft

Other Internet Information Services (1I5).
MTA Agents POA

InstalShield

o | mew> ][ o
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The Installation Wizard provides diagrams that help you understand how the various
components interact with each other. Review the diagrams as you provide the requested
information.

4 (Conditional) If you are installing the Monitor Agent, follow the prompts to provide the information
from your GroupWise Monitor Agent Installation Worksheet:

Server Information
Domain Directory
Service vs. Application

5 (Conditional) If you are installing the Monitor Application, follow the prompts to provide the
information from your GroupWise Monitor Application Installation Worksheet:

Monitor Agent Information (This page does not appear when you install the Monitor Agent and
the Monitor Application together on the same server.)

Web Server Information
6 Review the Installation Summary, then click Install.

=)

Installation Summary

GroupWise Monitor

If you want to review or change any settings, dick Back. Click Install to begin

copying files.

] Web Browser

!

I Web Server

Monitor
Apgplication

!

IDr‘llDr IQEHI I
= EE

Other
MTA Agenits POA

-}
[ --]
BEwm

Installshield

Installation Guide

O

Installation summary:
Groupiise Monitor Agent

GroupWise 2014 -version: 14.0.0

URL to GroupVise Monitor Agent: http:f/137.65.67.226:82

Server
Installation Path: C:\Program FilesMovell\GroupWiise Mc
MNetwork address: 137.65.67.226
Port number: 8200
Default language: English

Nomain

< Back ” Install Cancel

7 (Conditional) If prompts appear because your web server is running, decide whether you want
the Installation Wizard to stop your web server.

8 When the installation is complete, click Finish to exit the Monitor Installation program.

2 GroupWise Monitor .
Monitor Installation Complete
e The Monitor Installation program has successfully installed
Movell GroupWise Monitor. Click Finish.
Novell.
GroupWise.
Launch installation summary
2014 “

Start the Group\Wise Monitor Agent

Restart Web server
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You can choose to have the Monitor Installation program start the Monitor Agent and restart the
web server for you.

9 Click Finish to exit the GroupWise Installation program.

If you chose to start the Monitor Agent immediately, the Monitor Agent server console displays
on the Windows server.

& GroupWise Monitor = = -
Configuration View Actions Reports Log Help
427 ExampleGroupiwise? Statug Status Duration | Mame Type Up Time Closed Links | Queued | Platform
" Homal 0 days, 00:02 Engineering.Provol  POA 92 da E.37 Linuz
¥ Normal 0 days, 00:02 Proval GWwla GEwla 0 days, 0353 M4, M4, Linus
¥ Mormal 0 days, D002 Prova2 Giwla GWla 3 daps, 0953 M4 M4 ‘Windows
¥ Mormal 0 days, D002 Marketing.Prova2 PO&A 3 days, 05:52 M M ‘windows
& Mormal 0 days, 00:02 Proval MTA 0 daps, 0353 0 Linus
¥ Mormal 0 days, 00:02 ProvoZ2 MTA 3 days, 05:53 1 1 Windows
¥ Mormal 0 days, 00:02 Provo3 MTA 0 days, 03:53 0 Linwx
¥ Momal 0 days, 00:02 Salez.Provod POA 92 dayz, 1637 M/A M Linus
< m >
Mext Poll: 04:22 HTTP: 8200 Agents: 8

If the Monitor Agent does not start successfully, see “Manually Starting the Windows Agents As
Applications for Troubleshooting” on page 103.

10 (Conditional) If you use a proxy service, follow the instructions in “Configuring Proxy Service
Support for the Monitor Console” in the GroupWise 2014 Administration Guide.

11 Continue with Testing GroupWise Monitor.

Starting the Windows Monitor Agent

1 If you installed the Monitor Agent as a Windows service, use the Services administrative tool to
start and stop it.

or

If you installed the Monitor Agent as an application, start it on the Windows Start menu, or create
a desktop icon to start it.

2 Continue with Testing GroupWise Monitor.

18.5 Testing GroupWise Monitor

Monitor has two different web-based consoles. The main Monitor web console uses the capabilities of
your web server to provide access from outside your firewall. The web-based Monitor Agent console
is provided by the Monitor Agent itself and provides additional functionality beyond that which is
available from outside your firewall.

On Windows, the Monitor Agent also has a server console that displays only on the Windows server
where the Monitor Agent runs.

+ Section 18.5.1, “Using the Monitor Web Console,” on page 171
+ Section 18.5.2, “Using the Monitor Agent Console,” on page 171
+ Section 18.5.3, “Using the Windows Monitor Agent Server Console,” on page 172
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18.5.1

18.5.2

Using the Monitor Web Console

To display agent status information in your web browser from outside your firewall, enter the Monitor
Web console URL in your web browser:

http://network address/gwmon/gwmonitor

Replace network_address with the IP address or DNS hostname of the server where your web server
runs. The Monitor console appears.

GroupWises Monitor

Novell

® e Example GroupWisesy Monitered agents for "ExampleGroupWiseSystem™ group
Total: 8 Displayed:1-8

Create Refresh [[Show Subgraup Agents | [ Prablem | [ Suspend | [ Resume | [ Mave |[ Options | [ Thieshalds | [ Help |
R:An::E (] Name Status Status Duration Up Time Type Version Platform
Delete O @ Provol Mormal 3d2h33m 3d2h30m MTA 14.0.0 (01-17-14) Linux
Befiesh [ (@ Engineering Provol Mormal 3d2h33m 3d2h30m POA 1400 {D1-17-14) Linux
£ | @ Provol GWIA Mormal 3d2h33m 3d2h30m GWIA  14.0.0 01-17-14) Linux
1] @ Provo2 Mormal 0dOhM m 1d20h54 m WITA 14.0.0 (01-21-14) ‘Windows
1] @ Provo2 GWIA Mormal 0dOhM m 1d20h54m GWIA  14.0.0 (01-21-14) ‘Windows
| @ Marketing. Provo2 Mormal 0dOh1m 1d20h332m POA 14.0.0 (01-21-14) Windows
O @ Provo3 Mormal  3d2h33m 3d2h30m MTA 14.0.0 (01-17-14) Linux
O @ Sales Provo3 Mormal 3d2h33m 3d2h30m POA 14.0.0 (01-17-14) Linux

You can use this same URL to view the same agent status information in various browsers and on
mobile devices.

You can perform many of the same monitoring activities at the Monitor Web console as you can at the
Windows Monitor Agent server console. Refer to the online help in the Monitor Web console for
additional information about each Monitor Web console page.

For more information about using the Monitor consoles, see “Monitor” in the GroupWise 2014
Administration Guide.

Using the Monitor Agent Console

To display agent status information in your web browser from inside your firewall, enter the Monitor
Agent console URL in your web browser:

http://network address:8200

Monitored agents for ExampleGroupWiseSystem
Up Time: 3 days, 0352

| Show Subgroup Agents || Problem || Suspend || Resume || Move H Options || Thiesholds |

® v ExampleGroupWiseSystem [&]

Create
Sas Status Duration Mame e Up Time Closed Links Queued Platform Version
Rename
Move [ ¥ jyomal 2 days 0236 Engineering Provel POA 3 days, 02:30 N MiA  Linwx 14.0.0 (01-17-14)
Delete
[ 0 joyma 0 days 0003 Matketing Prove2  POA 1 days 2053 NiA NIA  Windows 14.0.0 [01-21-14)
D [? Maormal 3 davs, 02:36  Proval MTA 3 days, 02:30 o o Linux 14.0001-17-14)
[ ¢ yoymal 3 days. 0236 Provel GWIA GWIA 3 days, 02:30 N, WA Linux 14.0.0 01-17-14)
[ ¥ ygima O days. 0014 Prove2 MTA 1 days, 2054 1 31 Windows 14.0.0 01-21-14)
[ 0 joyma O days. 00:14  Prove2 GWIA GWIA 1 days 2054 Nis Ni&  Windows 14.0.0 [07-21-14)
[ % joyma @ d3ys 02:36  Proved MTA 3 days, 02:30 o 0 Linux  14.0.0 [01-17-14)
[ ¥ jomal 3 days. 02:36  SalesProved POA 3 days, 02:30 N, WA Linux 14.0.0 01-17-14)

For instructions on protecting the Monitor Agent console with a password, see “Securing the Monitor
Web Console” in the GroupWise 2014 Administration Guide.
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18.5.3 Using the Windows Monitor Agent Server Console

To start the Monitor Agent on a Windows server and display the Windows Monitor Agent server
console:

+ On Windows Server 2012: Click Search > GroupWise Monitor.

You might find it convenient to pin GroupWise Monitor to the Windows Start menu for future use.

+ On Windows Server 2008: Click Start > All Programs > GroupWise Monitor > GroupWise
Monitor.

The Windows Monitor Agent server console appears.

E) GroupWise Monitor NEIEN
Configuration View Actions Reports Log Help
475 ExampleGroupWiset | Status Statuz Duration | Name Type Up Time Closed Links | Queued | Platfarm
2 Engineering.Proval  POA 92 ¢ ;37 M4 A4, Lirws
o Normal 0 days, 00002 Proval Giwld, Ghwilé O days, 0353 M Mid Lirws
& Normal 0 days, 00:02 Provo2 Giwla Ghwila 3 days, 05:53 MAA MiA Windows
¥ Normal 0 days, 0002 I arketing. Provo2 FOA 3 days, 05:52 M Mis Windows
& Normal 0 days, 00:02 Praval MTA 0 days, 03:53 1] Lirws
¥ Normal 0 days, 00:02 Frovo2 MTA 3 days, 05:53 1 1 Windows
& Normal 0 days, 00:02 Pravad MTA 0 days, 03:53 1] Lirws
¥ Normal 0 days, 0002 Sales. Provod FOA 92 days, 16:37  N/A Mis Lirws
< m >
Next Poll: 04:22 HTTP: 8200 Agents: 8

In the Monitor Agent server console, you can perform many activities, for example:

+ Use items on the Configuration menu to configure the Windows Monitor Agent as needed.

+ Use items on the View menu to choose how much and what kind of agent status information to
display.

+ Create agent groups in order to monitor related agents together.

+ Use items on the Reports menu to check the status of links throughout your GroupWise system
and to organize status information into a format that can be emailed or printed.

+ Use items on the Actions menu to control agent polling.

For more information about using the Windows Monitor Agent server console, see “Monitor” in the
GroupWise 2014 Administration Guide.

18.6 GroupWise Monitor Installation Worksheets

+ Section 18.6.1, “GroupWise Monitor Agent Installation Worksheet,” on page 173
+ Section 18.6.2, “GroupWise Monitor Application Installation Worksheet,” on page 173
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18.6.1

18.6.2

GroupWise Monitor Agent Installation Worksheet

Installation Program Field

Value for Your GroupWise
System

Explanation

Monitor Component

+ GroupWise Monitor Agent

Section 18.1, “GroupWise Monitor
Overview,” on page 155

Agent Software Platform

* Linux

+ Windows

Section 18.3.1, “Deciding Where to
Install the GroupWise Monitor
Components,” on page 160

Server Information
+ [nstallation path
Linux:

/opt/novell /groupwise/
agents/bin

Windows:

c:\Program
Files\Novell\GroupWise
Monitor

+ Network address
+ |IP address
+ DNS hostname
+ TCP port
(default 8200)

Section 18.3.1, “Deciding Where to
Install the GroupWise Monitor
Components,” on page 160

“Monitor Agent Network Address”
on page 162

Domain Location

* Server

¢ Path

“Domain Folder” on page 162

Windows Installation Option

+ Service

+ Application

“Service vs. Application (Windows
Only)” on page 163

GroupWise Monitor Application Installation Worksheet

Installation Program Field

Value for Your GroupWise

System

Explanation

Monitor Component

* GroupWise Monitor Application

Section 18.1, “GroupWise Monitor
Overview,” on page 155
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Installation Program Field Value for Your GroupWise

System

Explanation

Web Server Platform

¢ Linux

+ Windows

Section 18.1, “GroupWise Monitor
Overview,” on page 155

Monitor Agent Information

¢ |P address

¢ DNS hostname

¢ TCP port
(default 8200)

“Monitor Agent Network Address”
on page 162

Web Server Information: OES 11
* Apache path
/etc/opt/novell/httpd/
conf.d
+ Tomcat path

/var/opt/novell/
tomcat6/webapps

Section 18.3.1, “Deciding Where to
Install the GroupWise Monitor
Components,” on page 160

Web Server Information: SLES 11
+ Apache path

/etc/apache2/conf .d
+ Tomcat path

/usr/share/tomcat6/
webapps

Section 18.3.1, “Deciding Where to
Install the GroupWise Monitor
Components,” on page 160

Web Server Information:
Windows

+ Microsoft Internet Information
Server (IIS) for Windows

+ Path to the web server’s root
directory

* Website

¢:\inetpub\wwwroot

Section 18.3.1, “Deciding Where to
Install the GroupWise Monitor
Components,” on page 160
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19.1

19.2

Installing the GroupWise Client

The following sections assist you with assigning GroupWise accounts to users and with installing the
GroupWise 2014 client.

+ Section 19.1, “GroupWise Client Overview,” on page 175

+ Section 19.2, “GroupWise Client Workstation Requirements,” on page 175

¢ Section 19.3, “Installing the GroupWise Client,” on page 176

¢ Section 19.4, “Starting the Groupwise Client,” on page 179

+ Section 19.5, “What’s Next,” on page 180

For information about client licensing requirements, see “Auditing Mailbox License Usage in the Post
Office” in the GroupWise 2014 Administration Guide.

GroupWise Client Overview

Each user with a GroupWise account has a mailbox in a post office. In a corporate workplace
environment, GroupWise users with Windows workstations can run the GroupWise client to access
their mailboxes and to send and receive mail.

When the users are not at their workstations, they can access their GroupWise mailboxes from a web
browser by using GroupWise WebAccess or on a tablet device by using GroupWise WebAccess
Mobile. See Chapter 16, “Setting Up GroupWise WebAccess,” on page 111.

Users can also synchronize GroupWise data to their mobile devices. See Section 20.1, “Using the
GroupWise Mobility Service to Synchronize GroupWise Data to Mobile Devices,” on page 181.

GroupWise Client Workstation Requirements

+ x86-32 processor or x86-64 processor

On a 64-bit processor, GroupWise still runs as a 32-bit application.
+ Any of the following desktop operating systems for the GroupWise client:
+ Windows XP on a 300 MHz or higher workstation with at least 128 MB of RAM
+ Windows 7 on a 1 GHz or higher workstation with at least 1 GB of RAM
+ Windows 8 or Windows 8.1 on a 1 GHz or higher workstation with at least 1 GB of RAM
+ Microsoft Internet Explorer 9 or later

NOTE: On Windows XP, Microsoft Internet Explorer 8.0 is also supported.

+ Any of the following word processors for use as the GroupWise editor:
+ OpenOffice 3.4 or later
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+ LibreOffice 3.6 or later
+ Microsoft Word 2007 or later

+ Approximately 200 MB of free disk space on each user’s workstation to install the GroupWise
client.

19.3 Installing the GroupWise Client

The GroupWise client software is available in both the Windows version and the Linux version of the
downloaded GroupWise 2014 software image. A simple installation of the GroupWise client helps you
test your GroupWise system as you are setting it up.

If you want, you can burn the GroupWise 2014 software image to DVDs for distribution to GroupWise
client users. Advanced, system-wide rollout methods for the GroupWise client are also available.

+ Section 19.3.1, “Installing the GroupWise Client from the Windows GroupWise 2014 Software
Image,” on page 176

+ Section 19.3.2, “Installing the GroupWise Client from the Linux GroupWise 2014 Software
Image,” on page 178

+ Section 19.3.3, “Implementing System-Wide GroupWise Client Rollouts,” on page 179

19.3.1 Installing the GroupWise Client from the Windows
GroupWise 2014 Software Image

1 Install the GroupWise client software on a Windows workstation that meets the system
requirements listed in Section 19.2, “GroupWise Client Workstation Requirements,” on
page 175.

2 Run the GroupWise Installation Wizard (setup . exe) from the root of the downloaded GroupWise
2014 software image.

Novell. GroupWise.

Documentation

Readme

Quick Start
Installation Guide
Eull Documentation

Installation

GroupWise Server

GroupWise Client

GroupWise WebAccess

GroupWise Calendar Publishing Host
GroupWise Monitor

GroupWise Free/Busy Service
GroupWise MMC Plugin

3 Click GroupWise Client to start the GroupWise Client Setup Wizard.

4 Select the language in which you want to run the GroupWise Client Installation Wizard, then click
OK.

All available languages are automatically installed on the workstation, but you select the specific
language that you want to use for the Installation Wizard.
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The GroupWise Client Installation Wizard appears.

ﬁ Movell GroupWise - Welcome =

Welcome to the InstallShield Wizard for Novell
GroupWise

The InstallShield{R) Wizard will install Novel GroupWise on your
computer. To continue, dick Next.

WARNING: Thiz program is protected by copyright law and
international treaties,

Novell.

< Back [ Next > J [ Cancel

5 Click Next to display the Setup Type dialog box.

‘_‘% MNovell GroupWise - Setup Type L=

Setup Type
Choose the setup type that best suits your needs.

Please select a setup type.

Installshield

(@ Typical

() Custom

H

Movell GroupWise will be installed with the most common options.
Recommended for most users,

Choose which program features you want installed and where they
will be installed. Recommended for advanced users.

< Back ][ Next > J [ Cancel

6 Select one of the following options:

+ Typical: Installs the most commonly used components in the standard installation directory
of c:\Program Files\Novell\Groupwise without prompting for further information.
Review the Custom settings to see which ones are enabled by default.

¢ Custom: Allows you to customize the following GroupWise client functionality:

*

*

*

Languages (select as needed)

Internet Browser Mail Integration (enabled by default)
Program Folder (Novell GroupWise by default)

Add GroupWise to the Desktop (selected by default)
Add GroupWise to Quick Launch (selected by default)
Add Icons to the Start Menu (selected by default)

Add Notify to the Startup folder (disabled by default)

If Notify is not added to the Startup folder, Notify does not automatically run when
Windows starts. Users can control how Notify starts in the GroupWise client. For
instructions, see “Starting Notify” in the GroupWise 2014 Client User Guide.
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See “Using GroupWise Client Custom Installation Options” in the GroupWise 2014
Administration Guide for more information about installing the GroupWise client.

7 Click Next.
8 (Conditional) If you selected Typical or Upgrade:
8a Click Install to install the client files.

When the client Installation Wizard has completed, a shortcut to run GroupWise appears on
your desktop and in the Quick Launch area.

8b Click Finish to exit the GroupWise Installation program.
8c Skip to Section 19.4, “Starting the Groupwise Client,” on page 179.
9 (Conditional) If you selected Custom:
9a Ensure that each component you want to install is selected.
Languages: Select which languages to install.

Internet Browser Mail Integration: Sets GroupWise to be the default email program on
the workstation, so that whenever the user clicks an email link on a web page or chooses
the Mail command in the browser, GroupWise starts.

9b Click Next.
9c¢c Select the Program folder where you want to add the GroupWise icons.
The default is Novell GroupWise.
9d Select whether you want the GroupWise icon added to your Desktop and Quick Launch.
9e Select whether you want GroupWise icons added to the Start menu.
9f Select whether you want Notify added to the Startup folder.

If Notify is not added to the Startup folder, Notify does not automatically run when Windows
starts. Users can control how Notify starts in the GroupWise client. For instructions, see
“Starting Notify” in theGroupWise 2014 Client User Guide.

9g Click Next.
9h Click Install to install the client software files.

When the Installation Wizard has completed, a shortcut to run GroupWise appears on your
desktop.

9i Click Finish to exit the GroupWise Client Installation Wizard.
9j Skip to Section 19.4, “Starting the Groupwise Client,” on page 179.

19.3.2 Installing the GroupWise Client from the Linux GroupWise
2014 Software Image

Install the GroupWise client on a Windows workstation that meets the system requirements listed in
Section 19.2, “GroupWise Client Workstation Requirements,” on page 175. The Linux GroupWise
2014 software image includes the GroupWise client software.

1 On the Linux server where the GroupWise client software is located, set up a Samba share to
provide access to the GroupWise client software.
If you need assistance with this task, follow the instructions for your version of Linux:
+ Section D.1, “Setting up Samba on OES,” on page 249
¢ Section D.3, “Setting Up Samba on SLES,” on page 252
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19.3.3

19.4

2 Install the GroupWise client software on a Windows workstation that meets the system
requirements listed in Section 19.2, “GroupWise Client Workstation Requirements,” on
page 175.

3 On the client workstation, map a drive to the Samba share that you created in Step 1.
If you need assistance with this task, follow the instructions for your version of Linux:

¢ Section D.2, “Mapping a Drive to a Samba Share on an OES Server,” on page 252

+ Section D.4, “Mapping a Drive to a Samba Share on a SLES Server,” on page 254

4 Change to the win32 subdirectory through the Samba share on the Linux server, then run the
GroupWise Client Installation Wizard (setup.exe).

The installation then proceeds normally.

5 Skip to Step 4 in Section 19.3.1, “Installing the GroupWise Client from the Windows GroupWise
2014 Software Image,” on page 176 to continue with the standard GroupWise client installation
process.

Implementing System-Wide GroupWise Client Rollouts

For a system-wide rollout of the GroupWise client software, see “Distributing the GroupWise Client” in
the GroupWise 2014 Administration Guide.

Starting the Groupwise Client

At startup, the GroupWise client needs to know the location (IP address/hostname and port number)
for the user’s post office.

s ~
=} Movell GroupWise Startup @
User name (Required): mpalu
Password:
@ Online Address: 172.16.5.18 Port: 1677
_) Caching mailbox path: i
") Remote mailbox path: fi

The GroupWise client can get the information for the initial login in two ways:

+ The user can provide the post office location when prompted.

+ The GroupWise client can access a GroupWise name server to get the user’s post office
location.

A GroupWise name server is a DNS hostname entry that defines the IP address of a POA.
During startup, the GroupWise client automatically looks for the GroupWise name server in DNS.
The POA identified as the GroupWise name server then redirects the client login to the POA for
the user’s post office. For information about creating a GroupWise name server, see “Post Office
Agent” in the GroupWise 2014 Administration Guide.
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19.5

After the first successful login, the GroupWise client stores the post office location as the default for
future logins. The user is subsequently presented with a simpler Startup dialog box:

[] Use collaboration single sign-on [CAS4]

) GroupWise Password I@

Password:

To start the GroupWise client for the first time:

1 Double-click the GroupWise icon @ on the Windows desktop.
2 Enter the password and post office address information, then click OK.

For more information about logging in, see “Getting Started” in the GroupWise 2014 Client User
Guide.

For information about providing users’ GroupWise passwords automatically, see “Security Options:
Password” in the GroupWise 2014 Administration Guide.

What’s Next

For information about using the features in the GroupWise client, click Help > Help Topics, or Help >
User Guide. The User Guide is also available on the GroupWise 2014 Documentation website (http://
www.novell.com/documentation/groupwise2014/) in HTML and PDF formats.
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20.1

20.2

Using Other Novell Products with
GroupWise

+ Section 20.1, “Using the GroupWise Mobility Service to Synchronize GroupWise Data to Mobile
Devices,” on page 181

+ Section 20.2, “Using Novell Messenger to Provide Secure Instant Messaging for GroupWise
Users,” on page 181

¢ Section 20.3, “Using Novell Vibe to Provide Team Workspaces for GroupWise Users,” on
page 182

Using the GroupWise Mobility Service to
Synchronize GroupWise Data to Mobile Devices

The GroupWise Mobility Service provides data synchronization between GroupWise mailboxes and
mobile devices for synchronizing email, appointments, contacts, tasks, notes, and phone messages.
The GroupWise Mobility Service is fast, reliable and scalable, and supports the latest device
operating systems. For more information, see the GroupWise Mobility 2.0 Documentation website.

To support BlackBerry devices with an operating system earlier than BlackBerry 10.x, use BlackBerry
Enterprise Server for GroupWise.

Using Novell Messenger to Provide Secure Instant
Messaging for GroupWise Users

Novell Messenger is a corporate-based, secure instant messaging solution that supports instant
messaging, presence, and archiving of conversations. The Messenger client integrates with the
GroupWise Groupwise client to provide access to instant messaging features from within the
GroupWise client.

Novell Messenger is installed separately from GroupWise and does not rely on your GroupWise
system. All Messenger information is stored in eDirectory, not in GroupWise databases. For more
information, see:

+ Novell Messenger Documentation website (https://www.novell.com/documentation/
novell_messenger22/)

+ GroupWise and Messenger Quick Start (https://www.novell.com/documentation/groupwise2014/
gw2014_gs_messenger/data/gw2014_qgs_messenger.html)
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20.3 Using Novell Vibe to Provide Team Workspaces
for GroupWise Users

Novell Vibe enhances GroupWise by providing easy document management and document sharing,
team calendars and task lists, workflows, discussion threads, wikis, blogs, RSS feeds, and more.

For more information, see:

+ Novell Vibe 3 Documentation website (http://www.novell.com/documentation/vibe34/)
+ “Novell Vibe” in the GroupWise 2012 Interoperability Guide
The integration procedure is the same in GroupWise 2014 as it was in GroupWise 2012.

+ GroupWise and Vibe Quick Start (https://www.novell.com/documentation/groupwise2014/

gw2014_gs_vibe/data/gw2014_qgs_vibe.html)
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V GroupWise System Upgrade

+ Chapter 21, “What’s New in GroupWise 2014,” on page 185

+ Chapter 22, “Understanding the Upgrade Process,” on page 191

+ Chapter 23, “Preparing Your Existing GroupWise System for the Upgrade,” on page 197
+ Chapter 24, “Installing the GroupWise 2014 Software,” on page 199

+ Chapter 25, “Upgrading the Primary Domain Server,” on page 203

+ Chapter 26, “Upgrading a Secondary Domain Server,” on page 209

+ Chapter 27, “Upgrading a Post Office Server,” on page 217

+ Chapter 28, “Upgrading GroupWise Agents and Applications,” on page 223

+ Chapter 29, “Upgrading Users’ GroupWise Client Software,” on page 229

+ Chapter 30, “Transitioning from ConsoleOne,” on page 231

+ Chapter 31, “Upgrading the GroupWise/Exchange Coexistence Solution,” on page 233
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1 What’s New in GroupWise 2014

*

Section 21.1, “GroupWise Administration Enhancements,” on page 185

*

Section 21.2, “GroupWise Agent Enhancements,” on page 186

*

Section 21.3, “GroupWise User Enhancements,” on page 188

*

Section 21.4, “GroupWise What's New and Tutorial Videos,” on page 190

211 GroupWise Administration Enhancements

+ Simplified Installation and Upgrade: GroupWise software files are quickly laid down by the
GroupWise Installation Wizard. You then perform installation and upgrade tasks in the new web-
based Installation console. You use the Installation console to create a new GroupWise system,
to create domains and post offices on new GroupWise servers, and to upgrade an existing
GroupWise system to GroupWise 2014.

For examples of the new functionality, see Chapter 11, “Creating a Typical GroupWise System,”
on page 71 and Chapter 25, “Upgrading the Primary Domain Server,” on page 203.

+ New Web-Based Administration Tool: The GroupWise Administration console enables you to
perform all required GroupWise administration tasks for which ConsoleOne was used in the
past. Many new and enhanced administrative features are also available. Now you can perform
GroupWise administration anywhere you have a web browser and an Internet connection.

For usage instruction, see Chapter 13, “Working with the GroupWise Administration Console,”
on page 83.

+ Directory-Agnostic Administration: In addition to NetlQ eDirectory, Microsoft Active Directory
can serve as the source of user information for GroupWise accounts. As an additional
alternative, GroupWise users can be created without any directory association. The eDirectory
schema is no longer modified with GroupWise-specific user information and objects. Standard
LDAP access is used with both eDirectory and Active Directory. You can use different directories
for different users in the same post office. You can use different directories for user provisioning
and authentication.

For usage instruction, see LDAP Directories and Servers in the GroupWise 2014 Administration
Guide.

+ Delegated Administration: When you upgrade your GroupWise system to GroupWise 2014, a
GroupWise Super Admin user is created. The Super Admin user can then delegate
administration responsibilities to other GroupWise users to act as administrators on the system,
domain, or post office level.

For usage instructions, see GroupWise Administrators in the GroupWise 2014 Administration
Guide.

+ GroupWise Administration Service: GroupWise administration is now based on the
GroupWise Administration Service that runs on each GroupWise server, along with any
GroupWise agents that have been installed there. The Admin Service provides the
communication between GroupWise servers and the Admin console so that drive mappings and
mounted filesystems are no longer required.

For background information, see Chapter 3, “GroupWise System Architecture,” on page 21.
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21.2

Scriptable Administration: The GroupWise Administration Service is based on the GroupWise
Administration REST API, which allows you to create customized administrative actions through
scripting.

For more information, see the GroupWise for Software Developers website.

Native GroupWise Certificate Authority: You no longer need to purchase commercially signed
certificates in order to secure your GroupWise system with SSL connections between agents.

For more information, see Using a Self-Signed Certificate from the GroupWise Certificate
Authority in the GroupWise 2014 Administration Guide.

Streamlined Client Software Updates: The new Client Auto-Update feature replaces the
software distribution directory for automatically updating GroupWise client software on users’
workstations. The client software is automatically installed to each post office whenever the POA
is updated. The software can be automatically distributed by the POA or by a web server.

For usage instruction, seeUsing Client Auto-Update to Distribute the GroupWise Client Software
in the GroupWise 2014 Administration Guide.

New Administrative Command Line Utility: The GroupWise Administration Utility
(GWAdminUtil) performs the few administrative tasks that cannot be performed in the Admin
console, because they require direct file system access.

Such tasks include:
+ Database maintenance where two databases must be opened simultaneously
+ Agent service management
+ Password management
+ Server certificate management

For details, see Using the GroupWise Administration Utility in the GroupWise 2014
Administration Guide.

Improved Online Help: The online help in the GroupWise Administration console and the agent
consoles now link seamlessly into the GroupWise 2014 Administration Guide, where details
beyond the information in the online help is readily available.

GroupWise Agent Enhancements

All GroupWise agents now use 64-bit architecture. GroupWise web-based applications (WebAccess,
Calendar Publishing Host, and Monitor) can be installed on either 64-bit or 32-bit web servers.

The following sctions provide details on specific enhancements for the GroupWise agents and
applications:

*

*

*

*

*

Section 21.2.1, “Post Office Agent Enhancements,” on page 187
Section 21.2.2, “Message Transfer Agent Enhancements,” on page 187
Section 21.2.3, “Internet Agent Enhancements,” on page 187

Section 21.2.4, “Document Viewer Agent Enhancements,” on page 187

Section 21.2.5, “Monitor Enhancements,” on page 188
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21.21 Post Office Agent Enhancements

+ DVA by Default: The POA always uses the DVA for document conversion. The DVA is installed
along with the other agent software as part of the GroupWise Server component. You can run it
along with the POA on a post office server, or you can run it on a separate server. The Document
Converter Agent (DCA) is no longer used.

+ Peak Value Data: The POA console includes a Peak Value column for client/server performance
data. The data is written to the peak@mmddyy.csv file whenever the values are refreshed. The
file is created in the post_office/oftemp folder.

+ Snapshot Data: The POA provides more accurate performance data and writes the data to a
snap@mmddyy.csv file. The file is created in the post_office/oftemp folder.

+ LDAP Server Pools: The POA console displays LDAP server pools based on the directory
(Novell eDirectory or Microsoft Active Directory) that the LDAP server is associated with. From
the list of LDAP servers in the pool, you can easily check the status of each one.

+ Audit Trail: In Verbose mode, all POA console activities are written to the log file. Search in the
log file for “Web Console” to see the activities.

+ Improved IMAP Functionality: IMAP has been optimized so that the most recent mailbox items
are delivered to IMAP clients first before older items, and so that the items are transferred much
more quickly.

21.2.2 Message Transfer Agent Enhancements

+ User Synchronization with Active Directory: The MTA can perform user synchronization
between GroupWise and Exchange systems.

+ On-Demand Synchronization: In the MTA console, you can start user synchronization
immediately, rather than waiting for a scheduled event.

21.23 Internet Agent Enhancements

+ Increased Stability: Improper encoding of imcoming messages is handled more gracefully.

+ Load Balancing of Relay Hosts: The GWIA cycles through the list of available relay hosts
instead of using the first relay host in the list every time.

+ Improved Spam Tracking: Sender and IP address information on relayed messages and acked
accounts is logged to help track spam.

+ Improved IMAP Functionality: IMAP has been optimized so that the most recent mailbox items
are delivered to IMAP clients first before older items, and so that the items are transferred much
more quickly.

+ Improved Experience for Non-English Speakers: Returned status messages now use
translated text. For example, the Subject line in an Undeliverable Message notification is in the
language of the sender’s GroupWise client.

21.24 Document Viewer Agent Enhancements

+ Log Files for Worker Thread: With logging set to Verbose, the DVA creates a log file for each
worker thread. This helps identify the error when a worker process fails to convert a specific
document into HTML.
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21.2.5 Monitor Enhancements

+ Windows Service: You can now run the Monitor Agent as a Windows service, as an alternative
to running it as a Windows application.

+ More Timely Status Reporting: The Monitor Agent now polls unresponsive agents every 12
seconds, so that it can report promptly when the agent is back up. After the agent is responsive
again, the default polling interval of 5 minutes resumes. This is especially useful when you
reboot a server where GroupWise agents run. You can see more quickly when agents are
running again. If a number of agents are unresponsive, the Monitor Agent continues the 12-
second polling until 80% of the agents are responsive. It then returns to the default polling cycle
to conserve resources.

21.3 GroupWise User Enhancements

+ Section 21.3.1, “GroupWise Client Enhancements,” on page 188
+ Section 21.3.2, “GroupWise WebAccess Enhancements,” on page 189
¢ Section 21.3.3, “GroupWise WebAccess Mobile Enhancements,” on page 189

¢ Section 21.3.4, “Calendar Publishing Enhancements,” on page 189

21.31 GroupWise Client Enhancements

TIP: For demonstrations, seeGroupWise 2014 What's New Videos.

+ New Look and Feel: GroupWise 2014 includes significant improvements to the look and feel of
the GroupWise client.

+ A new light-and-dark interface simplifies the user experience and highlights important fields
and information. The clean, flat layout highlights your data and causes the surrounding
GroupWise structure to blend in.

+ A modern layout and large, easily identifiable icons make features, resources, and folders
more discoverable and intuitive.

+ Many dialogs have been improved or removed to make managing your items easier.

+ A new Options slide-out in the Compose and Received views makes the items you're
composing or editing easier to customize, and allows you to change many important
settings on the fly.

+ Relevancy is used to bring frequently selected features and commands into easy-to-access
locations in the client interface. For example, the new Favorites list, located in the drop-
down menu on the To list, uses relevancy give you access to people you contact often.

For examples, see New Look and Feel in the GroupWise 2014 Client User Guide

+ More Convenient Signatures: Signature management features are now integrated directly into
the compose view to make adding and editing signatures more convenient. In addition, your
default signature now appears in the Compose view if signatures are turned on.

+ Improved Name Completion: Name Completion enhancements in GroupWise 2014 make it
easier to find the contact that you're looking for. For example, when you type characters into the
To, > CC, or BC fields in the Compose view, GroupWise Name Completion now returns results
on the first name, last name, display name, and email address of contacts in your address book
and then displays them in a list format.
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+ Personal/Group Items: To reduce confusion, Posted items are now referred to as Personal
items in GroupWise 2014. In addition, interface enhancements, such as the Options slide-out,
make it easier to manage Group and Personal (formerly Posted) items.

+ Reply Options: Compose options are now more accessible in GroupWise 2014, allowing
greater control over how and who you reply to items in your mailbox.

+ Clearer Month Calendar Display: A bolded date in the calendar view indicates that you have
an appointment with a status of Busy, Out of Office, or Tentative on that day. In previous versions
of GroupWise, a bolded date indicated that an appointment, task, or note was associated with
that day.

+ Finding Folders: Just as it has in previous versions, Find allows you to locate items, contacts,
and more. New in GroupWise 2014, Find now searches and returns folders in the Find results. In
conjunction, you can now hover over the Folder column in the Find Results list, and immediately
see the file path of the folder, which is especially useful for users who have folders with similar
names.

+ Help Improvements: In GroupWise 2014, you can quickly access Help topics with the new
Search Help feature. The Welcome tab, located in the Nav Bar, also provides Help resources for
new and experienced GroupWise users.

21.3.2 GroupWise WebAccess Enhancements

TIP: For demonstrations, see \WebAccess What's New Videos.

+ New Look and Feel: The user interface in GroupWise 2014 WebAccess, which features large,
easily identifiable icons and streamlined access to features, has been updated to match the
clean, flat layout of the GroupWise 2014 client.

+ Auto-Refresh: Your GroupWise Mailbox automatically refreshes as you receive new items in
GroupWise 2014 WebAccess. There is no need to manually refresh WebAccess to check for
new items as in earlier versions.

+ Notification of New Messages: If your computer has audio capabilities, and a GroupWise
WebAccess window is open in your web browser, an audio cue plays when a new item is
received.

21.3.3 GroupWise WebAccess Mobile Enhancements

+ Auto-Refresh: Your GroupWise Mailbox automatically refreshes as you receive new items in
GroupWise 2014 WebAccess Mobile. There is no need to manually refresh WebAccess to check
for new items as in earlier versions.

+ Attachments on iOS Devices: You can attach files to items that you send from Android tablets
or iOS tablets running iOS version 6.0 or higher. You can also download and read attachments
that you receive on either Android or iOS tablets.

+ Broader Device Support: New tablet devices are now supported (Apple iPad 3, Android 4.1x or
later devices, Kindle Fire HD7).

21.3.4 Calendar Publishing Enhancements

+ Private Items: The content of private items is hidden, but the time period for private items is
blocked out.

+ Calendar Display: When you publish your entire main GroupWise Calendar, 365 days in the
future are published. There is no restriction on publishing an entire personal calendar.
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214 GroupWise What’s New and Tutorial Videos

GroupWise 2014 includes a set of What’'s New videos to introduce your experienced GroupWise
users to new and improved features in the GroupWise client and in WebAccess:

+ Client What's New Videos
+ WebAccess What's New Videos

GroupWise 2014 also includes a set of tutorial videos to introduce new GroupWise users to the
basics of using GroupWise as their email client. See GroupWise 2014 Task Tutorial Videos.
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Understanding the Upgrade Process

You can upgrade a GroupWise 8, GroupWise 2012, or GroupWise 2014 system to GroupWise 2014
R2.

IMPORTANT: If you need to upgrade from an older GroupWise version, you must upgrade at least to
GroupWise 8, and preferably to GroupWise 2012, in order to ensure that your GroupWise data is
compatible with the upgrade process that is provided in GroupWise 2014.

If your GroupWise system is still on NetWare, see “Migrating Away from NetWare” in the GroupWise
2012 Installation Guide.

Before you begin upgrading any aspect of your GroupWise system to GroupWise 2014, review the
following sections to help you plan a successful upgrade strategy:
+ Section 22.1, “Domain and Post Office Upgrades,” on page 192
¢ Section 22.2, “Agent Upgrades,” on page 193
¢ Section 22.3, “Monitor Upgrades,” on page 194
+ Section 22.4, “WebAccess Upgrades,” on page 194
¢ Section 22.5, “Calendar Publishing Host Upgrades,” on page 194
¢ Section 22.6, “GroupWise Client Upgrades,” on page 195
+ Section 22.7, “Obsolete eDirectory Schema Extensions,” on page 195
+ Section 22.8, “Obsolete Software Distribution Directories,” on page 195
+ Section 22.9, “Obsolete GroupWise Gateways,” on page 195
¢ Section 22.10, “NetWare Compatibility,” on page 196

IMPORTANT: After you understand the upgrade process in general, you are ready to upgrade
specific components of your existing GroupWise system. Do not start upgrading your GroupWise
system until you have a solid understanding of the entire process.

For a large GroupWise system, you might need to maintain a mixed-version environment as you roll
out GroupWise 2014. For a table showing which GroupWise 8 and GroupWise 2012 components can
be used with GroupWise 2014, see Appendix A, “GroupWise Version Compatibility,” on page 237.

Understanding the Upgrade Process 191


https://www.novell.com/documentation/groupwise2012/pdfdoc/gw2012_guide_install/gw2012_guide_install.pdf#buks0oe
https://www.novell.com/documentation/groupwise2012/pdfdoc/gw2012_guide_install/gw2012_guide_install.pdf#gw2012guideinst
https://www.novell.com/documentation/groupwise2012/pdfdoc/gw2012_guide_install/gw2012_guide_install.pdf#gw2012guideinst

22.1

Domain and Post Office Upgrades

Functionality enhancements in GroupWise 2014 require the GroupWise domain and post office
databases to be upgraded. The following diagram illustrates the required upgrade sequence for
installing the GroupWise 2014 software.

Primary
Domain Server
! (1) Secondary
= Domain Server
Primary . (2]
Domain
- Secondary
Q Domain Post Office
| Server
Post Office Post Office Post Office

1. Upgrade the primary domain server first, so that correct replication of GroupWise 2014
information can take place as you upgrade secondary domains and post offices.

If there are secondary domains or post offices on the primary domain server, you can upgrade

them at the same time as the primary domain, but this is not required.
2. Upgrade secondary domain servers.

If there are multiple secondary domains or post offices on a secondary domain server, you can

upgrade them at the same time, but this is not required.
3. Upgrade post office servers after upgrading the secondary domains that they belong to.

When you install the GroupWise 2014 software on a server where an earlier version of GroupWise is
installed, the Installation Wizard stops the existing agents, installs the GroupWise 2014 software, and

then starts the GroupWise 2014 agents.

IMPORTANT: Upgrading the domain and post office servers does not upgrade the domain and post

office databases. Database upgrades are performed in a separate step.

When you upgrade multiple domains and post office on the same server at the same time, the
Installation console orchestrates the process of upgrading the databases in the proper order.
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22.2 Agent Upgrades

POA POAs are automatically upgraded along with the post offices that they belong to.

The upgrade process looks for POA startup files. If a POA startup file is found, the setting of the --
home switch is verified. If the home folder is valid, the existing POA startup file is used with the
upgraded POA. If the POA startup file cannot be found, or if the home folder is not valid, a new POA
startup file is created in the post office folder. The GroupWise 2014 location for POA startup files is the
post office folder.

If you have been running multiple POAs on multiple servers, the upgrade process cannot upgrade
POAs on remote servers. In GroupWise 2014, the need for running multiple POAs for a post office
does not occur. You can configure the POA that runs on the server where the post office is located to
handle all the needs of the post office.

If your existing POAs have been using the internal Document Converter Agent (DCA) rather than the
independent Document Viewer Agent (DVA), you must run at least on DVA in your GroupWise 2014
system.

For a list of improvements in the GroupWise 2014 POA, see Section 21.2.1, “Post Office Agent
Enhancements,” on page 187.

MTA MTAs are automatically upgraded along with the domains that they belong to.

The upgrade process looks for MTA startup files. If an MTA startup file is found, the setting of the --
home switch is verified. If the home folder is valid, the existing MTA startup file is used with the
upgraded MTA. If the MTA startup file cannot be found, or if the home folder is not valid, a new MTA
startup file is created in the domain folder. The GroupWise 2014 location for MTA startup files is the
domain folder.

For a list of improvements in the GroupWise 2014 MTA, see Section 21.2.2, “Message Transfer Agent
Enhancements,” on page 187.

GWIA  GWIAs are automatically upgraded along with the domains that they belong to.

For a list of improvements in the GroupWise 2014 GWIA, see Section 21.2.3, “Internet Agent
Enhancements,” on page 187.

IMPORTANT: If you are upgrading to GroupWise 2014 from GroupWise 8, you need to understand
the important changes to where GWIA configuration information is stored. See “Using Internet Agent
Startup Switches” in the GroupWise 8 Administration Guide before you upgrade to GroupWise 2014.

DVA Existing DVAs are automatically upgraded along with the POAs that they were installed with.
However, their startup files (gwdva . dva) are not modified. On Linux, the gwha . conf file already has
an entry for each DVA. On Windows, the DVA service is already set up.

If you were not running a DVA in your existing GroupWise system, you must install and configure at
least one DVA in your GroupWise 2014 system.

For a list of improvements in the GroupWise 2014 DVA, see Section 21.2.4, “Document Viewer Agent
Enhancements,” on page 187.
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22.3

22.4

22.5

Monitor Upgrades

GroupWise Monitor is not dependent on any other GroupWise agents, so you can upgrade the
Monitor Agent and the Monitor Application to GroupWise 2014 at any time.

IMPORTANT: If you are upgrading from GroupWise 8 directly to GroupWise 2014, you need to
understand that Monitor no longer relies on eDirectory objects for its configuration information. All
configuration information is located in the gwmonitor.cfg file instead. See “Understanding Monitor
Updates” and “Updating GroupWise Monitor”in the GroupWise 2012 Installation Guide before you
upgrade Monitor from GroupWise 8 directly to GroupWise 2014.

On Linux, the GroupWise High Availability Service (gwha), that works in conjunction with the Monitor
Agent to automatically restart the GroupWise agents, has been made more secure.

WebAccess Upgrades

If you are upgrading from GroupWise 2012 to GroupWise 2014, there are no WebAccess upgrade
issues. You can upgrade your WebAccess software whenever it is convenient as you upgrade your
GroupWise system. However, in order to use the WebAccess Application console, you must change
the way it is configured. For instructions, see “Using the WebAccess Application Console” in the
GroupWise 2014 Administration Guide.

For a list of new features in GroupWise 2014 WebAccess, see Section 21.3.2, “GroupWise
WebAccess Enhancements,” on page 189.

IMPORTANT: If you are upgrading from GroupWise 8 directly to GroupWise 2014, you need to
understand that the WebAccess Agent is no longer part of GroupWise. See “Understanding
WebAccess Updates” and “Updating GroupWise WebAccess” in the GroupWise 2012 Installation
Guide before you upgrade WebAccess from GroupWise 8 directly to GroupWise 2014.

Calendar Publishing Host Upgrades

There are no Calendar Publishing Host upgrade issues. You can upgrade the Calendar Publishing
Host to GroupWise 2014 at any time after the POA that it communicates with has been upgraded.
However, in order to use the CalPub Host Admin console, you must change the way it is configured.
For instructions, see Section 17.5.4, “Setting Up Calendar Publishing Administration,” on page 147.

For a list of improved functionality in the GroupWise 2014 Calendar Publishing Host, see
Section 21.3.4, “Calendar Publishing Enhancements,” on page 189.
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22.6

22.7

22.8

22.9

GroupWise Client Upgrades

After a post office is upgraded to version 2014, users can run the GroupWise 2014 client on
workstations that meet the requirements listed in Chapter 5, “GroupWise User Requirements,” on
page 33. If necessary, they can also continue to run their older GroupWise clients. However, older
clients do not have GroupWise 2014 functionality just because they are accessing mailboxes in a
GroupWise 2014 post office.

IMPORTANT: A user who needs to proxy into another user’s mailbox should not upgrade to the
GroupWise 2014 client until the mailbox owner’s post office has been upgraded to version 2014. The
GroupWise 2014 client cannot proxy into a mailbox that has not been upgraded to GroupWise 2014.

For a list of new features in the GroupWise 2014 client, see Section 21.3.1, “GroupWise Client
Enhancements,” on page 188.

Obsolete eDirectory Schema Extensions

GroupWise 2014 no longer extends the eDirectory schema to accommodate GroupWise-specific
objects. After upgrading domains and post offices to GroupWise 2014, the associated GroupWise
objects in eDirectory are not used by GroupWise 2014.

IMPORTANT: It is not necessary to remove obsolete GroupWise objects from eDirectory. If you want
to remove them, use iManager (recommended) or ConsoleOne (not recommended). If you use
ConsoleOne, remove (or move) the GroupWise snapins first. Otherwise, you run the risk of
inadvertently deleting a GroupWise account. Always back up your domain database before taking
any action.

Obsolete Software Distribution Directories

GroupWise 2014 no longer uses software distribution directories. After you have upgraded post
offices, you can delete the associated software distribution directories in the Admin console.

1 In the GroupWise Admin console, click System > Legacy.
2 Click Software Areas.
3 Select the obsolete software distribution directory, then click Delete.

GroupWise 2014 uses the Client Auto-Update feature instead of software distribution directories. For
usage instructions, see “Using Client Auto-Update to Distribute the GroupWise Client Software” in the
GroupWise 2014 Administration Guide.

Obsolete GroupWise Gateways

There are no known issues with using GroupWise gateways with GroupWise 2014. However,
GroupWise gateways are legacy products that are not supported with the current GroupWise version.
You can delete obsolete gateways in the GroupWise Admin console.

1 In the GroupWise Admin console, click System > Legacy.
2 On the Gateways tab, select the obsolete gateway, then click Delete.
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2210 NetWare Compatibility

196

As of GroupWise 2012, GroupWise does not include GroupWise agents that run on NetWare,
because NetWare has entered the Extended Support phase of the Novell Support Life cycle. For
more information, see TID 7003092, “NetWare Support,” in the Novell Support Knowledgebase (http:/
/www.novell.com/support/).

If you currently have NetWare servers in your GroupWise system, you must decide how to handle
them as you move forward with your GroupWise 2014 upgrade. You have several alternatives:

+ Migrate NetWare servers to Open Enterprise Server (OES).

+ Move domains and post offices from NetWare servers to supported Linux servers.

+ Move domains and post offices from NetWare servers to supported Windows servers.
You might decide to use one or more of these alternatives as you upgrade your GroupWise system to
GroupWise 2014. Detailed instructions for each alternative are provided in “Migrating Away from

NetWare” in the GroupWise 2012 Installation Guide, because GroupWise 2012 is the first version
where NetWare is not supported.
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23 Preparing Your Existing GroupWise
System for the Upgrade

To prepare your GroupWise system to be upgraded to version 2014, complete the following tasks:

O Validate your domain and post office databases to ensure that there are no physical
inconsistencies with the database. If problems exist, you should recover or rebuild the database.
For information about validating, recovering, or rebuilding a database, see the documentation for
your current GroupWise version at the Novell Documentation website (http://www.novell.com/
documentation/#d).

J Back up each domain or post office immediately before upgrading it. For information about
backing up your GroupWise databases, see the documentation for your current GroupWise
version at the Novell Documentation website (http://www.novell.com/documentation/#d).

O Collect the information about your existing GroupWise system that the GroupWise Installation
Wizard prompts you for as you upgrade to GroupWise 2014. You might find it helpful to review
Chapter 8, “Planning Your GroupWise System,” on page 43 and to record the information on the
worksheets provided for an initial installation:

+ “Simple GroupWise System Worksheet” on page 54 (for a small GroupWise system that is
all on one server)

¢ “Primary Domain Worksheet” on page 56 (for a primary domain on its own server)
+ “Secondary Domain Worksheet” on page 57 (for each secondary domain)
+ “Post Office Worksheet” on page 58 (for each post office)

* “GroupWise WebAccess Installation Worksheet” on page 127 (for each WebAccess
Application)

+ “GroupWise Calendar Publishing Host Worksheets” on page 151 (for each Calendar
Publishing Host Application)

+ “GroupWise Monitor Installation Worksheets” on page 172 (for each Monitor Agent/
Application)
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(J Prepare the existing agents for upgrade. The Installation console uses the same agent

configuration for GroupWise 2014 that is in use for your existing GroupWise system. Your
current agent configuration might not be the best option for GroupWise 2014. The GroupWise
2012 Installation Guide provides information for reconfiguring your existing agents in preparation
for the upgrade.

Linux: The Installation console can locate agents that are listed in the gwha . conf file used by the
GroupWise High Availability Service (gwha). For background information, see “Enabling the
GroupWise High Availability Service for the Linux GroupWise Agents” in the GroupWise 2012
Installation Guide.

Also, the Admin console cannot manage agents that run with the user interface provided by
the --show switch. For background information, see “Starting the Linux Agents with a User
Interface” in the GroupWise 2012 Installation Guide.

Windows: The Installation console can locate agents that have been running as Windows services. For
background information, see “Starting the Windows Agents Manually or Automatically as
Services” in the GroupWise 2012 Installation Guide.

Also, the Admin console cannot manage agents that run as applications with a user interface.
For background information, see “Starting the Windows Agents Manually As Applications” in
the GroupWise 2012 Installation Guide.

In preparation for GroupWise 2014, you can configure your existing agents to run without a user
interface, so that the Installation console can automatically locate them, or you can specify the
locations of domains and post offices during the upgrade process.

Ensure that all GroupWise servers meet the system requirements listed in Chapter 4,
“GroupWise Administration Requirements,” on page 27.

When you upgrade the primary domain to GroupWise 2014, you establish the user name and
password for the GroupWise Super Admin. For background information about this administrative
user, see “Primary Domain: Super Admin Creation” on page 48. Decide on the Super Admin
user name and password before you start the upgrade process.

When you upgrade a domain or post office on a Linux server, ensure that the Linux operating
system media is available, either physically or in a repository, in case the Installation Wizard
needs to install supporting packages on the Linux server.

Ensure that all GroupWise client user workstations meet the system requirements listed in
Chapter 5, “GroupWise User Requirements,” on page 33.
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Installing the GroupWise 2014 Software

Before installing the GroupWise 2014 software, review the background information and complete the
tasks in the following sections:

O Chapter 22, “Understanding the Upgrade Process,” on page 191

O Chapter 23, “Preparing Your Existing GroupWise System for the Upgrade,” on page 197

Then follow the installation instructions for the platform where the domain or post office to upgrade is
located.

¢ Section 24.1, “Linux: Installing the GroupWise 2014 Software,” on page 199

+ Section 24.2, “Windows: Installing the GroupWise 2014 Software,” on page 201

241 Linux: Installing the GroupWise 2014 Software

1 Stop the existing GroupWise agents that are running on the server to upgrade.

2 Ensure that the Linux operating system media is available, either physically or in a repository, in
case the Installation Wizard needs to install supporting packages on the Linux server.

3 In a terminal window, become root by entering su - and the root password.

4 Start the GroupWise Installation Wizard at the root of the downloaded GroupWise 2014 software
image:
./install.sh

5 Type the number for the language in which you want to run the GroupWise Installation Wizard,
then press Enter to select OK.

Please select an option:

"Woccimentation

f
|
| 2 Installation
L

“ < Exit =

e —|

6 Type 2 for Installation, then press Enter.
7 Type a to accept the License Agreement and display the Software list.

Please select an option:

| WGroupliise Server]

|2 Groupwise WebAccess

|2 GroupWise Calendar Publishing Host
|4 Groupwise Monitor Agent

\5 GroupWise Monitor Application

Bo3E < Back > < Exit >
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Type 1 for GroupWise Server, then press Enter to display the Actions list.

Please select an option:

| W1nstall]

2 Configure

|
|
|
L

5
|
|
|

]

E! < Back = !

Type 1 for Install, then press Enter to install the GroupWise Server component.

The packages for the GroupWise Server component (Admin Service and agents) are installed on
the server. If any supporting packages are not available on the server, the Installation Wizard
automatically installs them from the operating system media.

When the installation is finished, press any key to return to the Installation Options list.

All of the GroupWise agents are installed on every GroupWise server. The MTA and, optionally,
the GWIA are configured to run on a domain server. The POA and the DVA are configured to run
on a post office server.

The Installation Wizard starts any agents that typically run on the server.

IMPORTANT: Running the GroupWise 2014 agents does not upgrade the GroupWise
databases on the server to GroupWise 2014. Updating the databases is performed in a
subsequent step.

Type 2 for Configure, then press Enter to start the GroupWise Admin Service and display
instructions for accessing the Installation console to upgrade the GroupWise server to
GroupWise 2014.

Right-click the URL under To install or configure a new GroupWise server, then click Open Link
to open your web browser.

If your web browser does not offer this functionality, open your web browser, then copy the URL
into it.

Accept the self-signed certificate that the Installation Wizard has automatically provided for
accessing the Installation console.

Skip to the instructions for the upgrade task that you are performing:
+ Chapter 25, “Upgrading the Primary Domain Server,” on page 203
+ Chapter 26, “Upgrading a Secondary Domain Server,” on page 209
+ Chapter 27, “Upgrading a Post Office Server,” on page 217
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24.2 Windows: Installing the GroupWise 2014 Software

1 Stop the existing GroupWise agents that are running on the server to upgrade.

2 Run setup.exe at the root of the downloaded GroupWise 2014 software image to start the

GroupWise Installation Wizard.

e

Novell GroupWise
Novell. GroupWise. 2014

Documentation

Readme

Quick Start
Installation Guide
Full Documentation

Installation

GroupWise Server

GroupWise Client

GroupWise WebAccess

GroupWise Calendar Publishing Host
GroupWise Monitor

GroupWise Free/Busy Service
GroupWise MMC Plugin

=

3 Click GroupWise Server to install the GroupWise Server component.

4 Select the language in which you want to perform the installation, then click OK to start the

GroupWise Server Setup Wizard.

i Novell GroupWise Server Setup == -
Welcome to the Novell GroupWise Server
e Setup Wizard
Novell. The Setup Wizard will install Novel GroupWise Server on
H your computer. Click Next to continue or Cancel to exit the
(230r1°4u pWISE Setup Wizard,

14.0.0.114938

Back MNext

‘ Cancel

5 Click Next to continue.
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6 Accept the License Agreement, then click Next to display the Custom Setup page.

i) Novell GroupWise Server Setup |;|i-

Custom Setup
Select the way you want features to be installed.

Click the icons in the tree below to change the way features will be installed.

Files for the Post Office (POA),
Meszage Transport (MTA), Internet
Agent (GWIA), Document Viewer
(DVA) and REST agents.

This feature requires 373MB on
your hard drive, It has 1of 1
subfeatures selected. The
subfeatures require 590MB on your
hard drive.

< mn b

Location: C:'\Program Files\Movell\GroupWise Server),
Reset ” Disk Usage | | Back ” Next | | Cancel ‘

The following components are available for installation:

+ GroupWise Server: (Required) Consists of the Admin Service, the POA, the MTA, the
GWIA, and the DVA.

All of the GroupWise agents are installed on every GroupWise server. The MTA and,
optionally, the GWIA are configured to run on a domain server. The POA and the DVA are
configured to run on a post office server.

+ Client Auto-Update Repository: (Optional) Helps you distribute the GroupWise client
software to users’ Windows workstations.

For usage instructions, see “Using Client Auto-Update to Distribute the GroupWise Client
Software” in the GroupWise 2014 Administration Guide.

7 Click Next to continue, then click Install to install the GroupWise software.

8 When the GroupWise software has been installed, click Finish to return to the main page of the
Installation Wizard, then close the Installation Wizard.

9 Reboot the Windows server to complete the installation and start the GroupWise Installation
console.

The Installation Wizard has created two new icons on your Windows desktop.

10 On your Windows desktop, double-click GroupWise Install Eto open your web browser and
access the Installation console.
This starts the GroupWise Admin Service and launches the GroupWise Installation console in
your web browser.
After installation, use GroupWise Admin Console B to access the Admin console for ongoing
GroupWise system administration.

11 Accept the self-signed certificate that the Installation Wizard has automatically provided for
accessing the Installation console.

12 Skip to the instructions for the upgrade task that you are performing:
+ Chapter 25, “Upgrading the Primary Domain Server,” on page 203
+ Chapter 26, “Upgrading a Secondary Domain Server,” on page 209
+ Chapter 27, “Upgrading a Post Office Server,” on page 217
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Upgrading the Primary Domain Server

Before you upgrade the primary domain server, you should have reviewed the following sections and
completed the accompanying tasks:

O Chapter 3, “GroupWise System Architecture,” on page 21

O Chapter 4, “GroupWise Administration Requirements,” on page 27

O Chapter 22, “Understanding the Upgrade Process,” on page 191

O Chapter 23, “Preparing Your Existing GroupWise System for the Upgrade,” on page 197
O Chapter 24, “Installing the GroupWise 2014 Software,” on page 199

After you install the GroupWise 2014 software on the primary domain server, the Installation Wizard
displays the Installation console in your web browser.

Novell. GroupWisa

‘;) Create a New GroupWise System

w Upgrade an Existing Domain or Post Office to GroupWise 2014
0 Add a New Domain

d Add a New Post Office

IMPORTANT: As a security feature, the Installation console times out after one hour. For instructions
to renew the session, see Section 11.4, “Handling an Installation Timeout,” on page 77.

1 In the Installation console, click @l Upgrade an Existing Domain or Post Office to GroupWise
2014.

What displays next depends on whether the Installation console can detect the existing domains
and post offices on the server. The conditions for automatic detection are described in
Chapter 23, “Preparing Your Existing GroupWise System for the Upgrade,” on page 197.
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2 (Conditional) If the Installation console can locate existing domains and post offices:

Upgrade an Existing Domain or Post Office to GroupWise 2014 (7]
B System Settings Add..
': iedentizls Name Folder Admin Port Host Version
summary =
|_T| Accounting lgwsystem/accounting/ 9711 1376567220 1200
Q Orem1 lgwsystemiorem1/ 9710 137.65.67.220 1200

‘ Existing Configuration |

2a (Conditional) If there are any domains and post offices on the primary domain server that
you do not want to upgrade along with the primary domain, select them, then click Remove
to remove them from the list.

2b (Conditional) If you want to change the IP address or Admin port for any domain or post
office, click its name to display the Network Information dialog box.

Orem1 (Primary Domain)

MTA Address: [‘\3?.65.6?.220 ]

Admin Port. | a710|5

)

Specify the desired IP address or Admin port, then click OK.
2c¢ Skip to Step 4 to perform the upgrade.

3 (Conditional) If the Installation console cannot locate existing domains and post offices:

Novell

Upgrade an Existing Domain or Post Office to GroupWise 2014 (7]

% System Settings Add..
(_Zredentlals Name Folder Admin Port Host Version =
Summary S
&
5
=
Add existing domains or post offices to upgrade. E
@
£
]
B
i

3a Click Add.

3b Browse to and select the primary domain folder.

File Browser Close %

GroupWise Server
pre-gwdoc8710

¥ [T gwsystem [+
[ accounting
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3c Click OK, then review the MTA IP address and domain Admin port that the Installation
console has provided.

'd'rern"'ll ('Pf’irnary Domain)

MTA Address: [137.65.67.220 |

Admin Port: | 9710]5

)

3d (Optional) Change the information as needed.
3e Click OK to return to the Installation console.

3f Repeat Step 3a through Step 3e for each additional domain and post office that you want to
upgrade on the primary domain server.

3g Continue with Step 4 to perform the upgrade.
4 In the list of domains and post offices to upgrade, click Next to display the Credentials page.

Novell. C
Upgrade an Existing Domain or Post Office to GroupWise 2014 (7]
System Settings Upgrading the primary domain requires sefting up adminisiralion credentials fo manage the GroupWise sysfem

= Credentials —

» Admin Name [admin | c

Summary =

=

Password | 5

=

=

=

Confirm Password: [ | S

@

=

"

>

L

5 Specify the user name for the GroupWise Super Admin, type the password twice for
confirmation, then click Next to display the Summary page.

Novell. C

Upgrade an Existing Domain or Post Office to GroupWise 2014 (7]
System Seftings g . .
Srerantils roupWise 2012" Upgrade Summary -
» Summary s
Accounting =
I_I POA Address: 137.65.67.220 g,
Admin Port 8711 £
‘ersion: 1200 ‘CJ”
Folder: fgwsystem/accounting/ =
w

e orem1
MTA Address: 137 65.67 220

Admin Fort: 8710
ersion: 1200
Faolder: fgwsystemforem1/
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6 Review the information to ensure that it is correct, then click Finish to perform the upgrade.

Novell. GroupWise

€The service has been configured successfully

Please restart all MTAs and POAs to complete the upgrade process
Yol can now access the GroupWise Administration Consoleto manage your system

| Existing Configuration |

7 Click Go to the GroupWise Administration console now.

8 Accept the self-signed certificate that the Installation console has automatically provided for
accessing the Admin console.

The Login fields display.

User Name

9 Specify the GroupWise Super Admin user name and password that you established in Step 5,
then click Login to display the Overview page in the GroupWise Admin console.

Novell. GroupWise, Administration

admin | Logout

Connected Domain: { Orem] -

| Administration <
ﬁ Overview & oremt
System (=] E MTA
e Domains @ -E GwiA
|'_-'|| Fost Omces (=} .j Accounting

I’-i_o-ll Fuost Office Agents
E Message Transfer Agents

=f= intemet Agents

& Users

&L Groups
B Resources
A Micknames

&i Libraries

To finish the upgrade process, you must restart the MTA for the primary domain. You must also
restart the agents for any other upgraded domains and post offices on the primary domain
server.

If the primary domain has a GWIA, it was also upgraded along with the primary domain and its
MTA. However, you do not need to restart the upgraded GWIA.

IMPORTANT: If you are upgrading from GroupWise 8, see Section 22.2, “Agent Upgrades,” on
page 193 for release-specific information.
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10 To restart the MTA in the upgraded primary domain:

10a In the Domain box on the Overview page, click MTA or click Running ¢ > MTA to display
the MTA properties page.

Novell. GroupWise. Administratior

admin | Logout

Connected Domaln: (Orem = Recentw  Favorites =

Administration < fH Save = Clase 47 ‘
u Overview @orem1 B

System Delete Diagnostics

e Domains (LT 1B Agent Settings § Log Settings | SSL Settings | Scheduled Events Exchange Synchronization
(D post orices AgentType: MTA

Iﬂ Fost Office Agents Description [ Groupwise Message Transfer Agent

E Message Transfer Agents

=‘E Internet Agents Platform: | Linux |

Status. @ Running | Stop Agent
& Users
Launch MTA Console
.iﬂ- Groups Routing Options
-}
§ Resources [overide | pefault Routing Domain:
iR MEhnames Defined at MTA

Nl Libraries

Querride Force all messages to default routing domain

Defined at: MTA

O ovenide [ Allow MTA 1o send directly to other GroupWise systems
Defined at: MTA

10b Click Stop Agent, then click Start Agent to restart the upgraded MTA.
10c (Optional) Click Launch MTA Console to open the MTA console in a new browser window.

TIP: You can conveniently open the MTA console on the Overview page by clicking Running
4, and then clicking the IP address of the MTA.

If the primary domain has a GWIA, it was also upgraded along with the primary domain and
its MTA. However, you do not need to restart the upgraded GWIA.

IMPORTANT: If you are upgrading from GroupWise 8, see Section 22.2, “Agent Upgrades,”
on page 193 for release-specific information.

10d Click Overview to return to the Overview page.

11 (Conditional) If the primary domain server has additional upgraded domains, repeat Step 10 for
the MTA in each upgraded domain.
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12 (Conditional) If the primary domain server has upgraded post offices:

12a In the Domain box on the Overview page, click Running € next to the Post Office icon (],
then click POA to display the POA properties page.

Novell. GroupWise. Administration

Connected Domain: (Qreml = Recent =  Favorites =

& Overview @ orem1 [l Accounting &£ POA
System Delete D\égnost\cs
0 Domains General REGERESIE Log Settings SSL Seftings Scheduled Events QuickFinde|
d FECERNES Agent Type: POA
tﬁ Post Office Agents Descrplion: | Groupwise Post Office Agent
E Message Transfer Agents
=E Internet Agents Platform: | Linux 3|
Status: @ Running ~ Stop Agent
& Users
Launch POA Console
% Groups
! ﬂ Resources f L
& Nicknames
ﬁ Libraries

12b Click Stop Agent, then click Start Agent to restart the upgraded POA.
12¢ (Optional) Click Launch POA Console to open the POA console in a new browser window.

TIP: You can conveniently open the POA console on the Overview page by clicking
Running &%, and then clicking the IP address of the POA.

12d Click Overview to return to the Overview page.

If the post office has a DVA, it was also upgraded along with the post office and its POA.
However, you do not need to restart the upgraded DVA.

13 (Conditional) If the primary domain server has additional post offices, repeat Step 12 for the POA
in each upgraded post office.

14 Skip to the next upgrade task for your GroupWise system:
+ Chapter 26, “Upgrading a Secondary Domain Server,” on page 209
+ Chapter 27, “Upgrading a Post Office Server,” on page 217

*

Section 28.2, “Upgrading GroupWise WebAccess,” on page 223

*

Section 28.3, “Upgrading the Calendar Publishing Host,” on page 225

*

Section 28.4, “Upgrading GroupWise Monitor,” on page 226
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Upgrading a Secondary Domain Server

After you have upgraded the primary domain server in your GroupWise system, you can upgrade
secondary domains in your GroupWise system in any order that is convenient for you.

Before you upgrade a secondary domain server, review the following sections and complete the
accompanying tasks if you have not done so recently:

O Chapter 3, “GroupWise System Architecture,” on page 21

O Chapter 4, “GroupWise Administration Requirements,” on page 27

O Chapter 22, “Understanding the Upgrade Process,” on page 191

O Chapter 23, “Preparing Your Existing GroupWise System for the Upgrade,” on page 197

To upgrade a secondary domain server:

1 Stop the existing GroupWise agents that are running on the server to upgrade.
2 |nstall the GroupWise 2014 software on the secondary domain server.
See Chapter 24, “Installing the GroupWise 2014 Software,” on page 199 for instructions.

When the software installation is complete, the Installation Wizard displays the Installation
console in your web browser.

Novell. GroupWisa

&-l Upgrade an Existing Domatn or Post Office to GroupWise 2014
0 Add a New Domain
d Add a New Post Office

IMPORTANT: As a security feature, the Installation console times out after one hour. For
instructions to renew the session, see Section 11.4, “Handling an Installation Timeout,” on
page 77.

3 In the Installation console, click @ Upgrade an Existing Domain or Post Office to GroupWise
2014.

What displays next depends on whether the Installation console can detect the existing domains
and post offices on the server. The conditions for automatic detection are described in
Chapter 23, “Preparing Your Existing GroupWise System for the Upgrade,” on page 197.
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4 (Conditional) If the Installation console can locate existing domains and post offices:

Upgrade an Existing Domain or Post Office to GroupWise 2014 (7]
% System Settings Add.. || Remove
Credentials § §
= Name Folder Admin Port Haost \Version
=Uummary
e Qremz2 lawsystemioremz 9710 1376567 220 1200
(@] Accounting2 jgwsysterm/accountingz 97711 137 65 67 220 1200

| Existing Configuration |

4a (Conditional) If there are any domains and post offices on the secondary domain server that
you do not want to upgrade, select them, then click Remove.

4b (Conditional) If you want to change the IP address or Admin port for any domain or post
office, click its name to display the Network Information dialog box.

‘Orem2 (Secondary Domain)

MTA Address 137 6567 220 |

Admin Port. | 9710|853
)

Specify the desired IP address or Admin port, then click OK.
4c Skip to Step 6 to perform the upgrade.
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5 (Conditional) If the Installation console cannot locate existing domains and post offices:

Upgrade an Existing Domain or Post Office to GroupWise 2014

% System Settings Add...
Coedoiiis Name Folder Admin Port Host Version
Summary
Add existing domains or post offices to upgrade.
5a Click Add.

5b Browse to and select the secondary domain folder.

File Browser Close ¢

GroupWise Server
pr-gwdoc 8710

\ =T
» [ bin
> [ boot
» [ dev
> [etc
¥ [ gwsystem
¥ [raccounting2

5¢ Click OK, then review the MTA IP address and domain Admin port that the Installation
console has provided.

Orem2 (Secondary Domain) tinse %

NTA Address: (137 6567 220 |

¢ : =
Admin Port: | S710|=5

)

5d (Optional) Change the information as needed.
5e Click OK to return to the Installation console.

5f If you want o upgrade additional domains and post offices on the domain server, repeat
Step 5a through Step 5e.

5g Continue with Step 6 to perform the upgrade.

Upgrading a Secondary Domain Server
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6 In the list of secondary domains, and optionally, post offices to upgrade, click Next to display the
Credentials page.

Novell. GroupWise

Upgrade an Existing Domain or Post Office to GroupWise 2014 Q
System Settings Frovide credeniials fo connect fo the pimary domain. |
= Credentials —
_ Primary Domain MTA Address: | | &
Summary S
Admin Port: | o710|5 =
" L=
=
Admin Name: |admin | =
(]
r o
Password: | | £
o
=
|

7 Specify the IP address of the primary domain server and the password for the GroupWise Super
Admin, then click Next to display the Summary page.

Novell. GroupWise

Upgrade an Existing Domain or Post Office to GroupWise 2014 (7]
System Settings
Grefartals "GroupWise 2012" Upgrade Summary |
% Summary =
Orem2 =
MTA Address: 137 65.67.220 53,,
Admin Port: 9710 £
Version: 1200 "—3’,
Folder: fgwsystem/orem2 £
]

¢ 1 Accounting2

|J POA Address: 137 65,67 220
Admin Port 8711

Version: 1200

Folder: fgwsystem/accounting2

8 Review the information to ensure that it is correct, then click Finish to perform the upgrade.

€The service has been configured successfully

Please restart all MTAs and POAs to complete the upgrade process
Yol can now access the GroupWise Administration Consoleto manage your system

| Existing Configuration |

9 (Optional) Click the Existing Configuration slide-out to list all upgraded domains and post offices.
10 Click Go to the GroupWise Administration console now.

11 Accept the self-signed certificate that the Installation console has automatically provided for
accessing the Admin console.

212  GroupWise 2014 Installation Guide



The Login fields display.

User Name

12 Specify the GroupWise Super Admin user name and password that you established when you
upgraded the primary domain, then click Login to display the Overview page in the Admin
console.

Novell. Group Serin [ Logeu
Connected Domain: { Qrem] = Fecent=  Favorites -
S T
6 Overview a Qrem1 0 Orem2
System @ B via o R v
0 Domains @ -E Gwia @ (@ Accounting2
J Post Offices @ (7] Accounting

Iﬁ_}l Post Office Agents
ﬁ Message Transfer Agents

=f= internet Agents

l Users
% Groups

¥ Resources

& Nicknames

Wil Libraries

To finish the upgrade process, you must restart the agents for all upgraded secondary domains
and post offices on the secondary domain server.

If any secondary domains have GWIAs, they were also upgraded along with the secondary
domains. However, you do not need to restart the upgraded GWIAs.

IMPORTANT: If you are upgrading from GroupWise 8, see Section 22.2, “Agent Upgrades,” on
page 193 for release-specific information.
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13 To restart the MTA in the upgraded secondary domain:

13a In the Domain box on the Overview page, click MTA or click Running ¢ > MTA to display
the MTA properties page.

Novell. GroupWise. Administratior

admin | Logout

Connected Domaln: (Orem = Recentw  Favorites =

Administration < fH Save = Clase 47 ‘
u Overview @orem1 B

System Delete Diagnostics

e Domains (LT 1B Agent Settings § Log Settings | SSL Settings | Scheduled Events Exchange Synchronization
(D post orices AgentType: MTA

Iﬂ Fost Office Agents Description [ Groupwise Message Transfer Agent

E Message Transfer Agents

=‘E Internet Agents Platform: | Linux |

Status. @ Running | Stop Agent
& Users
Launch MTA Console
.iﬂ- Groups Routing Options
-}
§ Resources [overide | pefault Routing Domain:
iR MEhnames Defined at MTA

Nl Libraries

Querride Force all messages to default routing domain

Defined at: MTA

O ovenide [ Allow MTA 1o send directly to other GroupWise systems
Defined at: MTA

13b Click Stop Agent, then click Start Agent to restart the upgraded MTA.
13c (Optional) Click Launch MTA Console to open the MTA console in a new browser window.

TIP: You can conveniently open the MTA console on the Overview page by clicking Running
&4, and then clicking the IP address of the MTA.

If any secondary domains have GWIAs, they were also upgraded along with the secondary
domains. However, you do not need to restart the upgraded GWIAs.

IMPORTANT: If you are upgrading from GroupWise 8, see Section 22.2, “Agent Upgrades,”
on page 193 for release-specific information.

14 (Conditional) If the secondary domain server has additional upgraded domains, repeat Step 13
for the MTA in each upgraded domain.
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15 (Conditional) If the secondary domain server has upgraded post offices:

15a In the Domain box on the Overview page, click Running € next to the Post Office icon (],
then click POA to display the POA properties page.

Novell. GroupWise. Administration

Connected Domain: (Qreml = Recent =  Favorites =

Post Office Agent: POA
& Overview @ orem1 @] Accounting &£ POA
System Delete Diagnostics
@ comens
J Post Offices Agent Type. POA

*ﬂ Post Office Agents Descrplion: | Groupwise Post Office Agent

E Message Transfer Agents

=E Internet Agents Platform: | Linux 3|
Status: @ Running ~ Stop Agent
& Users
Launch POA Console

% Groups

- { -
¥ Resources

& Nicknames
ﬁ Libraries

15b Click Stop Agent, then click Start Agent to restart the upgraded POA.
15¢ (Optional) Click Launch POA Console to open the POA console in a new browser window.

NOTE: You can conveniently open the POA console on the Overview page by clicking
Running &%, and then clicking the IP address of the POA.

If the post office has a DVA, it was also upgraded along with the post office and its POA.
However, you do not need to restart the upgraded DVA.

16 (Conditional) If the secondary domain server has additional post offices, repeat Step 15 for the
POA in each upgraded post office.

17 Skip to the next upgrade task for your GroupWise system:
¢ Chapter 27, “Upgrading a Post Office Server,” on page 217
+ Section 28.2, “Upgrading GroupWise WebAccess,” on page 223
+ Section 28.3, “Upgrading the Calendar Publishing Host,” on page 225
+ Section 28.4, “Upgrading GroupWise Monitor,” on page 226
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Upgrading a Post Office Server

You can upgrade a post office after you have upgraded the domain that owns it.

When the post office is located on the same server with the owning domain, you can upgrade it along
with its domain. See these associated tasks:

O Chapter 25, “Upgrading the Primary Domain Server,” on page 203
O Chapter 26, “Upgrading a Secondary Domain Server,” on page 209

When the post office is on a separate post office server, review the following sections and complete
the accompanying tasks if you have not done so recently:

O Chapter 3, “GroupWise System Architecture,” on page 21

O Chapter 4, “GroupWise Administration Requirements,” on page 27

J Chapter 22, “Understanding the Upgrade Process,” on page 191

J Chapter 23, “Preparing Your Existing GroupWise System for the Upgrade,” on page 197

To upgrade a post office server:

1 Stop the existing GroupWise agents that are running on the server to upgrade.
2 Install the GroupWise 2014 software on the post office server.
See Chapter 24, “Installing the GroupWise 2014 Software,” on page 199 for instructions.

When the software installation is complete, the Installation Wizard displays the Installation
console in your web browser.

Novell. GroupWisa

‘;) Create a New GroupWise System

w Upgrade an Existing Domain or Post Office to GroupWise 2014
0 Add a New Domain

d Add a New Post Office

3 In the Installation console, click @a Upgrade an Existing Domain or Post Office to GroupWise
2014.
What displays next depends on whether the Installation console can detect the existing domains
and post offices on the server. The conditions for automatic detection are described in
Chapter 23, “Preparing Your Existing GroupWise System for the Upgrade,” on page 197.
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4 (Conditional) If the Installation console can locate existing post offices:

Upgrade an Existing Domain or Post Office to GroupWise 2014 (7]
% System Settings Add. | Remove
e Name Folder Admin Port Host Version _
Summary = =
i |_T| Accounting2 fgwsystem/accounting2 arn 137.6567.220 1200 "
&
2
£
s
(8]
@
£
n
F
1}

4a (Conditional) If there are any post offices on the post office server that you do not want to
upgrade, select them, then click Remove.

4b (Conditional) If you want to change the IP address or Admin port for any post office, click its
name to display the NetWork Information dialog box.

.Accountingz (Post Ofﬁce) Close ¢

POA Address: [137.65.67.220 |

Admin Port. | 9711 s
Q L 0K

4c Skip to Step 6 to perform the upgrade.
5 (Conditional) If the Installation console cannot locate existing post offices:

Novell. C

Upgrade an Existing Domain or Post Office to GroupWise 2014 Q

% System Settings Add...
e donid Name Folder Admin Port Host Version =
Summary e
e
5
=
Add existing domains or post offices to upgrade. 5
@
£
=
B
w

5a Click Add.

5b Browse to and select the post office folder.

File Browser Close 5¢

GroupWise Server
prv-gwdoc:2710

\ B =1

» [ bin

» [boot

> [dev

P [etc

¥ [T gwsystem

[ accounting2
g
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5¢ Click OK, then review the POA IP address and post office Admin port that the Installation
console has provided.

'Accounting2 (Post Office) Close %

POA Address: [137.65.67.220

Admin Port: | 97”'3

2] Lok _Jf Cancel J

5d (Optional) Change the information as needed.
5e Click OK to return to the Installation console.

5f (Conditional) If you want to upgrade additional post offices on the post office server, repeat
Step 5a through Step 5e.

5g Continue with Step 6 to perform the upgrade.
6 In the list of post offices to upgrade, click Next to display the Credentials page.

Upgrade an Existing Domain or Post Office to GroupWise 2014 Q@
System Settings Provide credeniials fo connect fo the pimary domain.

& Credentials T
~ — Frimary Domain MTA Address l | E
Summary B

Admin Port: | 9710|s g
o
=

Admin Name: |admin | 5
O
=

Password: \ | £
]
k-
L

7 Specify the IP address of the primary domain server and the password for the GroupWise Super
Admin, then click Next to display the Summary page.

(]

Upgrade an Existing Domain or Post Office to GroupWise 2014

System Settings
Credentials
=% Summary

"GroupWise 2012" Upgrade Summary

Accounting2
l_l POA Address: 137 6567220
Admin Port 28711
‘ersion: 1200
Folder: lgwsystem/accounting2

‘ Existing Configuration |
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8 Review the information to ensure that it is correct, then click Finish to perform the upgrade.

Novell. «

€The service has been configured successfully

Please restart all MTAs and POAs to complete the upgrade process
Yol can now access the GroupWise Administration Consoleto manage your system

| Existing Configuration |

9 (Optional) Click the Existing Configuration slide-out to list all upgraded domains and post offices.
10 Click Go to the GroupWise Administration console now.

11 Accept the self-signed certificate that the Installation console has automatically provided for
accessing the Admin console.

The Login fields display.

User Name

12 Specify the IP address of the primary domain server and the password for the GroupWise Super
Admin, then click Next to display the Summary page.

Novell. G

I iministration ct admin | Logout

omain: { Orem] =

6 Overview a arem o Qremz2
System @B va o R v

e Domains y { GWIA =] |_T| Accounting

|'j| Post Offices @ (] Accounting2

iﬂ FPost Office Agents
E Message Transfer Agents

"E Internet Agents

l Users
% Groups

¥ Resources

; Micknames

ﬁ Libraries

To finish the upgrade process, you must restart the POAs for all upgraded post offices on the
post office server.
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13 To restart the POA in the upgraded post office:

13a In the Domain box on the Overview page, click Running € next to the Post Office icon (],
then click POA to display the POA properties page.

Novell. GroupWise. Administrat

Connected Domain: (Qreml = Recent = Favorites =

Post Office Agent: POA
& Overview @ orem1 @] Accounting &£ POA
System Delete D\'agno'st\'cs
@ comens
J FECERNES Agent Type: POA

@ Post Office Agents Descrplion: | Groupwise Post Office Agent

E Message Transfer Agents

=E Internet Agents Platform: | Linux 3|
Status: @ Running ~ Stop Agent
& Users
Launch POA Console
% Groups .
'ﬂ Resources - G g
A Nicknames
ﬁ Libraries

13b Click Stop Agent, then click Start Agent to restart the upgraded POA.
13c (Optional) Click Launch POA Console to open the POA console in a new browser window.

NOTE: You can conveniently open the POA console on the Overview page by clicking
Running &%, and then clicking the IP address of the POA.

14 (Conditional) If the post office server has additional upgraded post offices, repeat Step 13 for the
POA in each upgraded post office.

15 Skip to the next upgrade task for your GroupWise system:
+ Section 28.2, “Upgrading GroupWise WebAccess,” on page 223
¢ Section 28.3, “Upgrading the Calendar Publishing Host,” on page 225
+ Section 28.4, “Upgrading GroupWise Monitor,” on page 226
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28.1

28.2

Upgrading GroupWise Agents and
Applications

*

Section 28.1, “Upgrading the Document Viewer Agent,” on page 223

*

Section 28.2, “Upgrading GroupWise WebAccess,” on page 223

*

Section 28.3, “Upgrading the Calendar Publishing Host,” on page 225

*

Section 28.4, “Upgrading GroupWise Monitor,” on page 226

*

Section 28.5, “Implementing SSL Encryption,” on page 227

Upgrading the Document Viewer Agent

DVAs on the same servers with POA are automatically upgraded along with the POAs. The following
situations require additional upgrade actions:

+ If you installed additional DVAs on other servers, you must manually upgrade them. Stop the
existing DVA, then install and set up the GroupWise 2014 DVA. For instructions, see “Scaling
Your DVA Installation” in the GroupWise 2014 Administration Guide.

+ |f you were not using the DVA in your existing GroupWise system, you must run at least one DVA
in your GroupWise 2014 system. For instructions, see “Installing the DVA” in the GroupWise
2014 Administration Guide.

In all cases, in order to make the DVA appear in the Admin console, you must manually add a DVA
object. For instructions, see “Setting Up the DVA” in the GroupWise 2014 Administration Guide.

Upgrading GroupWise WebAccess

After you have upgraded a domain and a post office to GroupWise 2014, you can upgrade
WebAccess for that domain and post office. For information about upgrade issues that you should
consider, see Section 22.4, “WebAccess Upgrades,” on page 194.

IMPORTANT

+ Any post office that is accessed by WebAccess must be upgraded before you upgrade your
WebAccess application.

+ The POA that the GroupWise 2014 WebAccess Application communicates with must be
configured for SOAP. A secure SSL connection between the POA and the WebAccess
Application is highly recommended.

¢ Section 28.2.1, “Preparing to Upgrade the WebAccess Application,” on page 224
+ Section 28.2.2, “Installing the GroupWise 2014 WebAccess Application,” on page 224

+ Section 28.2.3, “Clearing User Browser Caches to Display GroupWise 2014 WebAccess
Correctly,” on page 225

Upgrading GroupWise Agents and Applications 223


https://www.novell.com/documentation/groupwise2014/pdfdoc/gw2014_guide_admin/gw2014_guide_admin.pdf#admdvascale
https://www.novell.com/documentation/groupwise2014/pdfdoc/gw2014_guide_admin/gw2014_guide_admin.pdf#admdvascale
https://www.novell.com/documentation/groupwise2014/pdfdoc/gw2014_guide_admin/gw2014_guide_admin.pdf#adminfront
https://www.novell.com/documentation/groupwise2014/pdfdoc/gw2014_guide_admin/gw2014_guide_admin.pdf#admdvascaleinstalls
https://www.novell.com/documentation/groupwise2014/pdfdoc/gw2014_guide_admin/gw2014_guide_admin.pdf#adminfront
https://www.novell.com/documentation/groupwise2014/pdfdoc/gw2014_guide_admin/gw2014_guide_admin.pdf#adminfront
https://www.novell.com/documentation/groupwise2014/pdfdoc/gw2014_guide_admin/gw2014_guide_admin.pdf#admdvascalesetup
https://www.novell.com/documentation/groupwise2014/pdfdoc/gw2014_guide_admin/gw2014_guide_admin.pdf#adminfront

28.2.1

28.2.2

Preparing to Upgrade the WebAccess Application

If you are upgrading from GroupWise 2012 to GroupWise 2014, there are no WebAccess upgrade
issues. You can upgrade your WebAccess software whenever it is convenient as you upgrade your
GroupWise system. However, in order to use the WebAccess Application console, you must change
the way it is configured. For instructions, see “Using the WebAccess Application Console” in the
GroupWise 2014 Administration Guide.

For a list of new features in GroupWise 2014 WebAccess, see Section 21.3.2, “GroupWise
WebAccess Enhancements,” on page 189.

IMPORTANT: If you are upgrading from GroupWise 8 directly to GroupWise 2014, you need to
understand that the WebAccess Agent is no longer part of GroupWise. See “Understanding
WebAccess Updates” and “Updating GroupWise WebAccess” in the GroupWise 2012 Installation
Guide before you upgrade WebAccess from GroupWise 8 directly to GroupWise 2014.

Installing the GroupWise 2014 WebAccess Application

1 (Conditional) If you are upgrading from GroupWise 8:

1a Prepare the POA to work successfully with the WebAccess Application, as described in the
following sections in “Post Office Agent” in the GroupWise 2014 Administration Guide:

+ “Supporting SOAP Clients”
+ “Securing the Post Office with SSL Connections to the POA”
1b Stop the existing WebAccess Agent.

2 (Conditional) On Linux, stop Tomcat.

OES 11: rcnovell-tomcat6 stop
SLES 11: rctomcaté stop

On Windows, the Installation Wizard does this for you.

3 To upgrade WebAccess to GroupWise 2014, follow the standard installation instructions in
Chapter 16, “Setting Up GroupWise WebAccess,” on page 111.

IMPORTANT: If more than one web-based GroupWise component (WebAccess, Calendar
Publishing Host, and/or Monitor) is installed on the same server, you must upgrade all web-
based GroupWise components at the same time. After one existing web-based component has
been upgraded to GroupWise 2014, other web-based components on the server do not work
until they also are upgraded to GroupWise 2014.

4 Reconfigure the WebAccess Application console.

For instructions, see “Enabling the WebAccess Application Console” in the GroupWise 2014
Administration Guide.

5 (Conditional) If you are upgrading from GroupWise 8, complete the steps in “Cleaning Up the
WebAccess Server after Updating to GroupWise 2012” and “Updating Access Control for
WebAccess Users” in the GroupWise 2012 Installation Guide.

6 Continue with Clearing User Browser Caches to Display GroupWise 2014 WebAccess Correctly.
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28.2.3

28.3

28.3.1

Clearing User Browser Caches to Display GroupWise 2014
WebAccess Correctly

After you have upgraded the WebAccess Application to GroupWise 2014, notify your GroupWise
WebAccess users that they should clear their browser caches before logging into their mailboxes with
the upgraded version of GroupWise WebAccess. If old GroupWise WebAccess files are used from
users’ browser caches, they might not be compatible with the upgraded files from the web server. The
results can be unpredictable and undesirable.

Upgrading the Calendar Publishing Host

There are no Calendar Publishing Host upgrade issues. You can upgrade the Calendar Publishing
Host to GroupWise 2014 at any time after the POA that it communicates with has been upgraded.
However, in order to use the CalPub Host Admin console, you must change the way it is configured.
For instructions, see Section 17.5.4, “Setting Up Calendar Publishing Administration,” on page 147.

For a list of improved functionality in the GroupWise 2014 Calendar Publishing Host, see
Section 21.3.4, “Calendar Publishing Enhancements,” on page 189.

+ Section 28.3.1, “Installing the GroupWise 2014 Calendar Publishing Host Application,” on
page 225

+ Section 28.3.2, “Clearing User Browser Caches to Display Published Calendars Correctly,” on
page 226

Installing the GroupWise 2014 Calendar Publishing Host
Application

1 (Conditional) On Linux, stop Tomcat.

OES 11: rcnovell-tomcaté stop
SLES 11: rctomcat6 stop

On Windows, the Installation Wizard does this for you.

2 To upgrade the Calendar Publishing Host to GroupWise 2014, follow the standard installation
instructions in Chapter 17, “Setting Up the GroupWise Calendar Publishing Host,” on page 129.

IMPORTANT: If more than one web-based GroupWise component (WebAccess, Calendar
Publishing Host, and/or Monitor) is installed on the same server, you must upgrade all web-
based GroupWise components at the same time. After one existing web-based component has
been upgraded to GroupWise 2014, other web-based components on the server do not work
until they also are upgraded to GroupWise 2014.

3 Reconfigure the CalPub Host Admin console.

For instructions, see Section 17.5.4, “Setting Up Calendar Publishing Administration,” on
page 147.

4 (Conditional) If you are upgrading from GroupWise 8, complete the steps in “Cleaning Up the
Calendar Publishing Host Server after Updating to GroupWise 2012” in the GroupWise 2012
Installation Guide.

5 Continue with Clearing User Browser Caches to Display Published Calendars Correctly.
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28.3.2 Clearing User Browser Caches to Display Published
Calendars Correctly

After you have upgraded the Calendar Publishing Host Application to GroupWise 2014, notify your
GroupWise users that they should clear their browser caches before accessing published calendars.
If old Calendar Publishing files are used from users’ browser caches, they might not be compatible
with the upgraded files from the web server. The results can be unpredictable and undesirable.

External users of published calendars might not see some aspects of the GroupWise 2014 Calendar
Publishing interface until after they clear their browser caches.

28.4 Upgrading GroupWise Monitor

After you have upgraded at least one domain to GroupWise 2014, you can upgrade GroupWise
Monitor. For information about upgrade issues that you should consider, see Section 22.2, “Agent
Upgrades,” on page 193.

+ Section 28.4.1, “Preparing to Upgrade GroupWise Monitor,” on page 226

+ Section 28.4.2, “Installing the Monitor Software,” on page 226

+ Section 28.4.3, “Clearing Browser Caches to Display GroupWise 2014 Monitor Correctly,” on
page 227

+ Section 28.4.4, “Reconfiguring the GroupWise High Availability Service,” on page 227

28.41 Preparing to Upgrade GroupWise Monitor

GroupWise Monitor is not dependent on any other GroupWise agents, so you can upgrade the
Monitor Agent and the Monitor Application to GroupWise 2014 at any time.

IMPORTANT: If you are upgrading from GroupWise 8 directly to GroupWise 2014, you need to
understand that Monitor no longer relies on eDirectory objects for its configuration information. All
configuration information is located in the gwmonitor.cfg file instead. See “Understanding Monitor
Updates” and “Updating GroupWise Monitor’in the GroupWise 2012 Installation Guide before you
upgrade Monitor from GroupWise 8 directly to GroupWise 2014.

28.4.2 Installing the Monitor Software

1 Stop the existing Monitor Agent.
2 (Conditional) On Linux, stop Tomcat.

OES 11: rcnovell-tomcaté stop
SLES 11: rctomcaté6 stop

On Windows, the Installation Wizard does this for you.

3 To upgrade Monitor to GroupWise 2014, follow the standard installation instructions in
Chapter 18, “Setting Up GroupWise Monitor,” on page 155.
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28.4.3

28.4.4

28.5

IMPORTANT: If more than one web-based GroupWise component (WebAccess, Calendar
Publishing Host, and/or Monitor) is installed on the same server, you must upgrade all web-
based GroupWise components at the same time. After one existing web-based component has
been upgraded to GroupWise 2014, other web-based components on the server do not work
until they also are upgraded to GroupWise 2014.

4 Restart all GroupWise services on the server.

5 (Conditional) If you are upgrading from GroupWise 8, complete the steps in “Cleaning Up the
Monitor Server after Updating to GroupWise 2012” in the GroupWise 2012 Installation Guide.

6 Continue with Clearing Browser Caches to Display GroupWise 2014 Monitor Correctly.

Clearing Browser Caches to Display GroupWise 2014
Monitor Correctly

After you have upgraded the Monitor Application to GroupWise 2014, clear your browser cache
before accessing the upgraded version of GroupWise Monitor. If old GroupWise Monitor files are
used from users’ browser caches, they might not be compatible with the upgraded files from the web
server. The results can be unpredictable and undesirable.

Reconfiguring the GroupWise High Availability Service

On Linux, the GroupWise High Availably Service (gwha), that works in conjunction with GroupWise
Monitor to automatically restart the Linux GroupWise agents, now requires an additional file. The
gwha .allow file lists the user that the High Availability Service uses to log in to the Monitor Agent.
This file increases the security of the interaction between the High Available Service and the Monitor
Agent. For setup instructions, see Step 3 in “Creating a GroupWise High Availability Service User” on
page 99.

Implementing SSL Encryption

If you have not yet implemented SSL in your GroupWise system, you can now easily generate self-
signed certificates by using the native GroupWise certificate authority (CA). For instructions, see
“Using a Self-Signed Certificate from the GroupWise Certificate Authority” in the GroupWise 2014
Administration Guide.
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Upgrading Users’ GroupWise Client
Software

After a post office is upgraded to GroupWise 2014, users who have accounts in that post office can
start using the GroupWise 2014 clients. You can give users access to a GroupWise 2014 software
image, so that they can install the GroupWise client themselves, or you can use the other methods of
client software distribution described in “Distributing the GroupWise Client” in the GroupWise 2014

Administration Guide.

The GroupWise 2014 client is available as part of the Linux GroupWise 2014 software image. For
more information about installing the GroupWise 2014 client from a Linux server, see Section 19.3.2,
“Installing the GroupWise Client from the Linux GroupWise 2014 Software Image,” on page 178.
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Transitioning from ConsoleOne

Use the table below to learn how to perform familiar ConsoleOne tasks in the GroupWise Admin

console.

Task

ConsoleOne Functionality

Admin Console Functionality

Locate a domain or post
office to edit its properties.

Locate a user to edit its
properties.

Locate an agent to edit its
properties.

Perform GroupWise system
operations.

Use the eDirectory View to browse the
eDirectory tree structure to find the
Domain or Post Office object.

or

Use the GroupWise View to list the
Domain or Post Office objects in your
GroupWise system.

Use the eDirectory View to browse the
eDirectory tree structure to find the
User object.

or

Use the GroupWise View to list the
User objects in your GroupWise
system.

Use the eDirectory View to browse the
eDirectory tree structure to find the
agent object.

or

Use the GroupWise View to list the
agent objects in your GroupWise
system.

Click Tools > GroupWise System
Operations.

Click Domains or Post Offices in the
Administration panel to list the Domain
or Post Office objects in your
GroupWise system.

or

Click the domain or post office on the
System Overview page.

or

Type the name of the domain or post
office in the Global Search field.

Click Users in the Administration panel
to list the User objects in your
GroupWise system.

or

Type the user’s first name, last name,
GroupWise user name, email address,
or file ID (FID) in the Global Search
field.

Click the agent type in the
Administration panel to list the agent
objects of that type in your GroupWise
system.

or

Click the agent on the System Overview
page.

or

Type the agent’s IP address in the
Global Search field.

Click System in the Administration
panel.

or

Type the name of the GroupWise
system tool in the Global Search field.
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Task ConsoleOne Functionality Admin Console Functionality
Run GroupWise utilities. Click Tools > GroupWise Utilities. Click System in the Administration
panel.
or
Type the name of the GroupWise
system tool in the Global Search field.
Perform database Browse to and select a Domain or Post Display the properties of a domain or
maintenance. Office object, then click Tools > post office, then click Maintenance >

GroupWise Utilities > System
Maintenance.

Perform Mailbox/Library Browse to and select a Post Office or

Maintenance. User object, then click Tools >
GroupWise Utilities > System
Maintenance.

Set Client Options. Browse to and select a Domain, Post
Office, or User object, then click Tools
> GroupWise Utilities > Client Options.

System Maintenance.

Display the properties of a post office or
user, then click Maintenance > Mailbox/
Library Maintenance.

Display the properties of a domain, post
office, or user, then click Client Options.

If parts of your GroupWise system are still running legacy GroupWise agents, you should continue to
use the legacy ConsoleOne and its snap-ins to administer the legacy parts of your GroupWise
system. For convenience, you can safely run the GroupWise 2012 ConsoleOne and snap-ins on most
of the legacy parts of your GroupWise system. However, the GroupWise 2012 snap-ins do not
support specific legacy GroupWise functionality, such as the WebAccess Agent and its eDirectory

objects, which no longer exist in GroupWise 2012.

When you are in the GroupWise 2014 Admin console, you can easily see which agents have not yet
been upgraded. Legacy agents that have not yet been upgraded to GroupWise 2014 are marked with

their GroupWise version.
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Upgrading the GroupWise/Exchange
Coexistence Solution

If you installed the GroupWise/Exchange Coexistence solution in your GroupWise 2012 system, you
must follow the instructions in “Configuring the MTA for Address Book Synchronization” in the
GroupWise/Exchange Coexistence Guide after you upgrade the MTA that synchronizes users
between GroupWise and Exchange. This enables you to see the external GroupWise objects in the
GroupWise Admin console.

No other changes to GroupWise or Exchange are required to continue using the GroupWise/
Exchange Coexistence solution with your GroupWise 2014 system.
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+ Appendix B, “Attributes, Operators, and Values for Object Filters,” on page 243
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page 247

+ Appendix D, “Cross-Platform Connections,” on page 249
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A1

A11

GroupWise Version Compatibility

Use the tables in this section to determine compatibility among the following GroupWise versions:

+ Section A1, “GroupWise 2014 with Earlier GroupWise Versions,” on page 237
+ Section A.2, “GroupWise 2014 in a Cross-Platform Environment,” on page 240

For each GroupWise version, the tables indicate compatibility for:

+ Administrative components: Domain and post office database platforms and versions,
eDirectory platforms, and GroupWise snap-ins to ConsoleOne platforms and versions.

+ Agents: Domain and post office database platforms and versions, agent platforms and versions.

+ Clients: Post office directory platforms and access, POA platforms and versions, client modes.

In the compatibility tables, cells with combinations that are not applicable are marked N/A. For
example, the POA never communicates with the Internet Agent, so that table cell is N/A.

For information about what operating system versions are supported for GroupWise 2014 on Linux
and Windows, refer to “GroupWise System Requirements” on page 25. For information about earlier
versions of GroupWise, refer to:

+ GroupWise 2012 Installation Guide
+ GroupWise 8 Installation Guide

GroupWise 2014 with Earlier GroupWise Versions

Select the GroupWise version that you want to determine GroupWise 2014 compatibility with:

+ Section A.1.1, “Compatibility with GroupWise 2012,” on page 237
+ Section A.1.2, “Compatibility with GroupWise 8,” on page 239

Compatibility with GroupWise 2012

+ “GroupWise 2014 Administrative Components with GroupWise 2012” on page 237
* “GroupWise 2014 Agents with GroupWise 2012” on page 238
+ “GroupWise 2014 Clients and POAs with GroupWise 2012” on page 238

GroupWise 2014 Administrative Components with GroupWise 2012

GroupWise 2014 GroupWise 2012 GW 2012 Objects in ConsoleOne + GW 2012
Components Domain and Post Office eDirectory Snap-Ins

Databases
GW 2014 Domain and Post N/A N/A Not Supported

Office Databases

GW 2014 Admin Console Supported Not Supported Not Supported
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Table Summary: The GroupWise Admin console can be used to access GroupWise 2012 databases
for domains and post offices, but GroupWise 2012 ConsoleOne with the GroupWise snap-ins should
not be used to access GroupWise 2014 databases. The Admin console does not access GroupWise
eDirectory objects. You must continue to use ConsoleOne with the GroupWise snap-ins to access
GroupWise objects in eDirectory.

GroupWise 2014 Agents with GroupWise 2012

GroupWise GW 2012 GW 2012 GW 2012 GW 2012 GW 2012

. 2012 Domain POA MTA GWIA DVA Monitor
GroupWise 2014 and Post Agent
Agents Office

Databases
GW 2014 Domain N/A Not Not Not N/A N/A
and Post Office Supported  Supported Supported
Databases
GW 2014 POA Supported N/A Supported N/A Supported Supported
GW 2014 MTA Supported Supported  Supported N/A N/A Supported
GW 2014 GWIA  Supported N/A Supported N/A N/A Supported
GW 2014 DVA N/A Supported  N/A N/A N/A N/A
GW 2014 Monitor N/A Supported  Supported Supported N/A N/A
Agent

Table Summary: GroupWise 2012 agents cannot access domain and post office databases that
have been upgraded to GroupWise 2014. When a GroupWise 2014 MTA or POA accesses an earlier
GroupWise database, it has no effect on the database. You must use the Installation console to
upgrade domain and post office databases to GroupWise 2014.

GroupWise 2014 Clients and POAs with GroupWise 2012

GroupWise 2012 Client GroupWise 2012 POA
GroupWise 2014 Client N/A Not Supported
GroupWise 2014 POA Supported N/A

Table Summary: The GroupWise 2012 client can communicate with the GroupWise 2014 POA, but
the GroupWise 2014 client cannot communicate with the GroupWise 2012 POA. The general rule is
that earlier GroupWise clients can always communicate with later POAs, but later GroupWise clients
cannot communicate with earlier POAs.
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A1.2

Compatibility with GroupWise 8

IMPORTANT: Support for GroupWise 8 has ended. The information below is provided for your
convenience. Some of the options listed below may not work as expected. Use at your own risk.

+ “GroupWise 2014 Administrative Components with GroupWise 8” on page 239
+ “GroupWise 2014 Agents with GroupWise 8” on page 239
+ “GroupWise 2014 Client with GroupWise 8” on page 240

GroupWise 2014 Administrative Components with GroupWise 8

GroupWise 2014 GroupWise 8 Domain GW 8 Objects in ConsoleOne + GW 8
Components and Post Office eDirectory Snap-Ins

Databases
GW 2014 Domain and Post  N/A N/A Not Supported

Office Databases

GW 2014 Admin Console Supported Not Supported Not Supported

Table Summary: The GroupWise Admin console can be used to access GroupWise 8 databases for
domains and post offices, but GroupWise 8 ConsoleOne with the GroupWise snap-ins should not be
used to access GroupWise 2014 databases. The Admin console does not access GroupWise
eDirectory objects. You must continue to use ConsoleOne with the GroupWise snap-ins to access
GroupWise objects in eDirectory.

GroupWise 2014 Agents with GroupWise 8

GroupWise8 GW 38 POA GWS8MTA GW S8 GWIA GW 8 GW 38
G Wise 2014 Domain and WebAccess Monitor
ArouFt’ Ise Post Office Agent Agent

gents Databases

GW 2014 Domain N/A Not Not Not Supported N/A N/A
and Post Office Supported  Supported
Databases
GW 2014 POA Supported N/A Supported N/A N/A Supported
GW 2014 MTA Supported Supported  Supported Supported N/A Supported
GW 2014 GWIA  Supported N/A Supported N/A N/A Supported
GW 2014 DVA N/A N/A N/A N/A N/A N/A
GW 2014 Monitor N/A Supported  Supported Supported N/A N/A
Agent

Table Summary: GroupWise 8 agents cannot access domain and post office databases that have
been upgraded to GroupWise 2014. When a GroupWise 2014 MTA or POA accesses an earlier
GroupWise database, it has no effect on the database. You must use the Installation console to
upgrade domain and post office databases to GroupWise 2014.
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A.2

A.2.1

A.2.2

The Document Viewer Agent (DVA) was introduced in GroupWise 2012 and so does not interact with
any GroupWise 8 agents. The WebAccess Agent that was part of GroupWise 8 was eliminated in
GroupWise 2012.

GroupWise 2014 Client with GroupWise 8

GroupWise 8 Client GroupWise 8 POA
GroupWise 2014 Client N/A Not Supported
GroupWise 2014 POA Supported N/A

Table Summary: The GroupWise 8 Windows client can communicate with the GroupWise 2014
POA, but the GroupWise 2014 client cannot communicate with the GroupWise8 POA. The general
rule is that earlier GroupWise clients can always communicate with later POAs, but later GroupWise
clients cannot communicate with earlier POAs.

GroupWise 2014 in a Cross-Platform Environment

+ Section A.2.1, “GroupWise 2014 Administrative Components and Databases,” on page 240
¢ Section A.2.2, “GroupWise 2014 Agents on Linux and Windows,” on page 240

GroupWise 2014 Administrative Components and
Databases

Thanks to the web-based nature of the GroupWise Admin console, it does not matter what platform
GroupWise databases and agents are on, or where your browser is running, they successfully
communicate.

GroupWise 2014 Agents on Linux and Windows

GroupWise 2014 GroupWise GW 2014 GW 2014 GW 2014 GW 2014 GW 2014

on Linux Agents 2014 Domain POA on MTA on GWIA on DVA on Monitor
or Post Office Windows Windows Windows Windows Agent on
Databases on Windows
Windows

GW 2014 Domain  N/A Not Not N/A N/A N/A

and Post Office Supported Supported

Databases on

Linux

GW 2014 POAon Not Supported N/A Supported N/A Supported Supported

Linux

GW 2014 MTA on Not Supported Supported Supported Supported N/A Supported

Linux

GW 2014 GWIAon N/A N/A Supported N/A N/A Supported

Linux
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GroupWise 2014 GroupWise GW 2014 GW 2014 GW 2014 GW 2014 GW 2014

on Linux Agents 2014 Domain POA on MTA on GWIA on DVA on Monitor
or Post Office Windows Windows Windows Windows Agent on
Databases on Windows
Windows

GW 2014 DVAon N/A Supported N/A N/A N/A N/A

Linux

GW 2014 Monitor N/A Supported Supported Supported N/A N/A

Agent on Linux

Table Summary: Domains and post offices can be located on Linux or Windows. Run the version of
the GroupWise agents that matches the platform where the domains and post offices are located.

Agents on either platform can communicate with other agents regardless of platform.

GroupWise Version Compatibility
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B.1

Attributes, Operators, and Values

for Object Filters

In general terms, a filter selects data. In any list of objects, you can use a filter in the Search field to

select and list GroupWise object data based on object attributes and operators.

+ Section B.1, “Attributes,” on page 243

+ Section B.2, “Logical Operators,” on page 244

+ Section B.3, “Grouping Operators,” on page 245
+ Section B.4, “Wildcard Characters,” on page 245
+ Section B.5, “Literal Values,” on page 245

+ Section B.6, “Date Specifications,” on page 246

Attributes

To list the attributes that you can filter on for any object type, press Ctrl-Spacebar in the Search field

of the object list. Common attributes that you might want to filter on include the following:

Object

Common Attributes

Domain

Post Office

User

POA

domainversion
lockoutoldadmin
minimumadminreleasedate
minimumadminreleaseversion

clientlockout
clientlockoutdate
clientlockoutversion
disabledlogins
intruderdetection
postofficeversion

allowedaddressformats
lastclientlogintime
logindisabled
mailboxicensetype
mailboxsizemb
preferredemailid
visibility
clientserverthreads
imapenabled
maintenancehandlerthreads
messagehandlerthreads
soapenabled

Attributes, Operators, and Values for Object Filters
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Object Common Attributes

MTA defaultroutingdomain
loglevel
platform
syncldapservername
trackadminmessages

For an exhaustive list of attributes and their possible values, display the following URL on the Admin
Service server:

https://admin service address:9710/gwadmin-service/list/object type/schema

Replace admin service address with the IP address or DNS hostname of a server where the
Admin Service is installed.

Replace object type with any of the following object types, depending on what you want to list:

¢ domain

+ post_office
* user

¢ group

* resource
+ nickname
¢ poa

+ mta

+ gwia

¢ library

+ |dap_server

B.2 Logical Operators

Spaces around the operators are optional.

Operator Meaning Example

= Equal lasthame = smith

1= Not equal visibility != system

> Greater than mailboxsizemb > 500

< Less than mtpport < 2000

>= Greater than or equal to soapthreads >= 10

<= Less than or equal to physicalconnections <= 1000
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B.3

B.4

B.5

Grouping Operators

Spaces around the operators are optional.

Operator Meaning Example

&, and Conjunction firstname = john & lastname = smith
firstname = john and lastname = smith

|, or Disjunction lastname = smith | lastname = jones
lastname = smith or lastname = jones

1, not Inversion ! (lastname = smith | lastname = jones)
not (lastname = smith or lastname = jones)

() Parentheses lastname = smith & (firsthname = john | firstname = jill)
lastname = smith and (firstname = john or firstname = jill)

Wildcard Characters

The match operator must be used with wildcard characters. The string to match must be surrounded
by single quote marks.

Characters Meaning Example

*

Zero or more characters lastname match ‘sm*

? One character lasthame match ‘sm?th’

Literal Values

Spaces around the operators are optional.

Value Explanation Example

null Empty internetdomainname != null
minimumadminreleasedate != null
preferredaddressformat != null

true, 1 Enabled or set logindisabled = true
logindisabled = 1

false, 0 Disabled or not set soapenabled = false
soapenabled = 0
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B.6 Date Specifications

You can filter on one specific date or on a range of dates that are relative to today.

Format Explanation Example

yyyy-mm-ddTmm:ss Literal date 2014-01-01T00:00

timelastmod > now(time_unit) Modified now (current time stamp on server) timelastmod > now()
Modified in the last day timelastmod > now(-1)
Modified in the last 2 weeks timelastmod > now(-2, weeks)
Modified in the last three months timelastmod > now(-3, months)
Modified in the last year timelastmod > now(-1, year)

246  GroupWise 2014 Installation Guide



C.1

C.2

Invalid Characters in GroupWise
Object Names and Email Addresses

Although most characters in the languages supported by GroupWise can be used in GroupWise
object names and Internet email addresses, some cannot.
¢ Section C.1, “Invalid Characters in GroupWise Object Names,” on page 247

+ Section C.2, “Invalid Characters in Internet Email Addresses,” on page 247

Invalid Characters in GroupWise Object Names

Do not use any of the following invalid characters in GroupWise object names:

+ Space (use underscore instead)

+ ASCII characters 0-31

+ Extended ASCII characters that are graphical or typographical symbols

Accented characters in the extended range can be used in GroupWise object names.

+ Asterisk *

+ Atsigh @

¢ Backslash \

¢ Braces{}

+ Colon:

¢ Comma,

+ Double quote "

+ Parentheses ()

¢ Period .
In addition to the characters listed above, do not use any of the following invalid characters in Agent
objects names:

+ Exclamation mark !

+ Semicolon ;

+ Single quote '

Invalid Characters in Internet Email Addresses

Characters that are valid and even desirable in the name of a user, group, or resource might not be
valid in an email address. Such invalid characters include spaces and certain accented and special
characters. (Providing a definitive list of such invalid characters is beyond the scope of the
GroupWise product documentation.)

In the names of users, groups, and resources, use underscores (_) rather than spaces as separators
between words in order to facilitate addressing across the Internet.
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When an object name includes any character that is not valid in an email address, that object cannot
receive messages. For such an object, you must set up a preferred email ID in order to ensure that it
has a valid email address.
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D Cross-Platform Connections

If you want users to be able to install the GroupWise client software to Windows workstations from a
location on a Linux server, you must make the Linux server look like a Windows server from the point
of view of the workstations. There are a variety of ways to accomplish this. Samba is one of them.

This section provides examples of how to use Samba to install the GroupWise client software from a
Linux server.

¢ Section D.1, “Setting up Samba on OES,” on page 249

+ Section D.2, “Mapping a Drive to a Samba Share on an OES Server,” on page 252

+ Section D.3, “Setting Up Samba on SLES,” on page 252

+ Section D.4, “Mapping a Drive to a Samba Share on a SLES Server,” on page 254

D.1 Setting up Samba on OES

In order to access the GroupWise client software on a Linux server, you can set up a Samba share to
the client folder, either in the downloaded GroupWise 2014 software image or in the software
distribution folder, if you have created one on the Linux server.

¢ Section D.1.1, “Configuring NetWare Core Protocol (NCP),” on page 249

¢ Section D.1.2, “Installing Samba,” on page 250

+ Section D.1.3, “Logging In to iManager,” on page 250

+ Section D.1.4, “Creating a User to Manage the Samba Share,” on page 250

¢ Section D.1.5, “Configuring the eDirectory Universal Password for Samba,” on page 251

+ Section D.1.6, “Setting the eDirectory Universal Password for the Samba Administrator User,” on
page 251

¢ Section D.1.7, “Creating a Samba Share,” on page 251
+ Section D.1.8, “Setting the eDirectory Rights for the Samba Share,” on page 251
+ Section D.1.9, “Testing Samba on the OES Server,” on page 252

D.1.1 Configuring NetWare Core Protocol (NCP)

1 In a terminal window on the OES server, become root by entering su - and the root password.
2 Enter the following command to create the NCP volume:

ncpcon create volume volume name /folder

2a Replace volume name with a unique name for the location of the GroupWise client software.
2b Replace folder with the full path to the GroupWise client software, for example:

/opt/novell/groupwise/software/client

3 Verify that the volume has been created:

more /etc/opt/novell/ncpserv.conft
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The new volume should be listed at the end of the NCP server configuration file.

4 Restart the Novell eDirectory daemon:

rcndsd restart

5 Continue with Installing Samba.

D.1.2 Installing Samba

If you installed Samba when you installed OES, skip to “Logging In to iManager” on page 250.
If you did not install Samba when you installed OES, install it now:

1 Start YaST.

2 Under Groups, click Open Enterprise Server, then click OES Install and Configuration.
3 Under OES Services, select Novell Samba, then click Accept.

4 Follow the prompts to install Novell Samba.

5 Continue with Logging In to iManager.

D.1.3 Logging In to iManager

1 Access the following URL:

https://ip address/nps/servlet/webacc?taskid=fw Startup

Replace ip address with the IP address of the OES server.

2 Specify the eDirectory administrator user name, such as admin.users.novell, the password
for the user name, and the IP address of the eDirectory tree, then click Login.

3 Continue with Creating a User to Manage the Samba Share.

D.1.4 Creating a User to Manage the Samba Share

1 In iManager, click Users > Create User.

2 In the Username field, specify a unique user name for accessing the Samba share from
Windows, such as gwclient.

3 In the Last name field, provide a last name (this is a required field).

4 In the Context field, browse to and click the eDirectory context where you want to create the new
User object.

5 Type and confirm the password for the new user.

IMPORTANT: Any users who map a drive to the Samba share need to know this user name and
password in order to map the drive.

6 Click OK to create the Samba user for the GroupWise client Samba share.
7 Click Users to close the Users menu.

8 Continue with Configuring the eDirectory Universal Password for Samba.
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D.1.5 Configuring the eDirectory Universal Password for Samba

1 Click Passwords > Password Policies.
2 Click Samba Default Password Policy.

3 On the Policy Assignment tab, browse to and click the name of the Samba User object that you
created in “Creating a User to Manage the Samba Share” on page 250, then click OK to add the
user to the list.

4 Click OK to complete the process.

5 Continue with Setting the eDirectory Universal Password for the Samba Administrator User.

D.1.6 Setting the eDirectory Universal Password for the Samba
Administrator User

1 Under Passwords, click Set Universal Password.

2 Browse to and click the name of the Samba User object, then click OK.

3 Specify the password for the Samba user, retype the password for confirmation, then click OK.
4 Click Passwords to close the Passwords menu.

5 Continue with Creating a Samba Share.

D.1.7 Creating a Samba Share

1 Click File Protocols, then click Samba.
2 Browse to and click the name of the Server object where you are setting up the Samba share.
3 On the Shares tab, create a new Samba share for the client folder on the Linux server:

3a Click New.

3b Specify a unique name for the Samba share, such as gwclient.

3c Specify the full path name to the client folder on the Linux server, for example:

/opt/novell/groupwise/software/client

3d Select Read-Only.

Write access is not required in order to install the GroupWise client software from the Linux
server.

3e Click OK to add the location to the list of Samba shares, then click Close.
3f Click File Protocols to close the File Protocols menu.

4 Continue with Setting the eDirectory Universal Password for the Samba Administrator User.

D.1.8 Setting the eDirectory Rights for the Samba Share

1 Click Files and Folders, then click Properties.

2 Browse to and click the name of the Linux partition or folder where you created the new share,
then click OK.

3 Click Rights.
4 In the Add Trustee field, browse to and click the name of the Samba User object, then click OK.
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5 Under Inherited Rights Filter, select Read, then click OK.
6 Continue with Testing Samba on the OES Server.

D.1.9 Testing Samba on the OES Server

1 Double-click the Home Directory icon on the Linux desktop.

2 Click @

3 In the Location field, type smb://user name@ip address

3a Replace user name with the user name of the Samba administrator user.
3b Replace ip address with the IP address of the Linux server.

The File Browser should display all Samba shares, including the new one that you created
for the GroupWise client software.

4 Return to Step 3 in Section 19.3.2, “Installing the GroupWise Client from the Linux GroupWise

2014 Software Image,” on page 178.

D.2 Mapping a Drive to a Samba Share on an OES

D.3

Server

On the Windows server, right-click M on the Windows taskbar, then click Novell Map Network
Drive.

Select the drive letter to map to the NCP volume on the OES server.

3 Specify the network path to the NCP volume in the following format:

\\linux hostname\ncp volume
3a Replace 1inux hostname with the hostname of the OES server.
3b Replace ncp volume with the name of the NCP volume that you just created.

For the network user name, specify the fully qualified Samba user name for eDirectory, such as
gwclient.users.novell.

5 Click Map.
6 Click OK.

The mapped drive to the OES server opens in Windows Explorer and can now be accessed from
Windows.

Return to Step 4 in Section 19.3.2, “Installing the GroupWise Client from the Linux GroupWise
2014 Software Image,” on page 178.

Setting Up Samba on SLES

In order to access the GroupWise client software on a Linux server, you can set up a Samba share on
the Linux server to the client folder, either in the downloaded GroupWise 2014 software image or in
the software distribution folder, if you have created one on the Linux server.

+ Section D.3.1, “Preparing Your Firewall to Allow Samba Connections,” on page 253

+ Section D.3.2, “Configuring the Samba Server,” on page 253

¢ Section D.3.3, “Configuring the Samba Web Administration Tool (SWAT),” on page 253
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¢ Section D.3.4, “Accessing SWAT,” on page 253
+ Section D.3.5, “Setting the Samba User Name and Password,” on page 254
¢ Section D.3.6, “Creating a Samba Share,” on page 254

D.3.1 Preparing Your Firewall to Allow Samba Connections

1 In YaST, click Firewall, then click Interfaces.

2 Click Change, select Internal Zone, then click OK.
3 Click Next to view the summary, then click Finish.
4 Continue with Configuring the Samba Server.

D.3.2 Configuring the Samba Server

1 In YaST, click Network Services > Samba Server.
2 Specify a workgroup or domain name, then click Next.

For use in your GroupWise system, the Samba server does not need to be part of a workgroup
or domain, so it does not matter what you put in this field. For example, you could use
GWCLIENT.

3 Select Not a Domain Controller, then click Next.
For use in your GroupWise system, the Samba server does not need to be a domain controller.
4 Under Service Start, select During Boot.

Because you prepared the firewall in “Preparing Your Firewall to Allow Samba Connections” on
page 253, the Firewall Settings section shows that the firewall port for Samba is already open.

5 Click OK to finish the basic configuration of the Samba server.
6 Continue with Configuring the Samba Web Administration Tool (SWAT).

D.3.3 Configuring the Samba Web Administration Tool (SWAT)

1 In YaST, click Network Services > Network Services (xinetd).

2 Select Enable.

3 In the Currently Available Services list, select swat, then click Toggle Status (On or Off).
SWAT is off by default; this turns it on.

4 Click Finish.

5 Continue with “Accessing SWAT” on page 253.

D.3.4 Accessing SWAT

1 Display SWAT in your web browser with the following URL:

http://localhost:901

2 Specify the root user name and password, then click OK.

3 On the SWAT toolbar, click Status to verify that smbd and nmbd are running.
It is not necessary for winbindd to be running.

4 Continue with Setting the Samba User Name and Password.
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D.3.5 Setting the Samba User Name and Password

1 On the SWAT toolbar, click Password.

2 In the User Name field, specify a unique user name for use when mapping a drive to the Samba
share, such as gwclient.

3 Type and confirm the password for the new user, then click Add User.

IMPORTANT: Any users who map a drive to the Samba share need to know this user name and
password in order to map the drive.

4 Continue with Creating a Samba Share.

D.3.6 Creating a Samba Share

1 On the SWAT toolbar, click Shares.

2 Inthe Create Share field, type a unique name for the share, such as gwclient, then click Create
Share.

3 In the Path field, specify the full path name to the client folder on the Linux server.
4 Leave the Read Only field set to the default of Yes.

Write access is not required in order to install the GroupWise client software from the Linux
server.

5 In the Available field, select Yes.
6 Click Commit Changes.
The Samba share on the Linux server is now ready for access from a Windows workstation.

7 Return to Step 3 in Section 19.3.2, “Installing the GroupWise Client from the Linux GroupWise
2014 Software Image,” on page 178.

D.4 Mapping a Drive to a Samba Share on a SLES
Server

1 In Windows Explorer, right-click the Computer object, then click Map network drive.
2 In the Drive field, select the drive letter for the new Samba share.

3 In the Folder field, specify the location of the Samba share in the following format:

\\ip address\share name

3a Replace ip address with the IP address of the Linux server.

3b Replace share name with the name of the new Samba share where the GroupWise client
software is available.

4 Deselect Reconnect to logon.
5 Select Connect using different credentials.
6 Specify the Samba share user name and password, then click OK.

The Samba share for the OES file system opens in Windows Explorer and can now be accessed
from Windows.

7 Return to Step 4 in Section 19.3.2, “Installing the GroupWise Client from the Linux GroupWise
2014 Software Image,” on page 178.
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E Third-Party Materials

E.1

The following third-party software is included in Novell GroupWise 2014:

*

Section E.1, “Apache,” on page 255

Section E.2, “BLT,” on page 256

Section E.3, “GD Graphics Library,” on page 256

Section E.4, “getopt.h,” on page 257

Section E.5, “iCal4j - License,” on page 258

Section E.6, “ICU License - ICU 1.8.1 and Later,” on page 258
Section E.7, “JRE,” on page 259

Section E.8, “NET-SNMP Open Source Package,” on page 259
Section E.9, “ODMA 2.0,” on page 261

Section E.10, “OpenLDAP,” on page 262

Section E.11, “OpenSSL,” on page 263

Section E.12, “Oracle Outside In Technology,” on page 264
Section E.13, “Python 2.2,” on page 265

Section E.14, “Yahoo! Ul Library,” on page 265

Apache

The Apache Software License, Version 1.1 Copyright (c) 2000 The Apache Software Foundation. All
rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

1.

Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

. The end-user documentation included with the redistribution, if any, must include the following

acknowledgment:

“This product includes software developed by the Apache Software Foundation (http://
www.apache.org/).”

Alternately, this acknowledgment may appear in the software itself, if and wherever such third-
party acknowledgments normally appear.

The names “Apache” and “Apache Software Foundation” must not be used to endorse or
promote products derived from this software without prior written permission. For written
permission, please contact apache@apache.org.

Products derived from this software may not be called “Apache”, nor may “Apache” appear in
their name, without prior written permission of the Apache Software Foundation.
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E.2

E.3

THIS SOFTWARE IS PROVIDED "AS IS” AND ANY EXPRESSED OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
APACHE SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This software consists of voluntary contributions made by many individuals on behalf of the Apache
Software Foundation. For more information on the Apache Software Foundation, please see <http://
www.apache.org/>.

Portions of this software are based upon public domain software originally written at the National
Center for Supercomputing Applications, University of lllinois, Urbana-Champaign.

BLT

Copyright 1993-1998 Lucent Technologies, Inc.

Permission to use, copy, modify, and distribute this software and its documentation for any purpose
and without fee is hereby granted, provided that the above copyright notice appear in all copies and
that both that the copyright notice and warranty disclaimer appear in supporting documentation, and
that the names of Lucent Technologies any of their entities not be used in advertising or publicity
pertaining to distribution of the software without specific, written prior permission.

Lucent Technologies disclaims all warranties with regard to this software, including all implied
warranties of merchantability and fitness. In no event shall Lucent Technologies be liable for any
special, indirect or consequential damages or any damages whatsoever resulting from loss of use,
data or profits, whether in an action of contract, negligence or other tortuous action, arising out of or in
connection with the use or performance of this software.

GD Graphics Library

Portions copyright 1994, 1995, 1996, 1997, 1998, 1999, 2000, 2001, 2002, 2003, 2004 by Cold
Spring Harbor Laboratory. Funded under Grant P41-RR02188 by the National Institutes of Health.

Portions copyright 1996, 1997, 1998, 1999, 2000, 2001, 2002, 2003, 2004 by Boutell.Com, Inc.
Portions relating to GD2 format copyright 1999, 2000, 2001, 2002, 2003, 2004 Philip Warner.
Portions relating to PNG copyright 1999, 2000, 2001, 2002, 2003, 2004 Greg Roelofs.

Portions relating to gdttf.c copyright 1999, 2000, 2001, 2002, 2003, 2004 John Ellson
(ellson@graphviz.org).

Portions relating to gdft.c copyright 2001, 2002, 2003, 2004 John Ellson (ellson@graphviz.org).

Portions relating to JPEG and to color quantization copyright 2000, 2001, 2002, 2003, 2004, Doug
Becker and copyright (C) 1994, 1995, 1996, 1997, 1998, 1999, 2000, 2001, 2002, 2003, 2004
Thomas G. Lane. This software is based in part on the work of the Independent JPEG Group. See the
file README-JPEG.TXT for more information.
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E.4

Portions relating to GIF compression copyright 1989 by Jef Poskanzer and David Rowley, with
modifications for thread safety by Thomas Boutell.

Portions relating to GIF decompression copyright 1990, 1991, 1993 by David Koblas, with
modifications for thread safety by Thomas Boutell.

Portions relating to WBMP copyright 2000, 2001, 2002, 2003, 2004 Maurice Szmurlo and Johan Van
den Brande.

Permission has been granted to copy, distribute and modify gd in any context without fee, including a
commercial application, provided that this notice is present in user-accessible supporting
documentation.

This does not affect your ownership of the derived work itself, and the intent is to assure proper credit
for the authors of gd, not to interfere with your productive use of gd. If you have questions, ask.
“Derived works” includes all programs that utilize the library. Credit must be given in user-accessible
documentation.

This software is provided “AS IS.” The copyright holders disclaim all warranties, either express or
implied, including but not limited to implied warranties of merchantability and fitness for a particular
purpose, with respect to this code and accompanying documentation.

Although their code does not appear in the current release, the authors also wish to thank Hutchison
Avenue Software Corporation for their prior contributions.

getopt.h

Copyright (c) 2000 The NetBSD Foundation, Inc. All rights reserved.

This code is derived from software contributed to The NetBSD Foundation by Dieter Baron and
Thomas Klausner.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

3. All advertising materials mentioning features or use of this software must display the following
acknowledgement:

This product includes software developed by the NetBSD Foundation, Inc. and its contributors.

4. Neither the name of The NetBSD Foundation nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE NETBSD FOUNDATION, INC. AND CONTRIBUTORS
“AS 1IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE FOUNDATION OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
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E.5

E.6

CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

iCal4j - License

Copyright (c) 2012, Ben Fortuna
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

+ Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

+ Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

+ Neither the name of Ben Fortuna nor the names of any other contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

ICU License - ICU 1.8.1 and Later

COPYRIGHT AND PERMISSION NOTICE
Copyright (c) 1995-2006 International Business Machines Corporation and others
All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the
Software, and to permit persons to whom the Software is furnished to do so, provided that the above
copyright notice(s) and this permission notice appear in all copies of the Software and that both the
above copyright notice(s) and this permission notice appear in supporting documentation.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS.
IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE
LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR
ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
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E.8.1

WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION,
ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS
SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not be used in advertising or
otherwise to promote the sale, use or other dealings in this Software without prior written
authorization of the copyright holder.

JRE

JRE Note

This product includes code licensed from RSA Security, Inc. Some portions licensed from IBM are
available at http://oss.software.ibm.com/icu4j/.

NET-SNMP Open Source Package

+ Section E.8.1, “--- Part 1: CMU/UCD copyright notice: (BSD like) ----- ;) on page 259
¢ Section E.8.2, “---- Part 2: Networks Associates Technology, Inc copyright notice (BSD) ----- . on
page 260
+ Section E.8.3, “---- Part 3: Cambridge Broadband Ltd. copyright notice (BSD) ----- ,” on page 260
¢ Section E.8.4, “---- Part 4: Sun Microsystems, Inc. copyright notice (BSD) ----- ,” on page 261
---- Part 1: CMU/UCD copyright notice: (BSD like) -----

Copyright 1989, 1991, 1992 by Carnegie Mellon University Derivative Work - 1996, 1998-2000
Copyright 1996, 1998-2000 The Regents of the University of California All Rights Reserved

Permission to use, copy, modify and distribute this software and its documentation for any purpose
and without fee is hereby granted, provided that the above copyright notice appears in all copies and
that both that copyright notice and this permission notice appear in supporting documentation, and
that the name of CMU and The Regents of the University of California not be used in advertising or
publicity pertaining to distribution of the software without specific written permission.

CMU AND THE REGENTS OF THE UNIVERSITY OF CALIFORNIA DISCLAIM ALL WARRANTIES
WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL CMU OR THE REGENTS OF THE
UNIVERSITY OF CALIFORNIA BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL
DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM THE LOSS OF USE, DATA
OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS
ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS
SOFTWARE.
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---- Part 2: Networks Associates Technology, Inc copyright
notice (BSD) -----

Copyright (c) 2001-2003, Networks Associates Technology, Inc All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

+ Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

+ Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

+ Neither the name of the Networks Associates Technology, Inc nor the names of its contributors
may be used to endorse or promote products derived from this software without specific prior
written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS”
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

---- Part 3: Cambridge Broadband Ltd. copyright notice
(BSD) -----

Portions of this code are copyright (c) 2001-2003, Cambridge Broadband Ltd. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

+ Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

+ Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

+ The name of Cambridge Broadband Ltd. may not be used to endorse or promote products
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER “AS 1S” AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA,
OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
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LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 4: Sun Microsystems, Inc. copyright notice (BSD) ---

Copyright © 2003 Sun Microsystems, Inc., 4150 Network Circle, Santa Clara, California 95054,
U.S.A. All rights reserved.

Use is subject to license terms below.
This distribution may include materials developed by third parties.

Sun, Sun Microsystems, the Sun logo and Solaris are trademarks or registered trademarks of Sun
Microsystems, Inc. in the U.S. and other countries.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

+ Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

+ Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

+ Neither the name of the Sun Microsystems, Inc. nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS”
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

ODMA 2.0

OPEN DOCUMENT MANAGEMENT API LICENSE 1.0 ODMA 2.0 SPECIFICATIONS AND
SOFTWARE Copyright © 1994-1998 AlIM International

LICENSE:

Redistribution and use in source and binary forms, with or without modifications, are permitted
provided that the following conditions are met:

+ Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.
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+ Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

+ Neither the name of AlIM International nor the names of its contributors may be used to endorse
or promote products derived from this software without specific prior written permission.

DISCLAIMER:

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS”
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

ADDITIONAL INFORMATION:

+ ODMA reference materials, software, and status: <http://ODMA.info>
+ Information about this ODMA License and its application: <http://DMare.info/license/>

+ Open Source Definition 1.9 and the BSD License (the model for this ODMA license): <http://
opensource.org>

+ HTML (ISO 8859-1) version of this license: <http://Dmware.info/license/P040801F.htm>

OpenLDAP

The OpenLDAP Public License Version 2.8, 17 August 2003

Redistribution and use of this software and associated documentation (“Software”), with or without
modification, are permitted provided that the following conditions are met:

1 Redistributions in source form must retain copyright statements and notices,

2 Redistributions in binary form must reproduce applicable copyright statements and notices, this
list of conditions, and the following disclaimer in the documentation and/or other materials
provided with the distribution, and

3 Redistributions must contain a verbatim copy of this document.

The OpenLDAP Foundation may revise this license from time to time. Each revision is distinguished
by a version number. You may use this Software under terms of this license revision or under the
terms of any subsequent revision of the license.

THIS SOFTWARE IS PROVIDED BY THE OPENLDAP FOUNDATION AND ITS CONTRIBUTORS
"AS IS” AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OPENLDAP FOUNDATION, ITS
CONTRIBUTORS, OR THE AUTHOR(S) OR OWNER(S) OF THE SOFTWARE BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
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CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The names of the authors and copyright holders must not be used in advertising or otherwise to
promote the sale, use or other dealing in this Software without specific, written prior permission. Title
to copyright in this Software shall at all times remain with copyright holders.

OpenLDAP is a registered trademark of the OpenLDAP Foundation.

OpenSSL

OpenSSL License Copyright (c) 1998-2002 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

1 Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

2 Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

3 All advertising materials mentioning features or use of this software must display the following
acknowledgment:

“This product includes software developed by the OpenSSL Project for use in the OpenSSL
Toolkit. (http://www.openssl.org/)”

4 The names “OpenSSL Toolkit” and “OpenSSL Project” must not be used to endorse or promote
products derived from this software without prior written permission. For written permission,
please contact openssl-core@openssl.org.

5 Products derived from this software may not be called “OpenSSL” nor may “OpenSSL” appear in
their names without prior written permission of the OpenSSL Project.

6 Redistributions of any form whatsoever must retain the following acknowledgment:

“This product includes software developed by the OpenSSL Project for use in the OpenSSL
Toolkit (http://www.openssl.org/)’

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT "AS IS” AND ANY EXPRESSED
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN
NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This
product includes software written by Tim Hudson (tjh@cryptsoft.com).

Original SSLeay License
Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved.
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This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The
implementation was written so as to conform with Netscape's SSL.

This library is free for commercial and non-commercial use as long as the following conditions are
adhered to. The following conditions apply to all code found in this distribution, be it the RC4, RSA,
Ihash, DES, etc., code; not just the SSL code. The SSL documentation included with this distribution
is covered by the same copyright terms except that the holder is Tim Hudson (tih@cryptsoft.com).

Copyright remains Eric Young'’s, and as such any Copyright notices in the code are not to be
removed. If this package is used in a product, Eric Young should be given attribution as the author of
the parts of the library used. This can be in the form of a textual message at program startup or in
documentation (online or textual) provided with the package.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

1 Redistributions of source code must retain the copyright notice, this list of conditions and the
following disclaimer.

2 Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

3 All advertising materials mentioning features or use of this software must display the following
acknowledgement:

“This product includes cryptographic software written by Eric Young (eay@cryptsoft.com)”

The word “cryptographic” can be left out if the routines from the library being used are not
cryptographic related :-).

4 If you include any Windows specific code (or a derivative thereof) from the apps directory
(application code) you must include an acknowledgement:

“This product includes software written by Tim Hudson (tjih@cryptsoft.com)’

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG TAS IS” AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA,
OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The licence and distribution terms for any publicly available version or derivative of this code cannot
be changed; i.e. this code cannot simply be copied and put under another distribution licence
[including the GNU Public Licence.]

Oracle Outside In Technology

Oracle shall inform you of any notices and other instructions that are related to third party
components (including open source software) that are included in a program and/or hardware and
that Oracle is required to distribute with such programs and/or hardware. These notices and other
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instructions shall be provided to you in at least one of the following ways, at Oracle’s sole discretion:
(a) automatically installed with the programs or in the installation details; (b) in the program
documentation; (c) in the readme files or notice files; or (d) via a supplemental list.

You shall comply with all instructions related to third party software components (including open
source software). If you reproduce the programs, operating system and/or integrated software, you
shall reproduce all third party notices in an appropriate location in the reproduction and/or in its
related documentation and include any associated source code (to the extent such source code is
provided by Oracle), as required by the applicable notices or as otherwise directed by Oracle.

E.13 Python 2.2

Copyright (c) 1991 - 1995, Stichting Mathematisch Centrum Amsterdam, The Netherlands. All rights
reserved.

Permission to use, copy, modify, and distribute this software and its documentation for any purpose
and without fee is hereby granted, provided that the above copyright notice appear in all copies and
that both that copyright notice and this permission notice appear in supporting documentation, and
that the name of Stichting Mathematisch Centrum or CWI not be used in advertising or publicity
pertaining to distribution of the software without specific, written prior permission.

STICHTING MATHEMATISCH CENTRUM DISCLAIMS ALL WARRANTIES WITH REGARD TO
THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS, IN NO EVENT SHALL STICHTING MATHEMATISCH CENTRUM BE LIABLE FOR ANY
SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER
RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF
CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN
CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

E.14 Yahoo! Ul Library

Yahoo! Ul Library uses the BSD License which states:
Software License Agreement (BSD License)
Copyright (c) 2006, Yahoo! Inc.

All rights reserved.

Redistribution and use of this software in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:

+ Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

+ Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

+ Neither the name of Yahoo! Inc. nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission of Yahoo!
Inc.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
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ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.
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F Documentation Updates

This section lists updates to the GroupWise 2014 Installation Guide that have been made since the
initial release of GroupWise 2014. The information helps you to keep current on documentation
updates and, in some cases, software updates (such as a Support Pack release).

The information is grouped according to the date when the GroupWise 2014 Installation Guide was
republished. Within each dated section, the updates are listed by the names of the main table of
contents sections.

The GroupWise 2014 Installation Guide has been updated on the following dates:

¢ Section F.1, “July 28, 2014 (GroupWise 2014 SP1),” on page 267

F.1 July 28, 2014 (GroupWise 2014 SP1)

Location Change

System

Chapter 25, “Upgrading the Corrected the order of steps in the upgrade procedure.
Primary Domain Server,” on

page 203
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